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#ÈÁÐÔÅÒ ρ ɀ )ÎÔÒÏÄÕÃÔÉÏÎ ÔÏ Ȣ.%4 0ÒÏÊÅÃÔÓ 

¢Ƙƛǎ ŎƘŀǇǘŜǊ ǇǊƻǾƛŘŜǎ ŀƴ ƻǾŜǊǾƛŜǿ ƻŦ ǘƘŜ Φb9¢ ǇƻǊǘƛƻƴ ƻŦ ǘƘŜ ōǳƛƭŘ ǎŜǘǘƛƴƎǎ ŘƛŀƭƻƎ ōƻȄΦ Lǘ ŀƭǎƻ Ŏƻƴǘŀƛƴǎ ŀ 
ŎƻƴŎŜǇǘǳŀƭ ŜȄǇƭŀƴŀǘƛƻƴ ƻŦ ǘƘŜ ŎƻƳǇƛƭƛƴƎ ǇǊƻŎŜǎǎ ǘƘŀǘ ŜƴŀōƭŜǎ ȅƻǳ ǘƻ ŎǊŜŀǘŜ ŀ Φb9¢ ŀǇǇƭƛŎŀǘƛƻƴ ǿƛǘƘ ¢ŜŀƳ 
5ŜǾŜƭƻǇŜǊΦ 

Ȣ.%4 "ÕÉÌÄ 3ÅÔÔÉÎÇÓ 

¢ƘŜ .ǳƛƭŘ {ŜǘǘƛƴƎǎ ŘƛŀƭƻƎ ōƻȄ ƛǎ ŀŎŎŜǎǎŜŘ ōȅ ǎŜƭŜŎǘƛƴƎ ά.ǳƛƭŘ {ŜǘǘƛƴƎǎέ ŦǊƻƳ ǘƘŜ tǊƻƧŜŎǘ ƳŜƴǳ όǎŜŜ ǘƘŜ άtǊƻƧŜŎǘ 
aŜƴǳέ ǎŜŎǘƛƻƴ ƻŦ ǘƘŜ 5ŜǾŜƭƻǇƛƴƎ ²ƛǘƘ {v[²ƛƴŘƻǿǎ ŘƻŎǳƳŜƴǘύΦ ¢ƘŜ ǊƛƎƘǘ ǎƛŘŜ ƻŦ ǘƘƛǎ ŘƛŀƭƻƎ ōƻȄ Ŏƻƴǘŀƛƴǎ 
ƻǇǘƛƻƴǎ ŦƻǊ Φb9¢ ōǳƛƭŘ ǎŜǘǘƛƴƎǎΦ ¢ƘŜǎŜ ƻǇǘƛƻƴǎ ŀƴŘ ǎŜǘǘƛƴƎǎ ŀǊŜ ŜȄǇƭŀƛƴŜŘ ƛƴ ǘƘŜ ǎŜŎǘƛƻƴǎ ǘƘŀǘ ŦƻƭƭƻǿΦ 
 

 

Ȣ.%4 4ÁÒÇÅÔ 4ÙÐÅÓ 

¶ Φb9¢ ²tC 5ŜǎƪǘƻǇ ό9·9ύτ! ²tC ŀǇǇƭƛŎŀǘƛƻƴ ǘƘŀǘ Ǌǳƴǎ ŦǊƻƳ ǘƘŜ ŘŜǎƪǘƻǇΦ 

¶ Φb9¢ ²tC .ǊƻǿǎŜǊ ό·.!tύτ! ²tC ŀǇǇƭƛŎŀǘƛƻƴ ŘŜǎƛƎƴŜŘ ǘƻ Ǌǳƴ ƛƴ ŀ ōǊƻǿǎŜǊΦ 

¶ Φb9¢ /ƭŀǎǎ [ƛōǊŀǊȅ ό5[[ύτ! Ŏƭŀǎǎ ƭƛōǊŀǊȅ ǳǎŜŘ ƛƴ ŘŜǾŜƭƻǇƛƴƎ ƻǘƘŜǊ ŀǇǇƭƛŎŀǘƛƻƴǎΦ 

¶ Φb9¢ {![ [ƛōǊŀǊȅ ό5[[ύτ¢ƘŜ ²tC ŜǉǳƛǾŀƭŜƴǘ ŦƻǊ ǘƘŜ Řȅƴŀƭƛō ŎƻƳǇƛƭŜǊ ƻǇǘƛƻƴ ƛƴ ²ƛƴон ƳƻŘŜΦ 
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¶ Φb9¢ ²Ŝō {ŜǊǾƛŎŜ ό5[[ύτ! Φb9¢ ²Ŝō ǎŜǊǾƛŎŜ ǘƘŀǘ Ŏŀƴ ōŜ ƘƻǎǘŜŘ ƻƴ LL{Φ 

¸ƻǳ Ŏŀƴ ŀƭǎƻ ŎƻƳǇƛƭŜ ŦǊƻƳ ǘƘŜ ŎƻƳƳŀƴŘ ƭƛƴŜΣ ƛƴŎƭǳŘƛƴƎ ǇŀǊŀƳŜǘŜǊǎ ǘƻ ǎǇŜŎƛŦȅ ǘƘŜ ōǳƛƭŘ ǘŀǊƎŜǘΦ CƻǊ ŜȄŀƳǇƭŜǎΣ 
ǎŜŜ ά/ƻƳǇƛƭƛƴƎ tǊƻŎŜǎǎ hǾŜǊǾƛŜǿέ ƻƴ ǇŀƎŜ тΦ 

/ÔÈÅÒ 3ÅÔÔÉÎÇÓ 

¢ŀǊƎŜǘ bŀƳŜτ¦ǎŜŘ ǘƻ ƛƴŘƛŎŀǘŜ ǘƘŜ ƴŀƳŜ ƻŦ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΣ Ŏƭŀǎǎ ƭƛōǊŀǊȅΣ ƻǊ ²Ŝō ǎŜǊǾƛŎŜ ȅƻǳ ŀǊŜ ƎƻƛƴƎ ǘƻ 
ōǳƛƭŘΦ 

¢ŀǊƎŜǘ 5ƛǊŜŎǘƻǊȅτ¢ƘŜ ŘƛǊŜŎǘƻǊȅ ǿƘŜǊŜ ȅƻǳǊ ōǳƛƭŘ ǿƛƭƭ ōŜ ǎŀǾŜŘΦ 

φτ-ÂÉÔ !ÐÐÌÉÃÁÔÉÏÎÓ 

¢ƘŜ !ŘǾŀƴŎŜŘ ōǳǘǘƻƴ ƻƴ ǘƘŜ ōǳƛƭŘ ǎŜǘǘƛƴƎǎ ŘƛŀƭƻƎ ōǊƛƴƎǎ ǳǇ ŀ ƴŜǿ !ŘǾŀƴŎŜŘ {ŜǘǘƛƴƎǎ ŘƛŀƭƻƎ ōƻȄΦ Lƴ ǘƘƛǎ 
ŘƛŀƭƻƎΣ ǘƘŜ ǳǎŜǊ Ŏŀƴ ŎƘƻƻǎŜ ŀ ǾŀƭǳŜ ŦƻǊ ǘƘŜ ¢ŀǊƎŜǘ /t¦Υ 

¶ онōƛǘΥ ¢ƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ǿƛƭƭ ŀƭǿŀȅǎ ōŜ он-ōƛǘΦ hƴ ŀ сп-ōƛǘ h{Σ ŀǇǇƭƛŎŀǘƛƻƴǎ Ǌǳƴ ǿƛǘƘƛƴ ǘƘŜ он-ōƛǘ ǎǳōǎȅǎǘŜƳΦ 

¶ спōƛǘΥ ¢ƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ǿƛƭƭ ŀƭǿŀȅǎ ōŜ сп-ōƛǘ ŀƴŘ Ŏŀƴ ƻƴƭȅ Ǌǳƴ ƻƴ ŀ сп-ōƛǘ ƳŀŎƘƛƴŜΦ 

¶ !ǳǘƻΥ ¢ƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ǿƛƭƭ ŘŜŎƛŘŜ ǿƘŀǘ ōƛǘƴŜǎǎ ǘƻ ǳǎŜ ŀǘ ƭŀǳƴŎƘ ǘƛƳŜΣ ŘŜǇŜƴŘƛƴƎ ƻƴ ǘƘŜ h{Φ CƻǊ 5[[ǎΣ ǘƘŜ 
ōƛǘƴŜǎǎ ŘŜǇŜƴŘǎ ƻƴ ǘƘŜ ǇǊƻŎŜǎǎ ƭƻŀŘƛƴƎ ǘƘŜƳΦ 

¢ƘŜǊŜ ƛǎ ŀ ƴŜǿ ŎƻƳƳŀƴŘ-ƭƛƴŜ ŀǊƎǳƳŜƴǘ ǘƻ ¢5 ŦƻǊ ǎǇŜŎƛŦȅƛƴƎ ǘƘŜ ǘŀǊƎŜǘ /t¦ ǿƘŜƴ ŎƻƳǇƛƭƛƴƎ ŦǊƻƳ ŀ 5h{ 
ǇǊƻƳǇǘΦ ¢ƘŜ ǎȅƴǘŀȄ ŦƻǊ ǘƘŜ ƴŜǿ ŦƭŀƎ ƛǎ Ϧ-ŎǇǳΥонōƛǘϦΣ Ϧ-ŎǇǳΥспōƛǘϦΣ ƻǊ Ϧ-ŎǇǳΥŀǳǘƻϦΣ ŀǎ ŦƻƭƭƻǿǎΥ 

cbi62.exe - .net:WPFDesktop - cpu:64bit test.apt test.exe   

cbi62.exe - .net:WPFDesktop - cpu:32bit test.apt test.exe  

cbi62.exe - .net:WPFDesktop - cpu:auto test.apt test.exe  

3ÉÇÎÉÎÇ !ÓÓÅÍÂÌÙ 

¢ƘŜ !ŘǾŀƴŎŜŘ ōǳǘǘƻƴ ƻƴ ǘƘŜ ōǳƛƭŘ ǎŜǘǘƛƴƎǎ ŘƛŀƭƻƎ ōǊƛƴƎǎ ǳǇ ŀ ƴŜǿ !ŘǾŀƴŎŜŘ {ŜǘǘƛƴƎǎ ŘƛŀƭƻƎ ōƻȄΦ Lƴ ǘƘƛǎ 
ŘƛŀƭƻƎΣ ǘƘŜ ǳǎŜǊ Ŏŀƴ ǎǇŜŎƛŦȅ ǘƘŜ {ǘǊƻƴƎ bŀƳŜ YŜȅ ŦƛƭŜ όϝΦǎƴƪύΦ ¢ƘŜ Φb9¢ ŎƻƳǇƛƭŜǊ ǎƛƎƴǎ ǘƘŜ ŀǎǎŜƳōƭȅ ǳǎƛƴƎ ǘƘŜ 
Φǎƴƪ ŦƛƭŜΦ 

 



 

7 

#ÏÍÐÉÌÉÎÇ 0ÒÏÃÅÓÓ /ÖÅÒÖÉÅ× 

Φb9¢ ŀǇǇƭƛŎŀǘƛƻƴǎ ŀǊŜ ŎƻƳǇƛƭŜŘ ŦǊƻƳ LƴǘŜǊƳŜŘƛŀǘŜ [ŀƴƎǳŀƎŜ όL[ύΦ ¢ƻ ŎǊŜŀǘŜ ŀ Φb9¢ ŀǇǇƭƛŎŀǘƛƻƴ ŦǊƻƳ ŀ ¢ŜŀƳ 
5ŜǾŜƭƻǇŜǊ ƻǳǘƭƛƴŜΣ ȅƻǳǊ {![ ŎƻŘŜ Ƴǳǎǘ ōŜ ŎƻƴǾŜǊǘŜŘ ǘƻ L[ ŀƴŘ ŎƻƳǇƛƭŜŘ ƛƴǘƻ ŀ Φb9¢ ǇǊƻŘǳŎǘΦ ²ƛǘƘ ¢ŜŀƳ 
5ŜǾŜƭƻǇŜǊ сΦлΣ DǳǇǘŀ ƛƴǘǊƻŘǳŎŜŘ ŀ ƴŜǿ L[ ŎƻƳǇƛƭŜǊ ǘƘŀǘ ǇŜǊŦƻǊƳǎ ǘƘŜǎŜ ŦǳƴŎǘƛƻƴǎ ŦƻǊ ȅƻǳΦ 

¢ƻ ŎǊŜŀǘŜ ŀ Φb9¢ ǇǊƻŘǳŎǘ ǿƛǘƘ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊΣ ŜȄŜŎǳǘŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǎǘŜǇǎΥ 

1. Write your application in Team Developer as usual, using SAL code. 

2. In the Project menu, select Build Settings to access the Advanced Settings dialog box. 

3. Choose a .NET target type, and specify a target name and directory. 

¸ƻǳ Ŏŀƴ ŀƭǎƻ ŎƻƳǇƛƭŜ ŦǊƻƳ ǘƘŜ ŎƻƳƳŀƴŘ ƭƛƴŜΦ {ŜŜ ά/ƻƳǇƛƭƛƴƎ ŦǊƻƳ ǘƘŜ /ƻƳƳŀƴŘ [ƛƴŜέ ƻƴ ǇŀƎŜ у ŦƻǊ 
ƛƴŦƻǊƳŀǘƛƻƴ ŀƴŘ ŜȄŀƳǇƭŜǎΦ 

7ÈÁÔ 4ÅÁÍ $ÅÖÅÌÏÐÅÒ $ÏÅÓ 

hƴŎŜ ȅƻǳ ǎŜƭŜŎǘ ŀ Φb9¢ ǘŀǊƎŜǘ ǘȅǇŜΣ ōǳƛƭŘ ȅƻǳǊ ǇǊƻƧŜŎǘ ŀǎ ǳǎǳŀƭΦ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ǘǳǊƴǎ ȅƻǳǊ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ 
ƻǳǘƭƛƴŜ ƛƴǘƻ ŀ Φb9¢ ŀǇǇƭƛŎŀǘƛƻƴΣ Ŏƭŀǎǎ ƭƛōǊŀǊȅΣ ƻǊ ²Ŝō ǎŜǊǾƛŎŜΦ 

¶ [ƛōǊŀǊȅ ƛƴŎƭǳǎƛƻƴǎΥ 

!ƴȅ ƭƛōǊŀǊƛŜǎ ȅƻǳ ŎǊŜŀǘŜŘ ŀƴŘ ƛƴŎƭǳŘŜŘ ŀǊŜ ƳŀŘŜ ŀǾŀƛƭŀōƭŜ ǘƻ ǘƘŜ ŎƻƳǇƛƭŜǊΦ 

¶ CǳƴŎǘƛƻƴǎ ŦǊƻƳ !t[ǎΥ 

DǳǇǘŀ-ǇǊƻǾƛŘŜŘ ƭƛōǊŀǊƛŜǎ ŀǊŜ ƴƻǘ ƛƴŎƭǳŘŜŘΦ LƴǎǘŜŀŘΣ Φb9¢ ƛƳǇƭŜƳŜƴǘŀǘƛƻƴǎ ƻŦ ǘƘŜǎŜ ƭƛōǊŀǊƛŜǎΩ ŦǳƴŎǘƛƻƴǎ ŀǊŜ 
ŎǊŜŀǘŜŘ ƛƴŘƛǾƛŘǳŀƭƭȅΦ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ŀƴŘ ǘƘŜ L[ ŎƻƳǇƛƭŜǊ ƛƎƴƻǊŜ ȅƻǳǊ ƛƴŎƭǳŘŜ ǎǘŀǘŜƳŜƴǘǎ ŦƻǊ ǘƘŜǎŜ 
ƭƛōǊŀǊƛŜǎ ŀƴŘ ƛƴŎƻǊǇƻǊŀǘŜǎ ǘƘŜ Φb9¢ ƛƳǇƭŜƳŜƴǘŀǘƛƻƴǎ ǿƘŜǊŜ ŦǳƴŎǘƛƻƴǎ ŦǊƻƳ ǘƘŜǎŜ ƭƛōǊŀǊƛŜǎ ŀǊŜ ŎŀƭƭŜŘΦ 

¶ L[ ŎƻƳǇƛƭŜΥ 

¢ƘŜ L[ ŎƻƳǇƛƭŜǊ ǊŜŎŜƛǾŜǎ ȅƻǳǊ {![ ŎƻŘŜΣ ƛƴŎƭǳŘŜŘ !t[ǎΣ ŀƴŘ ǘƘŜ Φb9¢ ƛƳǇƭŜƳŜƴǘŀǘƛƻƴǎ ƻŦ DǳǇǘŀ ŦǳƴŎǘƛƻƴǎ 
ȅƻǳ ŎŀƭƭŜŘ ƛƴ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴΦ ¢ƘŜǎŜ ŜƭŜƳŜƴǘǎ ŀǊŜ ŎƻƴǾŜǊǘŜŘ ǘƻ L[ ŀƴŘ ŎƻƳǇƛƭŜŘΦ 

¶ CƛƴƛǎƘŜŘ ǇǊƻŘǳŎǘΥ 

¸ƻǳǊ Φb9¢ ǇǊƻƧŜŎǘ ƛǎ ōǳƛƭǘ ŀƴŘ ǎŀǾŜŘ ǿƛǘƘ ǘƘŜ ŘƛǊŜŎǘƻǊȅ ŀƴŘ ŦƛƭŜƴŀƳŜ ȅƻǳ ǎǇŜŎƛŦƛŜŘ ƛƴ ǘƘŜ .ǳƛƭŘ {ŜǘǘƛƴƎǎ 
ŘƛŀƭƻƎ ōƻȄΦ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ǳǎŜǎ ǘƘŜ ǎǘŀƴŘŀǊŘ ƻǳǘǇǳǘ ǿƛƴŘƻǿ ǘƻ ǊŜǇƻǊǘ ŀƴȅ ŜǊǊƻǊǎΦ 

¢ƘŜ ŦƻƭƭƻǿƛƴƎ ŘƛŀƎǊŀƳ ƛƭƭǳǎǘǊŀǘŜǎ ǘƘƛǎ ǇǊƻŎŜǎǎΥ 
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#ÏÍÐÉÌÉÎÇ ÆÒÏÍ ÔÈÅ #ÏÍÍÁÎÄ ,ÉÎÅ 

¢ƘŜ ŦƻƭƭƻǿƛƴƎ ŀǊŜ ŜȄŀƳǇƭŜ ŎƻƳƳŀƴŘǎ ŦƻǊ ŎƻƳǇƛƭƛƴƎ ŦǊƻƳ ǘƘŜ ŎƻƳƳŀƴŘ ƭƛƴŜΦ 

¶ ¢ƻ ŎƻƳǇƛƭŜ ǳǎƛƴƎ ǘƘŜ ǎǘŀƴŘŀǊŘ ¢5 ƴŀǘƛǾŜ ŎƻƳǇƛƭŜǊ ό²ƛƴон ŀǇǇƭƛŎŀǘƛƻƴύΥ 

cbi62.exe - b test.app test.exe  

¶ ¢ƻ ŎƻƳǇƛƭŜ ŀ ²tC ŘŜǎƪǘƻǇ ŀǇǇƭƛŎŀǘƛƻƴΥ 

cbi62.exe - .net:WPFDesktop test.app test.exe  

ƻǊ 

cbi62.exe - .net:AutoDes ktop test.app  

¶ ¢ƻ ŎƻƳǇƛƭŜ ŀ ²tC ōǊƻǿǎŜǊ ŀǇǇƭƛŎŀǘƛƻƴΥ 

cbi62.exe - .net:WPFBrowser test.app test.exe  

ƻǊ 

cbi62.exe - .net:AutoBrowser test.app  

¶ ¢ƻ ŎƻƳǇƛƭŜ ŀ Φb9¢ {![ ƭƛōǊŀǊȅΥ 

cbi62.exe - .net:SALLibrary test.apl test.dll  

¶ ¢ƻ ŎƻƳǇƛƭŜ ŀ Φb9¢ /ƭŀǎǎ ƭƛōǊŀǊȅΥ 

cbi62.exe - .net:ClassLibrary test.apl test.dll  



 

9 

CƻǊ ŀƴ ŀǇǇƭƛŎŀǘƛƻƴ ǘƻ ŎƻƳǇƛƭŜ ŎƻǊǊŜŎǘƭȅ ŦǊƻƳ ǘƘŜ ŎƻƳƳŀƴŘ ƭƛƴŜΣ ǘƘŜ ŎƻƳƳŀƴŘ Ƴǳǎǘ ƳŀǘŎƘ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΩǎ 
ōǳƛƭŘ ǘŀǊƎŜǘ όŦǊƻƳ ǘƘŜ .ǳƛƭŘ {ŜǘǘƛƴƎǎ ŘƛŀƭƻƎ ōƻȄύΦ ¢ƘŜ ŦƻƭƭƻǿƛƴƎ ǘŀōƭŜ ǎƘƻǿǎ ǘƘŜ ǊŜǎǳƭǘǎ ƻŦ ŜŀŎƘ Φb9¢ ŎƻƳƳŀƴŘ 
ƭƛƴŜ ǎǿƛǘŎƘ ǿƘŜƴ ǳǎŜŘ ƻƴ ŀƴ ŀǇǇƭƛŎŀǘƛƻƴ ǿƛǘƘ ǘƘŜ ƛƴŘƛŎŀǘŜŘ ōǳƛƭŘ ǘŀǊƎŜǘΦ 

Φb9¢ /ƻƳƳŀƴŘ [ƛƴŜ {ǿƛǘŎƘ !ǇǇƭƛŎŀǘƛƻƴΩǎ /ǳǊǊŜƴǘ .ǳƛƭŘ {ŜǘǘƛƴƎ wŜǎǳƭǘ 

ΦƴŜǘΥ²tC5Ŝǎƪ¢ƻǇ ǿƛƴ он 9·9Σ Φb9¢ ²tC 5ŜǎƪǘƻǇΣ Φb9¢ ²tC 
.ǊƻǿǎŜǊ 

Φb9¢ ²tC 5ŜǎƪǘƻǇ 

!ƭƭ ƻǘƘŜǊǎ ΦŜǊǊ όŜǊǊƻǊ ŦƛƭŜύ 

ΦƴŜǘΥ²tC.ǊƻǿǎŜǊ ǿƛƴ он 9·9Σ Φb9¢ ²tC 5ŜǎƪǘƻǇΣ Φb9¢ ²tC 
.ǊƻǿǎŜǊ 

Φb9¢ ²tC .ǊƻǿǎŜǊ 

!ƭƭ ƻǘƘŜǊǎ ΦŜǊǊ όŜǊǊƻǊ ŦƛƭŜύ 

ΦƴŜǘΥ/ƭŀǎǎ[ƛōǊŀǊȅ LƴŎƭǳŘŜ [ƛōǊŀǊȅΣ Φb9¢ /ƭŀǎǎ [ƛōǊŀǊȅ Φb9¢ /ƭŀǎǎ [ƛōǊŀǊȅ 

!ƭƭ ƻǘƘŜǊǎ ΦŜǊǊ όŜǊǊƻǊ ŦƛƭŜύ 

ΦƴŜǘΥ{![[ƛōǊŀǊȅ 5ȅƴŀƭƛōΣ Φb9¢ {![ [ƛōǊŀǊȅ Φb9¢ {![ [ƛōǊŀǊȅ 

!ƭƭ ƻǘƘŜǊǎ ΦŜǊǊ όŜǊǊƻǊ ŦƛƭŜύ 

ΦƴŜǘΥ!ǳǘƻ5Ŝǎƪ¢ƻǇ ǿƛƴ он 9·9Σ Φb9¢ ²tC 5ŜǎƪǘƻǇΣ Φb9¢ ²tC 
.ǊƻǿǎŜǊ 

Φb9¢ ²tC 5ŜǎƪǘƻǇ 

LƴŎƭǳŘŜ [ƛōǊŀǊȅΣ Φb9¢ /ƭŀǎǎ [ƛōǊŀǊȅ Φb9¢ /ƭŀǎǎ [ƛōǊŀǊȅ 

5ȅƴŀƭƛōΣ Φb9¢ {![ [ƛōǊŀǊȅ Φb9¢ {![ [ƛōǊŀǊȅ 

!ƭƭ ƻǘƘŜǊǎ ΦŜǊǊ όŜǊǊƻǊ ŦƛƭŜύ 

ΦƴŜǘΥ!ǳǘƻ.ǊƻǿǎŜǊ ǿƛƴ он 9·9Σ Φb9¢ ²tC 5ŜǎƪǘƻǇΣ Φb9¢ ²tC 
.ǊƻǿǎŜǊ 

Φb9¢ ²tC .ǊƻǿǎŜǊ 

LƴŎƭǳŘŜ [ƛōǊŀǊȅΣ Φb9¢ /ƭŀǎǎ [ƛōǊŀǊȅ Φb9¢ /ƭŀǎǎ [ƛōǊŀǊȅ 

5ȅƴŀƭƛōΣ Φb9¢ {![ [ƛōǊŀǊȅ Φb9¢ {![ [ƛōǊŀǊȅ 

!ƭƭ ƻǘƘŜǊǎ ΦŜǊǊ όŜǊǊƻǊ ŦƛƭŜύ 

$ÁÔÁ 4ÙÐÅ -ÁÔÃÈÉÎÇ 

bŀǘƛǾŜ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ŀǇǇƭƛŎŀǘƛƻƴǎ ŀƭƭƻǿ ŦƻǊ ǎƻƳŜ ƳƛȄƛƴƎ ƻŦ Řŀǘŀ ǘȅǇŜǎΦ CƻǊ ŜȄŀƳǇƭŜΣ ŀ ƴǳƳōŜǊ ǾŀǊƛŀōƭŜ Ŏŀƴ 
Ŏƻƴǘŀƛƴ ŀ ǿƛƴŘƻǿ ƘŀƴŘƭŜΦ Lƴ Φb9¢ ōǳƛƭŘ ǘŀǊƎŜǘǎΣ ǘƘƛǎ ǘȅǇŜ ƻŦ ƳƛǎƳŀǘŎƘ ŎŀǳǎŜǎ ŀ ŎƻƳǇƛƭŜǊ ŜǊǊƻǊΦ 

Ȣ.%4 3ÏÕÒÃÅ #ÏÄÅ 

¢ƘŜ L[ ŎƻƳǇƛƭŜǊ ŘƻŜǎ ƴƻǘ ƎŜƴŜǊŀǘŜ /І ƻǊ ƻǘƘŜǊ aƛŎǊƻǎƻŦǘ ǎƻǳǊŎŜ ŎƻŘŜΦ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ Ŏƻƴǘŀƛƴǎ ŀ ǘǊǳŜ Φb9¢ 
ŎƻƳǇƛƭŜǊ ǘƘŀǘ ŎƻƳǇƛƭŜǎ ǘƘŜ {![ ƭŀƴƎǳŀƎŜ ŘƛǊŜŎǘƭȅ ǘƻ 

Φb9¢ LƴǘŜǊƳŜŘƛŀǘŜ [ŀƴƎǳŀƎŜΦ ¢ƘŜ ƻƴƭȅ L59 ǘƘŀǘ Ŏŀƴ ŜŘƛǘ ŀƴŘ ŎƻƳǇƛƭŜ {![ ŎƻŘŜ ƛǎ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊΦ 
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¢ƘŜǊŜ ƛǎ ŀ ǎƛȊŜ ƭƛƳƛǘŀǘƛƻƴ ǘƻ ¢5 ŎƻŘŜ ǿƘŜƴ ōŜƛƴƎ ŎƻƳǇƛƭŜŘ ǘƻ Φb9¢Φ ¢Ƙƛǎ ŎƻƳŜǎ ŦǊƻƳ ǘƘŜ aƛŎǊƻǎƻŦǘ Φb9¢ 
!ǎǎŜƳōƭŜǊΣ ǿƘƻǎŜ ƳŜƳƻǊȅ ǳǎŀƎŜ Ŏŀƴ ŎƭƛƳō ƻǾŜǊ нD. ƛŦ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ƛǎ ƭŀǊƎŜ ŜƴƻǳƎƘΦ Lƴ ¢5Σ ƛǘ ǎŜŜƳǎ ǘƻ ōŜ  
ŀǊƻǳƴŘ срлΣллл ƻǳǘƭƛƴŜ ƛǘŜƳǎΦ ¦ǎƛƴƎ ǘƘŜ сп-ōƛǘ ǾŜǊǎƛƻƴ ƻŦ ǘƘŜ ŀǎǎŜƳōƭŜǊ όǿƘƛŎƘ ¢5 ǿƛƭƭ Řƻ ǿƘŜƴ ǇƻǎǎƛōƭŜύ 
ǊŜƳƻǾŜǎ ǘƘŜ ǎƛȊŜ ƭƛƳƛǘŀǘƛƻƴΦ 

/ƻƳǇƛƭƛƴƎ ǘƻ Φb9¢п ǎŜŜƳǎ ǘƻ ǎƘǊƛƴƪ ǘƘŜ ǎƛȊŜ ƻŦ ǘƘŜ L[Σ ōǳȅƛƴƎ ǘƘŜ ǳǎŜǊ ŀ ƭƛǘǘƭŜ ƳƻǊŜ ǘƛƳŜΣ ǇŜǊƘŀǇǎ ŀƭƭƻǿƛƴƎ ŀ 
тллΣллл-уллΣллл ƻǳǘƭƛƴŜ ƛǘŜƳ ŀǇǇƭƛŎŀǘƛƻƴ ōŜŦƻǊŜ ǘƘŜ ƳŜƳƻǊȅ ƭƛƳƛǘ ƛǎ ǊŜŀŎƘŜŘΦ 

'5) &ÕÎÃÔÉÏÎÓ ÉÎ $,,Ó 

Φb9¢ Ŏƭŀǎǎ ƭƛōǊŀǊƛŜǎΣ Φb9¢ {![ ƭƛōǊŀǊƛŜǎ ŀƴŘ Φb9¢ ²Ŝō ǎŜǊǾƛŎŜǎ Řƻ ƴƻǘ ǎǳǇǇƻǊǘ D¦L ƻōƧŜŎǘǎΦ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ 
ŀǇǇƭƛŎŀǘƛƻƴǎ ǘƘŀǘ ǳǎŜ D¦L ŦǳƴŎǘƛƻƴǎ ǊŜǇƻǊǘ ǿŀǊƴƛƴƎǎ ǿƘŜƴ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ƛǎ ōǳƛƭǘ ŀǎ ŀ Φb9¢ Ŏƭŀǎǎ ƭƛōǊŀǊȅ ƻǊ ŀ 
Φb9¢ {![ ƭƛōǊŀǊȅΦ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ŀǇǇƭƛŎŀǘƛƻƴǎ ǘƘŀǘ ǳǎŜ D¦L ŦǳƴŎǘƛƻƴǎ ǊŜǇƻǊǘ ŜǊǊƻǊǎ ǿƘŜƴ ōǳƛƭǘ ŀǎ ŀ Φb9¢ ²Ŝō 
ǎŜǊǾƛŎŜ ŘƭƭΦ 

 



 

11 

#ÈÁÐÔÅÒ ς ɀ ,ÉÂÒÁÒÉÅÓ ÁÎÄ &ÕÎÃÔÉÏÎÓ 

¢Ƙƛǎ ŎƘŀǇǘŜǊ ǇǊƻǾƛŘŜǎ ƛƴŦƻǊƳŀǘƛƻƴ ŀōƻǳǘ ǿƘƛŎƘ ƭƛōǊŀǊƛŜǎ ŀƴŘ ŦǳƴŎǘƛƻƴǎ ŀǊŜ ǎǳǇǇƻǊǘŜŘ ōȅ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ŦƻǊ 
Φb9¢ ǇǊƻƧŜŎǘǎ ŦƻǊ ǘƘŜ ŦƻƭƭƻǿƛƴƎΥ 

¶ vǳƛŎƪhōƧŜŎǘǎ 

¶ ±ƛǎǳŀƭ ¢ƻƻƭŎƘŜǎǘ 

¶ 9ȄǘŜǊƴŀƭ ƭƛōǊŀǊƛŜǎ ŀƴŘ !tLǎ ƛƴ ƎŜƴŜǊŀƭ 

¶ ¦ƴǎǳǇǇƻǊǘŜŘ {![ ŦǳƴŎǘƛƻƴǎ 

¶ ¦ƴǎǳǇǇƻǊǘŜŘ !t[ǎ 

¶ {ǳǇǇƻǊǘŜŘ ²aψϝ ƳŜǎǎŀƎŜǎ 

1ÕÉÃË/ÂÊÅÃÔÓ 

²ƛǘƘ ǘƘŜ ŜȄŎŜǇǘƛƻƴ ƻŦ vǳƛŎƪDǊŀǇƘǎΣ vǳƛŎƪhōƧŜŎǘǎ ŀǊŜ ƴƻǘ ǎǳǇǇƻǊǘŜŘ ŦƻǊ Φb9¢ ǇǊƻƧŜŎǘǎΦ IƻǿŜǾŜǊΣ ǘƘŜ 
vǳƛŎƪ¢ŀōн¢ŀō ǘƻƻƭ ŜƴŀōƭŜǎ ȅƻǳ ǘƻ ŎƻƴǾŜǊǘ ȅƻǳǊ vǳƛŎƪ¢ŀōǎ ǘƻ ƴŀǘƛǾŜ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ¢ŀō /ƻƴǘǊƻƭǎΦ ¢ƘŜ ƴŀǘƛǾŜ 
¢ŀō /ƻƴǘǊƻƭ ƛǎ ǎǳǇǇƻǊǘŜŘ ŦƻǊ Φb9¢ ǇǊƻƧŜŎǘǎΦ 

1ÕÉÃË4ÁÂς4ÁÂ 4ÏÏÌ 

¦ǎŜ ǘƘƛǎ ǘƻƻƭ ǘƻ ǇǊŜǇŀǊŜ ŀƴ ŀǇǇƭƛŎŀǘƛƻƴ ŦƻǊ Φb9¢ ŘŜǇƭƻȅƳŜƴǘΦ /ƻƴǾŜǊǎƛƻƴ ŦǊƻƳ vǳƛŎƪ¢ŀōǎ ǘƻ ƴŀǘƛǾŜ ¢ŀō 
/ƻƴǘǊƻƭǎ ƛǎ ƴƻǘ ǊŜǉǳƛǊŜŘ ŦƻǊ ²ƛƴон ŀǇǇƭƛŎŀǘƛƻƴǎΦ 

¢ƘŜ vǳƛŎƪ¢ŀōн¢ŀō ǘƻƻƭ όǉǘŀōнǘŀōΦŜȄŜύ ƛǎ ƭƻŎŀǘŜŘ ƛƴ ǘƘŜ Ǌƻƻǘ ŘƛǊŜŎǘƻǊȅ ƻŦ ȅƻǳǊ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ƛƴǎǘŀƭƭŀǘƛƻƴΦ ¢ƻ 
ŎƻƴǾŜǊǘ ŀƴ ŀǇǇƭƛŎŀǘƛƻƴΩǎ vǳƛŎƪ¢ŀōǎ ǘƻ ƴŀǘƛǾŜ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ǘŀō ŎƻƴǘǊƻƭǎΣ ŜȄŜŎǳǘŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǎǘŜǇǎΥ 

1. Make a copy of the target application and included libraries (qtab2tab.exe overwrites files; it does not 
create copies). 

2. Find qtab2tab.exe in your Team Developer installation directory and double-click it to launch the 
QuickTab2Tab conversion tool. 

3. Using the explorer tree at the left, find the directory that contains the application file you want to 
convert. 

4. (Optionalύ ¦ǎŜ ǘƘŜ ά!ƭƭ hǳǘƭƛƴŜ CƛƭŜǎέ ŘǊƻǇŘƻǿƴ ōƻȄ ǘƻ ŦƛƭǘŜǊ ǘƘŜ ŘƛǎǇƭŀȅŜŘ ŦƛƭŜǎ ōȅ ŦƛƭŜ type. 

5. In the list at the right, select the file you want to convert and click Convert Selected File. 

!ǇǇƭƛŎŀǘƛƻƴ ŎƻƴǾŜǊǎƛƻƴ Ŏŀƴƴƻǘ ōŜ ŘƻƴŜ ƛƴ ǇƛŜŎŜǎΦ ¢ƻ ŎƻƴǾŜǊǘ ŀƴ ŀǇǇƭƛŎŀǘƛƻƴ ŀƴŘ ƛǘǎ ƛƴŎƭǳŘŜŘ ƭƛōǊŀǊƛŜǎΣ ŎƻƴǾŜǊǘ 
ǘƘŜ ǘƻǇ-ƭŜǾŜƭ ΦŀǇǇ ŦƛƭŜΦ vǳƛŎƪ¢ŀōн¢ŀō ŦƛƴŘǎ ǘƘŜ ƴŜŎŜǎǎŀǊȅ ƭƛōǊŀǊƛŜǎ ŀƴŘ ŎƻƴǾŜǊǘǎ ǘƘŜƳ ŀǎ ǿŜƭƭΦ 

¢ƘŜ vǳƛŎƪ¢ŀōн¢ŀō ǘƻƻƭ ǊŜŀŘǎ ŀƴŘ ŎƻƴǾŜǊǘǎ ǘƘŜ ǊŜǉǳƛǊŜŘ ŦƛƭŜǎΦ 5ǳǊƛƴƎ ǘƘŜ ǇǊƻŎŜǎǎΣ ȅƻǳ ǿƛƭƭ ǎŜŜ ǇǊƻƎǊŜǎǎ ōŀǊǎ 
ƭƛƪŜ ǘƘŜ ƻƴŜ ǇƛŎǘǳǊŜŘ ōŜƭƻǿΦ ! ƳŜǎǎŀƎŜ ōƻȄ ƛƴŦƻǊƳǎ ȅƻǳ ǿƘŜƴ ŎƻƴǾŜǊǎƛƻƴ ƛǎ ŎƻƳǇƭŜǘŜΦ 
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²ƘŜƴ ŎƻƴǾŜǊǎƛƻƴ ƛǎ ŎƻƳǇƭŜǘŜΣ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴ ŦƛƭŜ ŀƴŘ ŀƴȅ ƛƴŎƭǳŘŜŘ ƭƛōǊŀǊƛŜǎ ǘƘŀǘ ŎƻƴǘŀƛƴŜŘ vǳƛŎƪ¢ŀōǎ ǿƛƭƭ 
ƘŀǾŜ ōŜŜƴ ƻǾŜǊǿǊƛǘǘŜƴΦ ¢ƘŜ ǳǇŘŀǘŜŘ ŦƛƭŜǎ ǿƛƭƭ Ŏƻƴǘŀƛƴ ƴŀǘƛǾŜ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ǘŀō ōŀǊ ŎƻƴǘǊƻƭǎΣ ŀƴŘ ŀƴȅ ŦƛƭŜǎ 
ǘƘŀǘ ǇǊŜǾƛƻǳǎƭȅ ƛƴŎƭǳŘŜŘ ǉŎƪǘŀōǎΦŀǇƭ ŀƴŘ ǇŀƎŜƭƛǎǘΦŀǇƭ ǿƛƭƭ ƴƻǿ ƛƴŎƭǳŘŜ ǉǘŀōнǘŀōΦŀǇƭΦ 

vǳƛŎƪ¢ŀōн¢ŀō ŘƻŜǎ ƴƻǘ ƳƛƎǊŀǘŜ ŎƭŀǎǎŜǎ ŘŜǊƛǾŜŘ ŦǊƻƳ Ŏ{²¢ŀōǎ ƻǊ Ŏ¢ŀōtŀƎŜ[ƛǎǘΦ ¢ƘŜǎŜ Ƴǳǎǘ ōŜ ŘƻƴŜ ƳŀƴǳŀƭƭȅΦ 

¢ƘŜ ŦƻƭƭƻǿƛƴƎ vǳƛŎƪ¢ŀō ŦǳƴŎǘƛƻƴǎ ŀǊŜ ƴƻǘ ǎǳǇǇƻǊǘŜŘ ŦƻǊ vǳƛŎƪ¢ŀōн¢ŀō ŎƻƴǾŜǊǎƛƻƴΥ 

/ŀƴŎŜƭaƻŘŜ 5ŜƭŜǘŜ CƛƴŘbŀƳŜ 

DŜǘ/ƻƴǘŜƴǘǎ.ƻǊŘŜǊwŜŎǘ DŜǘ/ƻƴǘŜƴǘǎwŜŎǘ DŜǘ/ƻƴǘŜƴǘǎwŜŎǘtƛȄŜƭǎ 

DŜǘ5Ǌŀǿ{ǘȅƭŜ DŜǘaŀǊƎƛƴwŜŎǘ DŜǘaƛƴƛƳǳƳ²ƛŘǘƘ 

DŜǘbŀƳŜ DŜǘwƻǿ/ƻǳƴǘ LƴŘŜȄCǊƻƳtƻƛƴǘ 

LƴƛǘCǊƻƳtǊƻǇǎ LƴǎŜǊǘ {Ŝǘ5Ǌŀǿ{ǘȅƭŜ 

{ŜǘaƛƴƛƳǳƳwŜǎƛȊŜ{ƛȊŜ {ŜǘbŀƳŜ {Ŝǘwƻǿ/ƻǳƴǘ 

{Ŝǘ²ƻǊƪǎǇŀŎŜ.ƻǳƴŘŀǊȅ {Ƙƻǿ{ƛōƭƛƴƎǎ  
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6ÉÓÕÁÌ 4ÏÏÌÃÈÅÓÔ 

¢ƘŜ ±ƛǎǳŀƭ ¢ƻƻƭŎƘŜǎǘ Ŏƻƴǎƛǎǘǎ ƻŦ ǎŜǾŜǊŀƭ Ŏƭŀǎǎ ƭƛōǊŀǊƛŜǎ ŀƴŘ Ƴŀƴȅ ǎǘŀƴŘ-ŀƭƻƴŜ ŦǳƴŎǘƛƻƴǎΦ aƻǎǘ ƻŦ ǘƘŜ ǎǘŀƴŘ-

ŀƭƻƴŜ ŦǳƴŎǘƛƻƴǎ ŀǊŜ ƛƳǇƭŜƳŜƴǘŜŘ ŦƻǊ Φb9¢ ŎƻƳǇŀǘƛōƛƭƛǘȅΣ ōǳǘ ǎƻƳŜ ŀǊŜ ƴƻǘΦ ±ƛǎǳŀƭ ¢ƻƻƭŎƘŜǎǘ Ŏƭŀǎǎ ƭƛōǊŀǊƛŜǎ ŀǊŜ 
Ƴƻǎǘƭȅ ǳƴǎǳǇǇƻǊǘŜŘΣ ǿƛǘƘ ŀ ŎƻǳǇƭŜ ƻŦ ŜȄŎŜǇǘƛƻƴǎΦ 

9ǾŜƴ ǿƘŜƴ ŀ ±ƛǎǳŀƭ ¢ƻƻƭŎƘŜǎǘ Ŏƭŀǎǎ ƭƛōǊŀǊȅ ƛǎ ǎǳǇǇƻǊǘŜŘΣ ǘƘŜǊŜ ƛǎ ƴƻ ƳŜŎƘŀƴƛǎƳ ŦƻǊ ŀŎŎŜǎǎƛƴƎ ǾŀǊƛŀōƭŜǎ ƛƴ 
ƛƳǇƻǊǘŜŘ Φb9¢ ŀǎǎŜƳōƭƛŜǎΦ ¢ƘǳǎΣ ƛǘ ƛǎ ƴƻǘ ǇƻǎǎƛōƭŜ ǘƻ ŘƛǊŜŎǘƭȅ ŀŎŎŜǎǎ ƳŜƳōŜǊ ǾŀǊƛŀōƭŜǎ ƻŦ ŀ ±ƛǎǳŀƭ ¢ƻƻƭŎƘŜǎǘ 
Ŏƭŀǎǎ ǿƘŜƴ ōǳƛƭŘƛƴƎ ǘƻ Φb9¢Φ 

3ÔÁÎÄ-!ÌÏÎÅ &ÕÎÃÔÉÏÎÓ 

¢ƘŜ ŦƻƭƭƻǿƛƴƎ ǎǘŀƴŘ-ŀƭƻƴŜ ±ƛǎǳŀƭ ¢ƻƻƭŎƘŜǎǘ ŦǳƴŎǘƛƻƴǎ ŀǊŜ ǎǳǇǇƻǊǘŜŘ ŦƻǊ Φb9¢ ǇǊƻƧŜŎǘǎΥ 

ǾǘŀǊǊŀȅΦŀǇƭ 

±ƛǎ!ǊǊŀȅ!ǇǇŜƴŘ ±ƛǎ!ǊǊŀȅ/ƻǇȅ 
 ±ƛǎ!ǊǊŀȅ5ŜƭŜǘŜLǘŜƳ  
±ƛǎ!ǊǊŀȅCƛƭƭ5ŀǘŜ¢ƛƳŜ 

±ƛǎ!ǊǊŀȅCƛƭƭbǳƳōŜǊ  
±ƛǎ!ǊǊŀȅCƛƭƭ{ǘǊƛƴƎ  
±ƛǎ!ǊǊŀȅCƛƴŘ5ŀǘŜ¢ƛƳŜ  
±ƛǎ!ǊǊŀȅCƛƴŘbǳƳōŜǊ 

±ƛǎ!ǊǊŀȅCƛƴŘ{ǘǊƛƴƎ  
±ƛǎ!ǊǊŀȅLƴǎŜǊǘLǘŜƳ ±ƛǎ!ǊǊŀȅ{ƻǊǘ 

ǾǘŘŜōǳƎΦŀǇƭ 

±ƛǎ5ŜōǳƎ.ŜƎƛƴ¢ƛƳŜ  
±ƛǎ5ŜōǳƎ9ƴŘ¢ƛƳŜ  
±ƛǎ5ŜōǳƎDŜǘCƭŀƎǎ 

±ƛǎ5ŜōǳƎ{ŜǘCƭŀƎǎ  
±ƛǎ5ŜōǳƎ{Ŝǘ[ŜǾŜƭ 

±ƛǎ5ŜōǳƎ{Ŝǘ¢ƛƳŜ  
±ƛǎ5ŜōǳƎ{ǘǊƛƴƎ 

ǾǘŘƻǎΦŀǇƭ 

±ƛǎ5ƻǎ.ǳƛƭŘCǳƭƭbŀƳŜ 
±ƛǎ5ƻǎ9ƴǳƳ5ƛǊLƴŦƻ 
±ƛǎ5ƻǎ9ƴǳƳ5ƛǊǎ 
±ƛǎ5ƻǎ9ƴǳƳ5ǊƛǾŜǎ 
±ƛǎ5ƻǎ9ƴǳƳCƛƭŜLƴŦƻ 
±ƛǎ5ƻǎ9ƴǳƳCƛƭŜǎ 
±ƛǎ5ƻǎ9ƴǳƳtŀǘƘ 
±ƛǎ5ƻǎ9Ȅƛǎǘ 

±ƛǎ5ƻǎLǎtŀǊŜƴǘ 
±ƛǎ5ƻǎDŜǘ/ǳǊ5ƛǊ 
±ƛǎ5ƻǎDŜǘ5ǊƛǾŜ{ƛȊŜ 
±ƛǎ5ƻǎDŜǘ5ǊƛǾŜ¢ȅǇŜ 
±ƛǎ5ƻǎDŜǘ9ƴǾ{ǘǊƛƴƎ 
±ƛǎ5ƻǎDŜǘCƭŀƎǎ 
±ƛǎ5ƻǎDŜǘbŜǘbŀƳŜ 

±ƛǎ5ƻǎDŜǘ±ŜǊǎƛƻƴ 
±ƛǎ5ƻǎDŜǘ±ƻƭǳƳŜ[ŀōŜƭ 
±ƛǎ5ƻǎaŀƪŜ!ƭƭ5ƛǊ 
±ƛǎ5ƻǎaŀƪŜtŀǘƘ 
±ƛǎ5ƻǎ{ŜǘCƭŀƎǎ 
±ƛǎ5ƻǎ{ǇƭƛǘtŀǘƘ 
±ƛǎ5ƻǎ{Ŝǘ±ƻƭǳƳŜ[ŀōŜƭ 

ǾǘŦƛƭŜΦŀǇƭ 

±ƛǎCƛƭŜ!ǇǇŜƴŘ 
±ƛǎCƛƭŜ/ƭƻǎŜ 
±ƛǎCƛƭŜ/ƻǇȅ 
±ƛǎCƛƭŜ/ǊŜŀǘŜ¢ŜƳǇ 
±ƛǎCƛƭŜ5ŜƭŜǘŜ 
±ƛǎCƛƭŜ9ȄǇŀƴŘ 
±ƛǎCƛƭŜCƛƴŘ 
±ƛǎCƛƭŜDŜǘ!ǘǘǊƛōǳǘŜ 

±ƛǎCƛƭŜDŜǘ{ƛȊŜ 
±ƛǎCƛƭŜDŜǘ¢ȅǇŜ 
±ƛǎCƛƭŜhǇŜƴ 
±ƛǎCƛƭŜwŜŀŘ 
±ƛǎCƛƭŜwŜŀŘ.ƛƴŀǊȅ 
±ƛǎCƛƭŜwŜŀŘ{ǘǊƛƴƎ 
±ƛǎCƛƭŜwŜƴŀƳŜ 
±ƛǎCƛƭŜ{Ŝǘ!ǘǘǊƛōǳǘŜ 

±ƛǎCƛƭŜ{Ŝǘ5ŀǘŜ¢ƛƳŜ 
±ƛǎCƛƭŜ{ŜŜƪ 
±ƛǎCƛƭŜ¢Ŝƭƭ 
±ƛǎCƛƭŜ²ǊƛǘŜ 
±ƛǎCƛƭŜ²ǊƛǘŜ.ƛƴŀǊȅ 
±ƛǎCƛƭŜ²ǊƛǘŜ{ǘǊƛƴƎ 

ǾǘƳŜƴǳΦŀǇƭ   

±ƛǎaŜƴǳ/ƘŜŎƪ 
±ƛǎaŜƴǳ5ŜƭŜǘŜ 
±ƛǎaŜƴǳ5ƛǎŀōƭŜ 
±ƛǎaŜƴǳ9ƴŀōƭŜ 
±ƛǎaŜƴǳDŜǘ/ƻǳƴǘ 
±ƛǎaŜƴǳDŜǘIŀƴŘƭŜ 

±ƛǎaŜƴǳDŜǘtƻǇǳǇIŀƴŘƭŜ 
±ƛǎaŜƴǳDŜǘ¢ŜȄǘ 
±ƛǎaŜƴǳLǎ/ƘŜŎƪŜŘ 
±ƛǎaŜƴǳLǎ9ƴŀōƭŜŘ 
±ƛǎaŜƴǳLƴǎŜǊǘ 
±ƛǎaŜƴǳLƴǎŜǊǘCƻƴǘ 

±ƛǎaŜƴǳLƴǎŜǊǘtƛŎǘǳǊŜ 
±ƛǎaŜƴǳ{ŜǘCƻƴǘ 
±ƛǎaŜƴǳ{ŜǘtƛŎǘǳǊŜ 
±ƛǎaŜƴǳ{Ŝǘ¢ŜȄǘ 
±ƛǎaŜƴǳ¦ƴŎƘŜŎƪ 
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ǾǘƳƛǎŎΦŀǇƭ 

±ƛǎDŜǘ±ŜǊǎƛƻƴ  
±ƛǎDŜǘ²ƛƴCƭŀƎǎ 

±ƛǎDŜǘ²ƛƴ±ŜǊǎƛƻƴ  
±ƛǎ{ŜƴŘaǎƎ{ǘǊƛƴ 

±ƛǎbǳƳōŜǊ/ƘƻƻǎŜ  
±ƛǎtǊƻŦƛƭŜ9ƴǳƳ{ǘǊƛƴƎǎ 

ǾǘǎǘǊΦŀǇƭ 

±ƛǎ{ǘǊ/ƘƻƻǎŜ 
±ƛǎ{ǘǊ9ȄǇŀƴŘ 
±ƛǎ{ǘǊCƛƴŘ 
±ƛǎ{ǘǊCǊŜŜ¢ŀōƭŜ 
±ƛǎ{ǘǊ[ŜŦǘ¢ǊƛƳ 

±ƛǎ{ǘǊ[ƻŀŘ¢ŀōƭŜ 
±ƛǎ{ǘǊtŀŘ 
±ƛǎ{ǘǊtǊƻǇŜǊ 
±ƛǎ{ǘǊwƛƎƘǘ¢ǊƛƳ 

±ƛǎ{ǘǊ{ŎŀƴwŜǾŜǊǎŜ 
±ƛǎ{ǘǊ{ǳōǎǘƛǘǳǘŜ 
±ƛǎ{ǘǊ¢ǊƛƳ 
±ƛǎ{ǘǊtŀŘ. 

ǾǘǘōƭǿƛƴΦŀǇƭ 

±ƛǎ¢ōƭ/ƭŜŀǊ/ƻƭǳƳƴ{ŜƭŜŎǘƛƻƴ ±ƛǎ¢ōƭCƛƴŘ5ŀǘŜ¢ƛƳŜ  

ǾǘǿƛƴΦŀǇƭ 

±ƛǎ²ƛƴ/ƭŜŀǊ!ƭƭCƛŜƭŘǎ 
±ƛǎ²ƛƴ/ƭŜŀǊ!ƭƭ9ŘƛǘCƭŀƎǎ 
±ƛǎ²ƛƴCǊŜŜ!ŎŎŜƭŜǊŀǘƻǊ 
±ƛǎ²ƛƴDŜǘCƭŀƎǎ 
±ƛǎ²ƛƴDŜǘIŀƴŘƭŜ 
±ƛǎ²ƛƴDŜǘ{ǘȅƭŜ 
±ƛǎ²ƛƴDŜǘ¢ŜȄǘ 

±ƛǎ²ƛƴLǎ/ƘƛƭŘ 
±ƛǎ²ƛƴLǎaŀȄƛƳƛȊŜŘ 
±ƛǎ²ƛƴLǎaƛƴƛƳƛȊŜŘ 
±ƛǎ²ƛƴLǎwŜǉǳƛǊŜŘCƛŜƭŘbǳƭƭ 
±ƛǎ²ƛƴLǎwŜǎǘƻǊŜŘ 
±ƛǎ²ƛƴLǎ²ƛƴŘƻǿ 

±ƛǎ²ƛƴ[ƻŀŘ!ŎŎŜƭŜǊŀǘƻǊ 
±ƛǎ²ƛƴaƻǾŜ 
±ƛǎ²ƛƴ{ŜǘCƭŀƎǎ 
±ƛǎ²ƛƴ{Ŝǘ{ǘȅƭŜ 
±ƛǎ²ƛƴ{Ŝǘ¢ŀōhǊŘŜǊ 
±ƛǎ²ƛƴ{Ƙƻǿ 

64 ,ÉÂÒÁÒÉÅÓ 

¢ƘŜ ŦƻƭƭƻǿƛƴƎ ±ƛǎǳŀƭ ¢ƻƻƭŎƘŜǎǘ Ŏƭŀǎǎ ƭƛōǊŀǊƛŜǎ ŀƴŘ ŀǎǎƻŎƛŀǘŜŘ ōŀǎŜ ŎƭŀǎǎŜǎ ŀǊŜ ǎǳǇǇƻǊǘŜŘ ŦƻǊ Φb9¢ ǇǊƻƧŜŎǘǎΦ 
hǘƘŜǊ ±ƛǎǳŀƭ ¢ƻƻƭŎƘŜǎǘ Ŏƭŀǎǎ ƭƛōǊŀǊƛŜǎ ŀǊŜ ƴƻǘ ǎǳǇǇƻǊǘŜŘΦ 

ǾǘŎƻƳƳΦŀǇƭ 

.ŀǎŜ ŎƭŀǎǎŜǎΥ ǎtƻƛƴǘΣ ǎwŜŎǘΣ ǎ{ƛȊŜΦ 

ǾǘǎǇƭƛǘΦŀǇƭ 

.ŀǎŜ ŎƭŀǎǎŜǎΥ Ŏ{ǇƭƛǘǘŜǊΣ Ŏ{ǇƭƛǘǘŜǊ²ƛƴŘƻǿΦ 

ǾǘƳŜǘŜǊΦŀǇƭ 

.ŀǎŜ ŎƭŀǎǎŜǎΥ ŎaŜǘŜǊ 

ǾǘŎŀƭΦŀǇƭ 

.ŀǎŜ ŎƭŀǎǎŜǎΥ Ŏ/ŀƭŜƴŘŀǊΣ Ŏ/ŀƭŜƴŘŀǊ5ǊƻǇ5ƻǿƴ 

/ǳǊǊŜƴǘƭȅ ƴƻ ƳŜǘƘƻŘǎ ŀǊŜ ǎǳǇǇƻǊǘŜŘ ŦƻǊ ǾǘŎŀƭΦŀǇƭΦ 

ǾǘƭōȄΦŀǇƭ 

.ŀǎŜ ŎƭŀǎǎŜǎΥ ŎhǳǘƭƛƴŜ[ƛǎǘ.ƻȄΣ ŎtƛŎǘǳǊŜ[ƛǎǘ.ƻȄΣ ŎwŀŘƛƻ[ƛǎǘ.ƻȄΣ Ŏ/ƻƭƻǊ[ƛǎǘ.ƻȄ 
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%ØÔÅÒÎÁÌ ,ÉÂÒÁÒÉÅÓ ÁÎÄ !0)Ó ÉÎ 'ÅÎÅÒÁÌ 

$ÁÔÁÔÙÐÅÓ ÉÎ %ØÔÅÒÎÁÌ $,,Ó 

²ƘŜƴ ǳǎƛƴƎ ŀƴ ŜȄǘŜǊƴŀƭ 5[[ ƛƴ ŀ Φb9¢ ǇǊƻƧŜŎǘ ŀƴŘ ŎŀƭƭƛƴƎ ƛǘǎ ŦǳƴŎǘƛƻƴǎΣ ǊŜƳŜƳōŜǊ ǘƘŀǘ ƴŀǘƛǾŜ ¢5κ{![ / 
ŘŀǘŀǘȅǇŜǎ ŀǊŜ ƴƻǘ ǎǳǇǇƻǊǘŜŘ ŀǎ ǊŜǘǳǊƴ ǾŀƭǳŜǎΣ ǇŀǊŀƳŜǘŜǊǎ ƻǊ ǊŜŎŜƛǾŜ ǇŀǊŀƳŜǘŜǊǎΦ ¢ƘŜǎŜ ŘŀǘŀǘȅǇŜǎ ƛƴŎƭǳŘŜΥ 

¶ 5!¢9¢La9 

¶ ICL[9 

¶ I¦5± 

¶ I²b5 ϝǎŜŜ ƴƻǘŜ ōŜƭƻǿ 

¶ I{9{{LhbI!b5[9 

¶ I{v[I!b5[9 

¶ [t5!¢9¢La9 

¶ [tICL[9 

¶ [tb¦a.9w 

¶ [t{9{{LhbI!b5[9 

¶ [tI{v[I!b5[9 

hƴƭȅ ǇǊƛƳƛǘƛǾŜ /κ/ҌҌ ǘȅǇŜǎ ŀǊŜ ǎǳǇǇƻǊǘŜŘΣ ǿƛǘƘ ǘƘŜ ŜȄŎŜǇǘƛƻƴ ƻŦ I!ww! Σ̧ I¦5±Σ ŀƴŘ {¢w¦/¢thLb¢9wΣ ǿƘƛŎƘ 
ŀǊŜ ƴƻǘ ǎǳǇǇƻǊǘŜŘΦ 

²tC ŀǇǇƭƛŎŀǘƛƻƴǎ ǳǎŜ ƻōƧŜŎǘ ǊŜŦŜǊŜƴŎŜǎ ǊŀǘƘŜǊ ǘƘŀƴ ǿƛƴŘƻǿ ƘŀƴŘƭŜǎΦ aƻŘŜǊƴƛȊƛƴƎ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴ ǘƻ Φb9¢ 
ŀƴŘ ƳƻǾƛƴƎ ǘƻ ²tC ƳŜŀƴǎ ƳƻǾƛƴƎ ŀǿŀȅ ŦǊƻƳ ƳŀƴƛǇǳƭŀǘƛƴƎ ǿƛƴŘƻǿǎ Ǿƛŀ !tL ŎŀƭƭǎΦ CƻǊǘǳƴŀǘŜƭȅΣ ǘƘŜ 
ŦǳƴŎǘƛƻƴŀƭƛǘȅ ȅƻǳ ŀŎǉǳƛǊŜŘ Ǿƛŀ ŜȄǘŜǊƴŀƭ !tLǎ ƛƴ ǘƘŜ Ǉŀǎǘ ƛǎ ǇǊƻōŀōƭȅ ŀǾŀƛƭŀōƭŜ ƛƴ ƴŀǘƛǾŜ {![ ŎƻŘŜ ƴƻǿΦ 

ÕÓÅÒσςȢÄÌÌ .ÏÔ 3ÕÐÐÏÒÔÅÄ ÉÎ Ȣ.%4 

¢Ƙƛǎ ƛǎ ŀ ²ƛƴон 5[[ ŀƴŘ Ŏŀƴƴƻǘ ōŜ ƳŀŘŜ ǘƻ ǿƻǊƪ ƛƴ Φb9¢Φ 

!ÓÓÅÍÂÌÙ )ÎÆÏÒÍÁÔÉÏÎ ÆÏÒ !0,Ó 

¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ Ŏƻƴǘŀƛƴǎ Φb9¢ ŀǎǎŜƳōƭȅ ƛƴŦƻǊƳŀǘƛƻƴ ŦƻǊ ǘƘŜ ŦƻƭƭƻǿƛƴƎ !t[ǎΦ ¢Ƙƛǎ ƛǎ ƴƻǘ ŀ ƭƛǎǘ ƻŦ Ŧǳƭƭȅ-
ǎǳǇǇƻǊǘŜŘ !t[ǎ ƛƴ Φb9¢Φ wŀǘƘŜǊΣ ǘƘŜǎŜ ŀǊŜ !t[ǎ ǘƘŀǘ ǿƛƭƭ ƴƻǘ ŎŀǳǎŜ ŎƻƳǇƛƭŜǊ ŜǊǊƻǊǎ ǿƘŜƴ ƛƴŎƭǳŘŜŘ ƛƴ ŀ Φb9¢ 
ǇǊƻƧŜŎǘΦ .ŜŎŀǳǎŜ ŀǎǎŜƳōƭȅ ƛƴŦƻǊƳŀǘƛƻƴ ƛǎ ŀǾŀƛƭŀōƭŜΣ ǘƘŜ ǇǊƻƧŜŎǘ ǿƛƭƭ ŎƻƳǇƛƭŜΦ ¸ƻǳ ǿƛƭƭ ŀƭǎƻ ǎŜŜ ǘƘŜ ǎȅƳōƻƭ 
ƛƴŦƻǊƳŀǘƛƻƴ ƛƴ ǘƘŜ 9ȄǘŜǊƴŀƭ !ǎǎŜƳōƭƛŜǎ ǎŜŎǘƛƻƴ ƻŦ ǘƘŜ ƻǳǘƭƛƴŜΦ Lƴ Ƴƻǎǘ ŎŀǎŜǎΣ ƘƻǿŜǾŜǊΣ ǘƘŜ ŀǎǎŜƳōƭȅ 
ƛƴŦƻǊƳŀǘƛƻƴ ǿƛƭƭ ƴƻǘ ƛƴŎƭǳŘŜ ŜǾŜǊȅ ŦǳƴŎǘƛƻƴ ƛƴ ǘƘŜ !t[Φ 

¸ƻǳ Ŏŀƴ ŎƘŜŎƪ ƛŦ ŀƴ !t[ Ƙŀǎ ŀǎǎŜƳōƭȅ ƛƴŦƻǊƳŀǘƛƻƴ ōȅ ŘƻƛƴƎ ǘƘŜ ŦƻƭƭƻǿƛƴƎΥ  

1. Open the APL. 

2. Right-click its name at the top of the tree view and select Properties. 

3. Click the Assembly File ǘŀōΦ LŦ ǘŜȄǘ ŀǇǇŜŀǊǎ ƛƴ ǘƘŜ ŦƛŜƭŘ ǳƴŘŜǊ ά!ǎǎŜƳōƭȅ LƳǇƻǊǘ CƛƭŜέΣ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ Ƙŀǎ 
assembly information for this APL. 

!ǳǘƻƳŀǘƛƻƴΦŀǇƭ ±¢/ƻƳƳΦŀǇƭ 
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ŎƎƳŀƛƭΦŀǇƭ 
ŎŘƪΦŀǇƭ 
/{ǘǊǳŎǘ[ΦŀǇƭ 
D¢ŀōƭŜ·ΦŀǇƭ 
h5.{ŀƭонΦŀǇƭ 
vŎƪ5±/ΦŀǇƭ 
vŎƪaŀƛƭΦŀǇƭ 
vŎƪ¢ŀōǎΦŀǇƭ 
{ŀƭaŀƛƭΦŀǇƭ 
ǎǉƭƴǿƪŎƴΦŀǇƭ 
±¢!ǊǊŀȅΦŀǇƭ 
±¢/ƻƳ5ƭƎΦŀǇƭ 

±¢5ŜōǳƎΦŀǇƭ 
±¢5hǎΦŀǇƭ 
±¢CƛƭŜΦŀǇƭ 
±¢[ōȄΦŀǇƭ 
±¢ƭǎǘǾǿΦŀǇƭ 
±¢aŜƴǳΦŀǇƭ 
ǾǘƳŜǘŜǊΦŀǇƭ 
±¢aƛǎŎΦŀǇƭ 
ǾǘǎǇƭƛǘΦŀǇƭ 
±¢{ǘǊΦŀǇƭ 
±¢¢ōƭ²ƛƴΦŀǇƭ 
ȄƳƭƭƛōΦŀǇƭ 

5ÎÓÕÐÐÏÒÔÅÄ 3!, &ÕÎÃÔÉÏÎÓ 

¢ƘŜ ŦƻƭƭƻǿƛƴƎ {![ ŦǳƴŎǘƛƻƴǎ ŀǊŜ ƴƻǘ ǎǳǇǇƻǊǘŜŘ ŦƻǊ Φb9¢ ōǳƛƭŘ ǘŀǊƎŜǘǎΥ 

{ŀƭ!ŎǘƛǾŜ·!ǳǘƻ9ǊǊƻǊaƻŘŜ {ŀƭ!ŎǘƛǾŜ·/ǊŜŀǘŜCǊƻƳ5ŀǘŀ 

{ŀƭ!ŎǘƛǾŜ·/ǊŜŀǘŜCǊƻƳCƛƭŜ {ŀƭ!ŎǘƛǾŜ·5ŜƭŜǘŜ 

{ŀƭ!ŎǘƛǾŜ·DŜǘ5ŀǘŀ {ŀƭ!ŎǘƛǾŜ·DŜǘCƛƭŜbŀƳŜ 

{ŀƭ!ŎǘƛǾŜ·LƴǎŜǊǘhōƧŜŎǘ5ƭƎ {ŀƭ!ŎǘƛǾŜ·h[9¢ȅǇŜ 

{ŀƭ!ǇǇCƛƴŘ {ŀƭ/ƻƴǘŜȄǘ.ǊŜŀƪ 

{ŀƭ/ǊŜŀǘŜ²ƛƴŘƻǿ9ȄCǊƻƳ{ǘǊ {ŀƭ/ǊŜŀǘŜ²ƛƴŘƻǿCǊƻƳ{ǘǊ 

{ŀƭ559!ŘŘ!ǘƻƳ {ŀƭ559!ƭƭƻŎ 

{ŀƭ5595ŜƭŜǘŜ!ǘƻƳ {ŀƭ5599ȄǘǊŀŎǘ 

{ŀƭ5599ȄǘǊŀŎǘ/ƳŘ {ŀƭ5599ȄǘǊŀŎǘ5ŀǘŀ¢ŜȄǘ 

{ŀƭ5599ȄǘǊŀŎǘhǇǘƛƻƴǎ {ŀƭ559CƛƴŘ!ǘƻƳ 

{ŀƭ559CǊŜŜ {ŀƭ559DŜǘ!ǘƻƳbŀƳŜ 

{ŀƭ559DŜǘ9ȄŜŎǳǘŜ{ǘǊƛƴƎ {ŀƭ559tƻǎǘ 

{ŀƭ559wŜǉǳŜǎǘ {ŀƭ559{ŜƴŘ 

{ŀƭ559{ŜƴŘ!ƭƭ {ŀƭ559{ŜƴŘ9ȄŜŎǳǘŜ 

{ŀƭ559{ŜƴŘ¢ƻ/ƭƛŜƴǘ {ŀƭ559{Ŝǘ/ƳŘ 

{ŀƭ559{Ŝǘ5ŀǘŀ¢ŜȄǘ {ŀƭ559{ŜǘhǇǘƛƻƴǎ 

{ŀƭ559{ǘŀǊǘ{ŜǊǾŜǊ {ŀƭ559{ǘŀǊǘ{Ŝǎǎƛƻƴ 

{ŀƭ559{ǘƻǇ{ŜǊǾŜǊ {ŀƭ559{ǘƻǇ{Ŝǎǎƛƻƴ 

{ŀƭ5ǊƻǇCƛƭŜǎvǳŜǊȅtƻƛƴǘ {ŀƭ9Řƛǘ/ŀƴtŀǎǘŜ[ƛƴƪ 

{ŀƭ9Řƛǘ/ŀƴtŀǎǘŜ{ǇŜŎƛŀƭ {ŀƭCƻƴǘDŜǘ{ƛȊŜǎ 

{ŀƭDŜǘ¢ȅǇŜ9Ȅ {ŀƭI.ƛƴŀǊȅ¢ƻbǳƳōŜǊ 

{ŀƭIǘƳƭIŜƭǇ {ŀƭLŘƭŜYƛŎƪ 
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{ŀƭLŘƭŜwŜƎƛǎǘŜǊ²ƛƴŘƻǿ {ŀƭLŘƭŜ¦ƴǊŜƎƛǎǘŜǊ²ƛƴŘƻǿ 

{ŀƭaƻŘŀƭ5ƛŀƭƻƎCǊƻƳ{ǘǊ {ŀƭa¢{/ǊŜŀǘŜLƴǎǘŀƴŎŜ 

{ŀƭa¢{5ƛǎŀōƭŜ/ƻƳƳƛǘ {ŀƭa¢{9ƴŀōƭŜ/ƻƳƳƛǘ 

{ŀƭa¢{DŜǘhōƧŜŎǘ/ƻƴǘŜȄǘ {ŀƭa¢{Lǎ/ŀƭƭŜǊLƴwƻƭŜ 

{ŀƭa¢{LǎLƴ¢ǊŀƴǎŀŎǘƛƻƴ {ŀƭa¢{Lǎ{ŜŎǳǊƛǘȅ9ƴŀōƭŜŘ 

{ŀƭa¢{{Ŝǘ!ōƻǊǘ {ŀƭa¢{{Ŝǘ/ƻƳǇƭŜǘŜ 

{ŀƭbǳƳōŜǊ¢ƻI.ƛƴŀǊȅ {ŀƭhōƧLǎbǳƭƭ 

{ŀƭhǳǘƭƛƴŜ/ƘƛƭŘhŦ¢ȅǇŜ {ŀƭhǳǘƭƛƴŜ/ǳǊǊŜƴǘ 

{ŀƭhǳǘƭƛƴŜLǘŜƳhŦ²ƛƴŘƻǿ {ŀƭhǳǘƭƛƴŜLǘŜƳ¢ȅǇŜ¢ŜȄǘ 

{ŀƭwŜǇƻǊǘ/ƭƻǎŜ {ŀƭwŜǇƻǊǘ/ǊŜŀǘŜ 

{ŀƭwŜǇƻǊǘDŜǘwƛŎƘ¢ŜȄǘ±ŀǊ {ŀƭwŜǇƻǊǘ{ŜǘwƛŎƘ¢ŜȄǘ±ŀǊ 

{ŀƭwƛōōƻƴ{ŜǘLǘŜƳ¢ǊŀƴǎǇŀǊŜƴǘ /ƻƭƻǊ {ŀƭ{ǘŀǘƛŎCƛǊǎǘ 

{ŀƭ{ǘŀǘƛŎDŜǘ{ƛȊŜ {ŀƭ{ǘŀǘƛŎ{Ŝǘ{ƛȊŜ 

{ŀƭ{ǘǊ¢ƻaǳƭǘƛ.ȅǘŜ {ŀƭ{ǘǊ¢ƻ²ƛŘŜ/ƘŀǊ 

{ŀƭ¢ŀō{ŜǘtŀƎŜ¢ǊŀƴǎǇŀǊŜƴǘ/ƻƭƻǊ {ŀƭ¢ōƭ{Ŝǘ/ƻƭǳƳƴ·a[!ǘǘǊƛōǳǘŜǎ 

{ŀƭ¢ōƭ{Ŝǘ±ƛŜǿ {ŀƭ¢ōƭvǳŜǊȅ±ƛŜǿ 

{ŀƭ²ƛƴŘƻǿDŜǘ5ƻŎƪ{ŜǘǘƛƴƎ {ŀƭ²ƛƴDŜǘ{ǘȅƭŜ 

{ŀƭ·a[5ŜǎŜǊƛŀƭƛȊŜ¦5± {ŀƭ·a[DŜǘ[ŀǎǘ9ǊǊƻǊ 

{ŀƭ·a[{ŜǊƛŀƭƛȊŜ¦5± {ŀƭ¸ƛŜƭŘ9ƴŀōƭŜ 

{ŀƭ¸ƛŜƭŘvǳŜǊȅ{ǘŀǘŜ {ŀƭ¸ƛŜƭŘ{ǘƻǇaŜǎǎŀƎŜǎ 

{ŀƭ¸ƛŜƭŘ{ǘŀǊǘaŜǎǎŀƎŜǎ {ǉƭ/ƭƻǎŜ 

{ǉƭ/ƭƻǎŜ!ƭƭ{twŜǎǳƭǘ{Ŝǘǎ {ǉƭ/ƭƻǎŜwŜǎǳƭǘ{Ŝǘ 

{ǉƭ/ƻƴƴŜŎǘ¢ǊŀƴǎŀŎǘƛƻƴ {ǉƭ/ƻƴǘŜȄǘ{Ŝǘ¢ƻCƻǊƳ 

{ǉƭ5ŜƭŜǘŜ/ƻƴƴŜŎǘƛƻƴ{ǘǊƛƴƎ {ǉƭ5ǊƻǇ{ǘƻǊŜŘ/ƳŘ 

{ǉƭCƛƴŘLƴƛCƛƭŜ {ǉƭDŜǘ/ƻƴƴŜŎǘƛƻƴ{ǘǊƛƴƎǎ 

{ǉƭDŜǘ/ƳŘhǊwƻǿǎŜǘtǘǊ {ǉƭDŜǘ/ǳǊǎƻǊ 

{ǉƭDŜǘ9ǊǊƻǊtƻǎƛǘƛƻƴ {ǉƭDŜǘ5{hǊ{ŜǎǎƛƻƴtǘǊ 

{ǉƭDŜǘ[ŀǎǘ{ǘŀǘŜƳŜƴǘ {ǉƭDŜǘwƻƭƭōŀŎƪCƭŀƎ 

{ǉƭDŜǘ{ǘŀǘŜƳŜƴǘ9ǊǊƻǊLƴŦƻ {ǉƭLƳƳŜŘƛŀǘŜ/ƻƴǘŜȄǘ 

{ǉƭ[ƛǎǘ/ƻƴƴŜŎǘƛƻƴǎ {ǉƭhǇŜƴ 

{ǉƭhǊŀt[{v[{ǘǊƛƴƎ.ƛƴŘ¢ȅǇŜ {ǉƭwŜǘǊƛŜǾŜ 

{ǉƭ{ǘƻǊŜ {ǉƭ²ǊƛǘŜ/ƻƴƴŜŎǘƛƻƴ{ǘǊƛƴƎ 
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5ÎÓÕÐÐÏÒÔÅÄ !0,Ó 

¢ƘŜ ŦƻƭƭƻǿƛƴƎ !t[ǎ ŀǊŜ ƴƻǘ ǎǳǇǇƻǊǘŜŘ ƛƴ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ сΦнΦ 

ŀȄǘƳǇƭΦŀǇƭ 

ŎŘƪΦŀǇƭ 

ŎŘƪŦǿǊƪΦŀǇƭ 

ŎƎƳŀƛƭΦŀǇƭ 

ƎǘŀōƭŜȄΦŀǇƭ ƳǳƭǘƛǘōƭΦŀǇƭ 

ǇŀƎŜƭƛǎǘΦŀǇƭ 

ǎǿōƛŘƛонΦŀǇƭ 

¢ƭbƻǘƛŦȅΦŀǇƭ 

ǘǘƳƴƎǊΦŀǇƭ 

3ÕÐÐÏÒÔÅÄ 7-ͺɕ -ÅÓÓÁÇÅÓ 

Lƴ ²tC ŀǇǇƭƛŎŀǘƛƻƴǎΣ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ²aψϝ ƳŜǎǎŀƎŜǎ ŀǊŜ ǎǳǇǇƻǊǘŜŘ ŦƻǊ ǘƘŜ ǿƛƴŘƻǿ ǘȅǇŜǎ ƭƛǎǘŜŘΦ 

¶ ²aψ[.¦¢¢hb5h²b 

.ǳǘǘƻƴ /ƘŜŎƪ .ƻȄ hǇǘƛƻƴ 5ŀǘŀ CƛŜƭŘ 

wƛŎƘ ¢ŜȄǘ .ƻȄ [ƛǎǘ .ƻȄ tƛŎǘǳǊŜ .ƻȄ 

/ƘƛƭŘ DǊƛŘκ/ƘƛƭŘ ¢ŀōƭŜκ¢ŀōƭŜ ²ƛƴŘƻǿκDǊƛŘ ²ƛƴŘƻǿ 

¶ ²aψw.¦¢¢hb5h²b 

CƻǊƳκ5ƛŀƭƻƎ 

!ƭƭ ŎƻƴǘǊƻƭǎ ŜȄŎŜǇǘΥ  

5ŀǘŀ CƛŜƭŘǎ 

aǳƭǘƛ-ƭƛƴŜ ǘŜȄǘ ¢ŀō ōŀǊ bŀǾƛƎŀǘƛƻƴ .ŀǊ 

¶ ²aψ[.¦¢¢hb¦t 

.ǳǘǘƻƴ /ƘŜŎƪ .ƻȄ 5ŀǘŀ CƛŜƭŘ 

wƛŎƘ ¢ŜȄǘ .ƻȄ /ƻƳōƻ .ƻȄ 

¶ ²aψw.¦¢¢hb¦t 

/ƘƛƭŘ DǊƛŘ /ƘƛƭŘ ¢ŀōƭŜ DǊƛŘ ²ƛƴŘƻǿ ¢ŀōƭŜ ²ƛƴŘƻǿ 

¶ ²aψ/I!w 

!ƭƭ ŦƛŜƭŘ ŎƻƴǘǊƻƭǎ ό5ŀǘŀ CƛŜƭŘΣ /ƻƳōƻ .ƻȄΣ aǳƭǘƛƭƛƴŜΣ wƛŎƘ ¢ŜȄǘΣ /ƻƭǳƳƴύ /ƘƛƭŘ DǊƛŘ 

/ƘƛƭŘ ¢ŀōƭŜ ¢ŀōƭŜ ²ƛƴŘƻǿ DǊƛŘ ²ƛƴŘƻǿ 

¶ ²aψY9¸¦t 

!ƭƭ ŎƻƴǘǊƻƭǎ ŜȄŎŜǇǘΥ  

tǳǎƘōǳǘǘƻƴ 

tƛŎǘǳǊŜ ¢ŀō ōŀǊ 

bŀǾƛƎŀǘƛƻƴ ōŀǊ 

¢ƻǇ [ŜǾŜƭ DǊƛŘ ²ƛƴŘƻǿ ¢ƻǇ [ŜǾŜƭ ¢ŀōƭŜ ²ƛƴŘƻǿ 
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¶ ²aψY9¸5h²b 

5ŀǘŀ CƛŜƭŘ wƛŎƘ ¢ŜȄǘ .ƻȄ /ƘƛƭŘ DǊƛŘ  

/ƘƛƭŘ ¢ŀōƭŜ [ƛǎǘ .ƻȄ /ƻƳōƻ .ƻȄ  

/ƻƭǳƳƴ 

¶ ²aψ[.¦¢¢hb5.[/[Y 

5ŀǘŀ CƛŜƭŘ wƛŎƘ ¢ŜȄǘ .ƻȄ /ƻƳōƻ .ƻȄ 

¶ ²aψw.¦¢¢hb5.[/[Y 

bƻǘ ǎǳǇǇƻǊǘŜŘ ƛƴ ²tCΦ 

¶ ²aψah¦{9ah±9 

bƻǘ ǎǳǇǇƻǊǘŜŘ ƛƴ ²tCΦ 

¶ ²aψYL[[Ch/¦{ 

5ŀǘŀ CƛŜƭŘ wƛŎƘ ¢ŜȄǘ .ƻȄ 

¶ ²aψ{L½9 

CƻǊƳκ5ƛŀƭƻƎ a5L 
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#ÈÁÐÔÅÒ σ ɀ 70& !ÐÐÌÉÃÁÔÉÏÎÓ 

¢Ƙƛǎ ŎƘŀǇǘŜǊ ŘƛǎŎǳǎǎŜǎ ²tC ŀǇǇƭƛŎŀǘƛƻƴǎ ŀƴŘ ǘƘŜƛǊ ŀǎǎƻŎƛŀǘŜŘ ŦƛƭŜǎΣ ŘŜǎŎǊƛōŜǎ ²tC ŘŜǎƪǘƻǇ ŀƴŘ ōǊƻǿǎŜǊ 
ŀǇǇƭƛŎŀǘƛƻƴǎΣ ŀƴŘ ŜȄǇƭŀƛƴǎ ·!a[ ŦƛƭŜǎ ŀƴŘ Ƙƻǿ ǘƻ ŎǳǎǘƻƳƛȊŜ ǘƘŜƳΦ 

70& !ÐÐÌÉÃÁÔÉÏÎÓ 

¢ƘŜ .ǳƛƭŘ {ŜǘǘƛƴƎǎ ŘƛŀƭƻƎ ōƻȄ ǇǊƻǾƛŘŜǎ ǘǿƻ ²tC ƻǇǘƛƻƴǎΥ ²tC 5ŜǎƪǘƻǇ ŀƴŘ ²tC .ǊƻǿǎŜǊΦ ¢ƘŜǎŜ ǘǿƻ ƻǇǘƛƻƴǎ 
ŀǊŜ ǾƛǊǘǳŀƭƭȅ ǘƘŜ ǎŀƳŜΦ ¢ƘŜ ǊŜǎǳƭǘƛƴƎ ŀǇǇƭƛŎŀǘƛƻƴǎ ŀǊŜ ƛŘŜƴǘƛŎŀƭ ŜȄŎŜǇǘ ǘƘŀǘ ƻƴŜ Ŏŀƴ ōŜ ŘŜǇƭƻȅŜŘ ƻƴ ǘƘŜ 
ŘŜǎƪǘƻǇ ŀƴŘ ǘƘŜ ƻǘƘŜǊ ƛǎ ƘƻǎǘŜŘ ƛƴ ŀ ōǊƻǿǎŜǊΦ 

.Ŝǎǘ ǇǊŀŎǘƛŎŜǎ ŦƻǊ ²tC ŀǇǇƭƛŎŀǘƛƻƴǎ ƛƴŎƭǳŘŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎΥ 

¶ bŀƳŜǎ ƻŦ ²tC .ǊƻǿǎŜǊ ŀǇǇƭƛŎŀǘƛƻƴǎ Ŏŀƴƴƻǘ Ŏƻƴǘŀƛƴ ǎƻƳŜ ǇǳƴŎǘǳŀǘƛƻƴ ŎƘŀǊŀŎǘŜǊǎΣ ǎǳŎƘ ŀǎ ώ όƻǇŜƴ 
ōǊŀŎƪŜǘύ ŀƴŘ ϐ όŎƭƻǎŜ ōǊŀŎƪŜǘύΦ 

¶ /ŜǊǘŀƛƴ ƪŜȅǿƻǊŘǎ ƛƴ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴ ŦƛƭŜ ƴŀƳŜ ǿƛƭƭ ŎŀǳǎŜ ŀ ά¦ǎŜǊ !ŎŎƻǳƴǘ /ƻƴǘǊƻƭέ ǿŀǊƴƛƴƎ ƛƴ ²ƛƴŘƻǿǎ 
ǿƘŜƴ ȅƻǳ ǘǊȅ ǘƻ Ǌǳƴ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΦ !ǾƻƛŘ ǿƻǊŘǎ ƭƛƪŜ άƛƴǎǘŀƭƭΣέ άǎŜǘǳǇΣέ ŀƴŘ άǳǇŘŀǘŜέ ƛƴ ȅƻǳǊ ŦƛƭŜ ƴŀƳŜΦ 

¶ ²tC ŀǇǇƭƛŎŀǘƛƻƴǎ Ŏŀƴƴƻǘ ƘŀǾŜ ǘǿƻ ǘƻǇ-ƭŜǾŜƭ ƛǘŜƳǎ ǿƛǘƘ ǘƘŜ ǎŀƳŜ ƴŀƳŜΦ ¢Ƙƛǎ ƛƴŎƭǳŘŜǎ ŀƴ a5L ǿƛƴŘƻǿ ŀƴŘ 
ƛǘǎ ŎƘƛƭŘ ŦƻǊƳ ǿƛƴŘƻǿΣ ǿƘƛŎƘ ŀǊŜ ōƻǘƘ ŎƻƴǎƛŘŜǊŜŘ ǘƻǇ-ƭŜǾŜƭ ǿƘŜƴ ŎƻƳǇƛƭƛƴƎ ǘƻ Φb9¢Φ 

¶ ²tC ŀǇǇƭƛŎŀǘƛƻƴǎ Ŏŀƴƴƻǘ ƛƴŎƭǳŘŜ ŀ ƭƛōǊŀǊȅ ǿƛǘƘ ǘƘŜ ǎŀƳŜ ƴŀƳŜ ŀǎ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΦ CƻǊ ŜȄŀƳǇƭŜΣ ȅƻǳ 
Ŏŀƴƴƻǘ Ŏŀƭƭ ŀ ƭƛōǊŀǊȅ ŎŀƭƭŜŘ ŦƻƻΦŘƭƭ ŦǊƻƳ ŀƴ ŀǇǇƭƛŎŀǘƛƻƴ ŎŀƭƭŜŘ ŦƻƻΦŜȄŜΦ 

¶ ²tC ŘƻŜǎ ƴƻǘ ƘŀǾŜ ŀ ƴƻǘƛƻƴ ƻŦ ŀ ŎŀŎƘŜΣ ǎƻ {!aψ/ŀŎƘŜCǳƭƭ ǿƛƭƭ ƴŜǾŜǊ ŦƛǊŜ ƛƴ ŀ ²tC ŀǇǇƭƛŎŀǘƛƻƴΦ 

¶ .ŜŎŀǳǎŜ ²tC .ǊƻǿǎŜǊ ŀǇǇƭƛŎŀǘƛƻƴǎ Ǌǳƴ ƛƴǎƛŘŜ ŀ ōǊƻǿǎŜǊ ǿƛƴŘƻǿΣ {!aψ/ƭƻǎŜ ŀƴŘ ²aψ/ƭƻǎŜ ƳŜǎǎŀƎŜǎ Řƻ 
ƴƻǘ ǎǳŎŎŜŜŘΦ LƴǎǘŜŀŘΣ ǳǎŜ {ŀƭ5ŜǎǘǊƻȅ²ƛƴŘƻǿΦ 

¶ Lƴ ²tC ŀǇǇƭƛŎŀǘƛƻƴǎΣ {ŀƭwŜǇƻǊǘ±ƛŜǿ ƭŀǳƴŎƘŜǎ ŀƴ ƛƴŘŜǇŜƴŘŜƴǘ ƛƴǎǘŀƴŎŜ ƻŦ wŜǇƻǊǘ .ǳƛƭŘŜǊ όǊŀǘƘŜǊ ǘƘŀƴ ŀ 
ǊǳƴǘƛƳŜ ǇǊŜǾƛŜǿ ǿƛƴŘƻǿύΦ 

¶ LŦ ǘƘŜ Φb9¢ пΦл ŦǊŀƳŜǿƻǊƪ ƛǎ ƛƴǎǘŀƭƭŜŘΣ ȅƻǳ ǿƛƭƭ ƴƻǘ ōŜ ŀōƭŜ ǘƻ ŘŜōǳƎ ²tC ōǊƻǿǎŜǊ ŀǇǇƭƛŎŀǘƛƻƴǎΦ ¢ƻ ŀǾƻƛŘ 
ǘƘƛǎ ǇǊƻōƭŜƳΣ ǳǎŜ ǘƘŜ Φb9¢ оΦр ŦǊŀƳŜǿƻǊƪ ƻǊ ŘŜōǳƎ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴǎ ǳǎƛƴƎ ǘƘŜ ²tC ŘŜǎƪǘƻǇ ōǳƛƭŘ ǘŀǊƎŜǘΦ 
όaƛŎǊƻǎƻŦǘ ǿƛƭƭ ǇǊƻōŀōƭȅ ǊŜƭŜŀǎŜ ŀ ŦƛȄ ŦƻǊ ǘƘƛǎ ōǳƎ ǎƻƻƴΦύ 

¶ ²ƘŜƴ ŘŜōǳƎƎƛƴƎ ²tC ŀǇǇƭƛŎŀǘƛƻƴǎΣ {ǘŜǇ Lƴǘƻ ŀƴŘ {ǘŜǇ hǾŜǊ ǿƻǊƪ ŘƛŦŦŜǊŜƴǘƭȅ ǘƘŀƴ ƛƴ ²ƛƴонΦ ̧ƻǳ ǿƛƭƭ ƴŜŜŘ 
ǘƻ ǎŜǘ ŀ ŘƛǎǘƛƴŎǘ ōǊŜŀƪ Ǉƻƛƴǘ ŦƻǊ ŜŀŎƘ ƳŜǎǎŀƎŜ ƻǊ ŜǾŜƴǘ ƛƴ ²tCΣ ƻǊ ŜƭǎŜ ŀƴ ŀǘǘŜƳǇǘ ǘƻ ά{ǘŜǇ Lƴǘƻέ ƳƛƎƘǘ 
ǊŜǎǳƭǘ ƛƴ ŀ ά{ǘŜǇ hǾŜǊΦέ 

¶ ¢ƻ Ǌǳƴ ¢5сл ²tC ŀǇǇƭƛŎŀǘƛƻƴǎ ǳǎƛƴƎ !5htǊƻȄȅ ǊǳƴƴƛƴƎ ƻƴ сп-ōƛǘ ƳŀŎƘƛƴŜΣ ȅƻǳ Ƴǳǎǘ ŜƴŀōƭŜ он-ōƛǘ 
!ǇǇƭƛŎŀǘƛƻƴǎ ƳƻŘŜ ƻƴ LL{Φ ¢ƻ Řƻ ǘƘƛǎΣ Ŧƻƭƭƻǿ ǘƘŜǎŜ ǎǘŜǇǎΥ 

a. /ƭƛŎƪ ±ƛŜǿ !ǇǇƭƛŎŀǘƛƻƴ tƻƻƭǎΦ 

b. {Ŝǘ !ǇǇƭƛŎŀǘƛƻƴ Ǉƻƻƭ ŘŜŦŀǳƭǘǎΦ 

c. {Ŝǘ 9ƴŀōƭŜ он-ōƛǘ !ǇǇƭƛŎŀǘƛƻƴǎ ǘƻ ¢w¦9Φ 
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8!-, &ÉÌÅÓ 

·!a[ ƛǎ ŀƴ ·a[-ōŀǎŜŘ ƳŀǊƪǳǇ ƭŀƴƎǳŀƎŜ ŘŜǾŜƭƻǇŜŘ ōȅ aƛŎǊƻǎƻŦǘΦ Lǘ ƛǎ ǘƘŜ ƭŀƴƎǳŀƎŜ ōŜƘƛƴŘ ǘƘŜ Ǿƛǎǳŀƭ 
ǇǊŜǎŜƴǘŀǘƛƻƴ ƻŦ ²tC ŀǇǇƭƛŎŀǘƛƻƴǎΦ ·!a[ ƛǎ ǎƛƳƛƭŀǊ ǘƻ I¢a[ ƛƴ ǘƘŀǘ ƛǘ ƛǎ ǘŜȄǘ ōŀǎŜŘ ŀƴŘ ǘŀƎ ōŀǎŜŘΣ ŀƴŘ ƛǘ 
ŘŜǘŜǊƳƛƴŜǎ ǘƘŜ ƭƻƻƪ ŀƴŘ ǎǘǊǳŎǘǳǊŜ ƻŦ ŀ ǇǊƻƧŜŎǘΦ Lƴ ǘƘŜ ŎŀǎŜ ƻŦ I¢a[Σ ǘƘŜ ǇǊƻƧŜŎǘ ƛǎ ŀ ǿŜōǇŀƎŜΦ Lƴ ǘƘŜ ŎŀǎŜ ƻŦ 
·!a[Σ ǘƘŜ ǇǊƻƧŜŎǘ ƛǎ ŀƴ ŀǇǇƭƛŎŀǘƛƻƴΦ Lƴ ¢5Σ ·!a[ ŦƛƭŜǎ ŘŜǘŜǊƳƛƴŜ ǘƘŜ Ǿƛǎǳŀƭ ŀǎǇŜŎǘǎ ƻŦ ŀ ¢5 ŀǇǇƭƛŎŀǘƛƻƴ 
ŘŜǇƭƻȅŜŘ ŀǎ ²tCΦ 

²ƘŜƴ ȅƻǳ ŎƻƳǇƛƭŜ ŀ ¢5 ŀǇǇƭƛŎŀǘƛƻƴ ǿƛǘƘ ŀ ²tC ōǳƛƭŘ ǘŀǊƎŜǘΣ ·!a[ Řŀǘŀ ƛǎ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ŎǊŜŀǘŜŘΣ ŀƭǘƘƻǳƎƘ ƛǘ 
ƛǎ ƴƻǘ ŜȄǇƻǎŜŘ ŀǎ ƛƴŘŜǇŜƴŘŜƴǘ ŦƛƭŜǎΦ LŦ ȅƻǳ ŘŜŎƛŘŜ ǘƻ ŎǳǎǘƻƳƛȊŜ ǘƘŜ ·!a[Σ ŦƛƭŜǎ ŀǊŜ ŎǊŜŀǘŜŘ ƛƴ ȅƻǳǊ ǇǊƻƧŜŎǘ 
ŘƛǊŜŎǘƻǊȅ ŦƻǊ ȅƻǳ ǘƻ ǾƛŜǿ ŀƴŘ ŜŘƛǘ όǎŜŜ /ǳǎǘƻƳƛȊƛƴƎ ·!a[ ŦƛƭŜǎΣ ǿƘƛŎƘ ŦƻƭƭƻǿǎύΦ ¢ƘŜǎŜ ·!a[ ŦƛƭŜǎ Ŏƻƴǘŀƛƴ ŎƻŘŜ 
ǘƘŀǘ ǎǇŜŎƛŦƛŜǎ ǘƘŜ ƭŀȅƻǳǘΣ ǎǘǊǳŎǘǳǊŜΣ ǎƛȊŜΣ ŎƻƭƻǊǎΣ ŜǘŎΦ ƻŦ ǘƘŜ ǾŀǊƛƻǳǎ ǿƛƴŘƻǿǎΣ ōǳǘǘƻƴǎΣ ŀƴŘ ƻǘƘŜǊ Ǿƛǎǳŀƭ 
ŜƭŜƳŜƴǘǎ ƛƴ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴΦ ! ΦȄŀƳƭ ŦƛƭŜ ƛǎ ŎǊŜŀǘŜŘ ŦƻǊ ŜŀŎƘ ǘƻǇ-ƭŜǾŜƭ ŘƛŀƭƻƎ ōƻȄΣ ŦƻǊƳ ǿƛƴŘƻǿΣ a5L ǿƛƴŘƻǿΣ 
ƎǊƛŘ ǿƛƴŘƻǿΣ ŀƴŘ ǘŀōƭŜ ǿƛƴŘƻǿΦ 

¢ƘŜ ŦƻƭƭƻǿƛƴƎ ǎŎǊŜŜƴǎƘƻǘǎ ǎƘƻǿ ŀ ǎƛƳǇƭŜ ŦƻǊƳ ǿƛƴŘƻǿ ŀǎ ƛǘ ŀǇǇŜŀǊǎ ƛƴ ǘƘŜ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ƻǳǘƭƛƴŜ ŀƴŘ 
ƭŀȅƻǳǘΣ ŀƴŘ ǘƘŜ ǊŜǎǳƭǘƛƴƎ ·!a[ ŦƛƭŜ ŀǎ ǾƛŜǿŜŘ ƛƴ ǘƘŜ ŜŘƛǘƻǊ ǇǊƻǾƛŘŜŘ ǿƛǘƘ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊΦ 

 



 

22 

#ÕÓÔÏÍÉÚÉÎÇ 8!-, ÆÉÌÅÓ 

¢ƘŜ ǇǊŜǾƛƻǳǎ ǎŎǊŜŜƴǎƘƻǘ ƻŦ ǘƘŜ ·!a[ ŦƛƭŜ ǎƘƻǿǎ ǘƘŜ ŦƛƭŜ ōŜƛƴƎ ǾƛŜǿŜŘ ƛƴ ǘƘŜ YŀȄŀƳƭ-ōŀǎŜŘ ŜŘƛǘƻǊ ǘƘŀǘ ǎƘƛǇǎ 
ǿƛǘƘ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊΦ ¸ƻǳ Ŏŀƴ ŀŎŎŜǎǎ YŀȄŀƳƭ ǘƘǊƻǳƎƘ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ōȅ ǊƛƎƘǘ-ŎƭƛŎƪƛƴƎ ƻƴ ŀ ǇŀǊŜƴǘ ǿƛƴŘƻǿ ƻŦ 
ŀƴȅ ǘȅǇŜ ƛƴ ǘƘŜ ƻǳǘƭƛƴŜ ƻǊ ƭŀȅƻǳǘ ǾƛŜǿΦ Lƴ ǘƘŜ ǊƛƎƘǘ-ŎƭƛŎƪ ƳŜƴǳ ǘƘŀǘ ŀǇǇŜŀǊǎΣ ǎŜƭŜŎǘ /ǳǎǘƻƳ ·!a[ ŀƴŘ ǘƘŜƴ 9Řƛǘ 
ŎǳǎǘƻƳ ·!a[ΦΦΦ 

²ƘŜƴ ȅƻǳ ǎŜƭŜŎǘ ά9Řƛǘ ŎǳǎǘƻƳ ·!a[Σέŀ ƴŜǿ ΦȄŀƳƭ ŦƻƭŘŜǊ ƛǎ ŎǊŜŀǘŜŘ ƛƴ ȅƻǳǊ ǇǊƻƧŜŎǘ ŘƛǊŜŎǘƻǊȅΣ ŀƴŘ ƛǘ ƛǎ 
ǇƻǇǳƭŀǘŜŘ ǿƛǘƘ ΦȄŀƳƭ ŦƛƭŜǎ ŦƻǊ ȅƻǳǊ ǇǊƻƧŜŎǘΦ YŀȄŀƳƭ ƭŀǳƴŎƘŜǎΣ ŀƴŘ ȅƻǳ Ŏŀƴ ǳǎŜ ƛǘ ǘƻ ǾƛŜǿ ŀƴŘ ŜŘƛǘ ǘƘŜ ΦȄŀƳƭ 
ŦƛƭŜǎ όǎŜƭŜŎǘ άhǇŜƴέ ŦǊƻƳ ǘƘŜ ŦƛƭŜ ƳŜƴǳΣ ŦƛƴŘ ǘƘŜ ƴŜǿ ΦȄŀƳƭ ŘƛǊŜŎǘƻǊȅΣ ŀƴŘ ǎŜƭŜŎǘ ǘƘŜ ŦƛƭŜ ȅƻǳ ǿŀƴǘ ǘƻ 
ǾƛŜǿκŜŘƛǘύΦ 

.Ŝǎǘ ǇǊŀŎǘƛŎŜǎ ŦƻǊ ŎǳǎǘƻƳƛȊƛƴƎ ·!a[ ŦƛƭŜǎ ƛƴŎƭǳŘŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎΥ 

¶ ²ƘŜƴ ŎǳǎǘƻƳƛȊƛƴƎ ·!a[ ŦƛƭŜǎ ŦƻǊ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ŀǇǇƭƛŎŀǘƛƻƴǎΣ ǳǎŜ ǘƘŜ ·!a[ ŜŘƛǘƻǊ ǇǊƻǾƛŘŜŘ ǿƛǘƘ ¢ŜŀƳ 
5ŜǾŜƭƻǇŜǊΦ 

¶ ¦ǎŜ ǘƘŜ ƳŜǘƘƻŘ ƳŜƴǘƛƻƴŜŘ ŀōƻǾŜ ǘƻ ŀŎŎŜǎǎ ŎǳǎǘƻƳ ·!a[ ŦƛƭŜǎ όǊƛƎƘǘ-ŎƭƛŎƪκ /ǳǎǘƻƳ ·!a[κ9Řƛǘ ŎǳǎǘƻƳ 
·!a[ύΦ wǳƴƴƛƴƎ YŀȄŀƳƭΦŜȄŜ ƛƴŘŜǇŜƴŘŜƴǘƭȅ ƻǊ ƻǇŜƴƛƴƎ ΦȄŀƳƭ ŦƛƭŜǎ Ǿƛŀ ²ƛƴŘƻǿǎ 9ȄǇƭƻǊŜǊ ōȅǇŀǎǎŜǎ 
ƴŜŎŜǎǎŀǊȅ ƛƴŦƻǊƳŀǘƛƻƴ ŜȄŎƘŀƴƎŜ ōŜǘǿŜŜƴ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ŀƴŘ YŀȄŀƳƭΤ ŦƻǊ ŜȄŀƳǇƭŜΣ ƭƻŎŀǘƛƻƴ ƻŦ 
ƛƴǘŜǊƴŀƭƭȅ-ǎǘƻǊŜŘ ŀǇǇƭƛŎŀǘƛƻƴ ƛƳŀƎŜǎΦ 

¶ LŦ ȅƻǳ ƳŀƪŜ ǎƛƎƴƛŦƛŎŀƴǘ ǳǎŜǊ ƛƴǘŜǊŦŀŎŜ ŎƘŀƴƎŜǎ ƛƴ ȅƻǳǊ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ƻǳǘƭƛƴŜ ŀŦǘŜǊ ȅƻǳ ƘŀǾŜ ŎǳǎǘƻƳƛȊŜŘ 
ȅƻǳǊ ·!a[ ŦƛƭŜǎΣ ǳǇŘŀǘŜ ȅƻǳǊ ·!a[ ŦƛƭŜǎ ōȅ ŦƻƭƭƻǿƛƴƎ ǘƘŜǎŜ ǎǘŜǇǎΥ 

a. wŜƴŀƳŜ ȅƻǳǊ ΦȄŀƳƭ ŘƛǊŜŎǘƻǊȅ ǎƻ ǘƘŀǘ ǘƘŜ L[ ŎƻƳǇƛƭŜǊ ǿƛƭƭ ƴƻǘ ǊŜŎƻƎƴƛȊŜ ƛǘΦ 

b. /ƻƳǇƛƭŜ ȅƻǳǊ ǇǊƻƧŜŎǘΦ 

c. wƛƎƘǘ-ŎƭƛŎƪ ŀ ǇŀǊŜƴǘ ǿƛƴŘƻǿ ƛƴ ȅƻǳǊ ƻǳǘƭƛƴŜΣ ǎŜƭŜŎǘ /ǳǎǘƻƳ ·!a[ ŀƴŘ ǘƘŜƴ 9Řƛǘ ŎǳǎǘƻƳ ·!a[Φ ¢Ƙƛǎ 
ǿƛƭƭ ŎǊŜŀǘŜ ƴŜǿ ΦȄŀƳƭ ŦƛƭŜǎΦ 

d. ¦ǎƛƴƎ ŀ ŎƻƳǇŀǊƛǎƻƴ ǘƻƻƭΣ ŎƻƳǇŀǊŜ ǘƘŜ ƴŜǿ ΦȄŀƳƭ ŦƛƭŜǎ ǿƛǘƘ ȅƻǳǊ ƻƭŘ ŎǳǎǘƻƳƛȊŜŘ ŦƛƭŜǎ όƛƴ ǘƘŜ ŘƛǊŜŎǘƻǊȅ 
ȅƻǳ ǊŜƴŀƳŜŘύΦ ¸ƻǳ ǿƛƭƭ ǎŜŜ ŘƛŦŦŜǊŜƴŎŜǎ ǘƘŀǘ ŎƻǊǊŜǎǇƻƴŘ ǿƛǘƘ ǘƘŜ ŎƘŀƴƎŜǎ ȅƻǳ ƳŀŘŜ ƛƴ ¢ŜŀƳ 
5ŜǾŜƭƻǇŜǊΣ ŀƴŘ ȅƻǳ ǿƛƭƭ ŀƭǎƻ ǎŜŜ ŘƛŦŦŜǊŜƴŎŜǎ ǿƘŜǊŜ ȅƻǳ ŎǳǎǘƻƳƛȊŜŘ ȅƻǳǊ ƻƭŘ ŦƛƭŜǎΦ 

e. /ƻǇȅ ǘƘŜ ŘŜǎƛǊŜŘ ŎǳǎǘƻƳƛȊŀǘƛƻƴǎ ŦǊƻƳ ȅƻǳǊ ƻƭŘ ŎǳǎǘƻƳƛȊŜŘ ŦƛƭŜǎ ǘƻ ǘƘŜ ƴŜǿ ŦƛƭŜǎΦ ¢ƘŜ ŦƛƭŜǎ ƛƴ ǘƘŜ ΦȄŀƳƭ 
ŘƛǊŜŎǘƻǊȅ ŀǊŜ ƴƻǿ ŎǳǎǘƻƳƛȊŜŘΦ 

f. /ƻƳǇƛƭŜ ȅƻǳǊ ǇǊƻƧŜŎǘΦ ¢ƘŜ L[ ŎƻƳǇƛƭŜǊ ǳǎŜǎ ǘƘŜ ŦƛƭŜǎ ƛƴ ȅƻǳǊ ΦȄŀƳƭ ŘƛǊŜŎǘƻǊȅΦ 

g. όhǇǘƛƻƴŀƭύ 5ŜƭŜǘŜ ǘƘŜ ŘƛǊŜŎǘƻǊȅ ȅƻǳ ǊŜƴŀƳŜŘ ƛƴ ǎǘŜǇ ŀΦ 

¶ 5ƻ ƴƻǘ ƳŀƪŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǘȅǇŜǎ ƻŦ ŎƘŀƴƎŜǎ ƛƴ ȅƻǳǊ ŎǳǎǘƻƳ ·!a[ ŦƛƭŜǎΥ 

4 5ƻ ƴƻǘ ŀŘŘ ƴŜǿ ŎƻƴǘǊƻƭǎ ǘƘŀǘ Řƻ ƴƻǘ ŎƻǊǊŜǎǇƻƴŘ ǘƻ ŎƻƴǘǊƻƭǎ ƛƴ ȅƻǳǊ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ŀǇǇƭƛŎŀǘƛƻƴ 
ƻǳǘƭƛƴŜΦ 

4 5ƻ ƴƻǘ ǊŜŀǊǊŀƴƎŜ ǘƘŜ ƻǊŘŜǊ ƻŦ ŎƻƴǘǊƻƭǎΦ 

4 5ƻ ƴƻǘ ǊŜƴŀƳŜ ŎƻƴǘǊƻƭǎΦ 

4 5ƻ ƴƻǘ ŎƘŀƴƎŜ ŜǾŜƴǘ ƘŀƴŘƭŜǊǎΦ 

aƻǊŜ LƴŦƻǊƳŀǘƛƻƴ ŀōƻǳǘ ·!a[ 

CƻǊ ƳƻǊŜ ƛƴŦƻǊƳŀǘƛƻƴ ŀōƻǳǘ ·!a[ ƛƴ ²tCΣ ǎŜŜ aƛŎǊƻǎƻŦǘΩǎ ŘƻŎǳƳŜƴǘŀǘƛƻƴ ŀǘ ƘǘǘǇΥκκƳǎŘƴΦƳƛŎǊƻǎƻŦǘΦŎƻƳκŜƴ-
ǳǎκƭƛōǊŀǊȅκƳǎтптмннΦŀǎǇȄ 

http://msdn.microsoft.com/en-us/library/ms747122.aspx
http://msdn.microsoft.com/en-us/library/ms747122.aspx
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$ÅÐÌÏÙÉÎÇ 70& $ÅÓËÔÏÐ !ÐÐÌÉÃÁÔÉÏÎÓ 

¢ƻ ŘŜǇƭƻȅ ȅƻǳǊ ²tC ŘŜǎƪǘƻǇ ŀǇǇƭƛŎŀǘƛƻƴǎ ǘƻ ǳǎŜǊǎΣ ȅƻǳ Ƴǳǎǘ ŎǊŜŀǘŜ ŀƴ ƛƴǎǘŀƭƭŜǊ ōȅ ŦƻƭƭƻǿƛƴƎ ǘƘŜǎŜ ǎǘŜǇǎΥ 

1. Select Create Installer from the Project menu. This menu option is disabled unless your build target is set 
to WPF Desktop. 

¢ƘŜ /ǊŜŀǘŜ LƴǎǘŀƭƭŜǊ ŘƛŀƭƻƎ ōƻȄ ƻǇŜƴǎΦ 

 

¢ƘŜ ŦƛŜƭŘǎ ƛƴ ǘƘƛǎ ŘƛŀƭƻƎ ōƻȄ ŀǊŜ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ǇƻǇǳƭŀǘŜŘ ǿƛǘƘ ƛƴŦƻǊƳŀǘƛƻƴ ȅƻǳ ŜƴǘŜǊŜŘ ƛƴ ǘƘŜ ±ŜǊǎƛƻƴ ǘŀō 
ƻŦ ǘƘŜ .ǳƛƭŘ {ŜǘǘƛƴƎǎ ŘƛŀƭƻƎ ōƻȄΦ aƻǎǘ ƻŦ ǘƘŜǎŜ ŦƛŜƭŘǎ ŀǊŜ ƻǇǘƛƻƴŀƭΦ !ŘŘΣ ŘŜƭŜǘŜΣ ƻǊ ŜŘƛǘ ǘŜȄǘ ŀǎ ȅƻǳ ǎŜŜ ŦƛǘΦ 

2. LŦ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴ ǊŜǉǳƛǊŜǎ {v[.ŀǎŜ ŎƻƴƴŜŎǘƛǾƛǘȅΣ ŎƘŜŎƪ ǘƘŜ άLƴŎƭǳŘŜ {v[.ŀǎŜ /ƭƛŜƴǘ aƻŘǳƭŜǎέ check box. 
Otherwise, leave this box unchecked. 

¸ƻǳǊ ǇǊƻƧŜŎǘΩǎ ǎǉƭΦƛƴƛ ŦƛƭŜ ƛǎ ǇŀŎƪŀƎŜŘ ƛƴ ǘƘŜ ƛƴǎǘŀƭƭŜǊΦ ¢ƘŜǊŜŦƻǊŜΣ ƛŦ ȅƻǳǊ ǎǉƭΦƛƴƛ ǳǎŜǎ άƭƻŎŀƭƘƻǎǘέ ƛƴ ƛǘǎ 
ǎŜǊǾŜǊǇŀǘƘ ǎŜǘǘƛƴƎΣ ȅƻǳ Ƴǳǎǘ ŎƘŀƴƎŜ ǘƘƛǎ ǎŜǘǘƛƴƎ ǘƻ Ǉƻƛƴǘ ǘƻ ǘƘŜ {v[.ŀǎŜ ŘŀǘŀōŀǎŜ ȅƻǳ Ǉƭŀƴ ǘƻ ǳǎŜΤ ŦƻǊ 
ŜȄŀƳǇƭŜΣ ŀƴ Lt ŀŘŘǊŜǎǎΦ 

3. LŦ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴ ǊŜǉǳƛǊŜǎ wŜǇƻǊǘ .ǳƛƭŘŜǊ ŦǳƴŎǘƛƻƴŀƭƛǘȅΣ ŎƘŜŎƪ ǘƘŜ άLƴŎƭǳŘŜ wŜǇƻǊǘ.ǳƛƭŘŜǊ ƛƴǎǘŀƭƭŜǊέ check 
box. This allows your users to install a limited version of Report Builder. They can access all the 
functionality required for your application, but cannot create new reports or run Report Builder 
independently. If your application does not require Report Builder functionality, leave this check box 
unchecked. 

4. Click Generate and wait a few moments. The άDŜƴŜǊŀǘŜ CƛƴƛǎƘŜŘέ ƳŜǎǎŀƎŜ appears, and the installer is 
placed in your application directory. 

70& "ÒÏ×ÓÅÒ !ÐÐÌÉÃÁÔÉÏÎÓ ÉÎ &ÉÒÅÆÏØ 

¢ƻ ǳǎŜ ǘƘŜ CƛǊŜŦƻȄ ōǊƻǿǎŜǊ ǘƻ Ǌǳƴ ²tC .ǊƻǿǎŜǊ ŀǇǇƭƛŎŀǘƛƻƴǎΣ ȅƻǳ Ƴǳǎǘ ƛƴǎǘŀƭƭ ŀ CƛǊŜŦƻȄ ǇƭǳƎƛƴΦ ¢ƻ ŎƘŜŎƪ ƛŦ ȅƻǳ 
ƘŀǾŜ ǘƘŜ ǇƭǳƎƛƴΣ ǳǎŜ ǘƘŜ ǎŎǊƛǇǘ ŀǘ ƘǘǘǇΥκκƳǎŘƴΦƳƛŎǊƻǎƻŦǘΦŎƻƳκŜƴ-ǳǎκƭƛōǊŀǊȅκōōфлфустΦŀǎǇȄΦ 

http://msdn.microsoft.com/en-us/library/bb909867.aspx


 

24 

LŦ ȅƻǳ Řƻ ƴƻǘ ƘŀǾŜ ǘƘŜ ǎŎǊƛǇǘΣ Řƻ ǘƘŜ ŦƻƭƭƻǿƛƴƎΥ 

¶ ²ƛƴŘƻǿǎ ·tκ±ƛǎǘŀ ¦ǎŜǊǎ 

Lƴǎǘŀƭƭ ǘƘŜ ƭŀǘŜǎǘ Φb9¢ оΦр ŦǊŀƳŜǿƻǊƪ όǿƛǘƘ ŀǾŀƛƭŀōƭŜ ǎŜǊǾƛŎŜ ǇŀŎƪǎύΦ ¢Ǌȅ ǘƘŜ ǎŎǊƛǇǘ ŦǊƻƳ ǘƘŜ ƭƛƴƪ ŀƎŀƛƴΦ LŦ 
ǘƘŜ ǎŎǊƛǇǘ ǎǘƛƭƭ ƛƴŘƛŎŀǘŜǎ ŀ ǇǊƻōƭŜƳΣ ŎƘŜŎƪ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ŘƛǊŜŎǘƻǊȅΥ 

/Υξ²ƛƴŘƻǿǎξaƛŎǊƻǎƻŦǘΦb9¢ξCǊŀƳŜǿƻǊƪξǾоΦрξ²ƛƴŘƻǿǎ tǊŜǎŜƴǘŀǘƛƻƴ CƻǳƴŘŀǘƛƻƴ 

¢ƘŜ Φb9¢ ŦǊŀƳŜǿƻǊƪ ƛƴǎǘŀƭƭŀǘƛƻƴ ǎƘƻǳƭŘ ƘŀǾŜ ǇƭŀŎŜŘ ŀ ŦƛƭŜ ƴŀƳŜŘ bt²tCΦŘƭƭ ƛƴ ǘƘŀǘ ŘƛǊŜŎǘƻǊȅΦ /ƻǇȅ ǘƘŀǘ 
ŦƛƭŜ ǘƻ /ΥξtǊƻƎǊŀƳ CƛƭŜǎ όȄусύξaƻȊƛƭƭŀ CƛǊŜŦƻȄξǇƭǳƎƛƴǎΦ 

¶ ²ƛƴŘƻǿǎ т ¦ǎŜǊǎ 

¢ƘŜ Φb9¢ оΦр {tм ŦǊŀƳŜǿƻǊƪ Ŏŀƴƴƻǘ ōŜ ƛƴǎǘŀƭƭŜŘ ƻƴ ŀ ²ƛƴŘƻǿǎ т ƳŀŎƘƛƴŜΦ ¢ƻ ƻōǘŀƛƴ ǘƘŜ ƴŜŎŜǎǎŀǊȅ 
ǇƭǳƎƛƴΣ ȅƻǳ Ƴǳǎǘ ŀŎǉǳƛǊŜ bt²tCΦŘƭƭτŦƻǊ ŜȄŀƳǇƭŜΣ ŦǊƻƳ ŀ ²ƛƴŘƻǿǎ ·t ƻǊ ±ƛǎǘŀ ƳŀŎƘƛƴŜτŀƴŘ ŎƻǇȅ ƛǘ ǘƻ 
ǘƘŜ ŀǇǇǊƻǇǊƛŀǘŜ ŘƛǊŜŎǘƻǊȅΦ 

70& "ÒÏ×ÓÅÒ !ÐÐÌÉÃÁÔÉÏÎÓ ÉÎ )ÎÔÅÒÎÅÔ %ØÐÌÏÒÅÒ 

LƴǘŜǊƴŜǘ 9ȄǇƭƻǊŜǊ у ǇǊƻǾƛŘŜǎ ŀƴ ŜȄŎŜƭƭŜƴǘ Ƙƻǎǘ ŦƻǊ ²tC ōǊƻǿǎŜǊ ŀǇǇƭƛŎŀǘƛƻƴǎΦ IƻǿŜǾŜǊΣ ŀƴ ƛǎǎǳŜ Ŏŀƴ ŀǊƛǎŜ 
ǿƘŜƴ ǳǎƛƴƎ ǘŀōōŜŘ ōǊƻǿǎƛƴƎ ŀƴŘ ŎƭƻǎƛƴƎ ǘƘŜ ǘŀō ǘƘŀǘ ƛǎ ǊǳƴƴƛƴƎ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΦ ¢ƻ ŀǾƻƛŘ ǘƘƛǎ ǇǊƻōƭŜƳΣ ŎƭƻǎŜ 
LƴǘŜǊƴŜǘ 9ȄǇƭƻǊŜǊ ŎƻƳǇƭŜǘŜƭȅ ǿƘŜƴ ȅƻǳ ǿŀƴǘ ǘƻ ŎƭƻǎŜ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΦ 

hƴ ŀ сп-ōƛǘ ²ƛƴŘƻǿǎ ƳŀŎƘƛƴŜΣ сп-ōƛǘ LƴǘŜǊƴŜǘ 9ȄǇƭƻǊŜǊ ƛǎ ƴƻǘ ǘƘŜ ŘŜŦŀǳƭǘ ǾŜǊǎƛƻƴΦ ¦ǎŜǊǎ ƴŜŜŘ ǘƻ ƴŀǾƛƎŀǘŜ ǘƻ 
LƴǘŜǊƴŜǘ 9ȄǇƭƻǊŜǊ сп-ōƛǘ ǘƻ Ǌǳƴ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ²tC сп-ōƛǘ ŀǇǇƭƛŎŀǘƛƻƴǎΦ сп-ōƛǘ LƴǘŜǊƴŜǘ 9ȄǇƭƻǊŜǊ ƛǎ ƭƻŎŀǘŜŘ ŀǘ 
҈tǊƻƎǊŀƳCƛƭŜǎ҈ξLƴǘŜǊƴŜǘ 9ȄǇƭƻǊŜǊΦ 
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#ÈÁÐÔÅÒ τ ɀ 0ÕÂÌÉÓÈÉÎÇ 8"!0 !ÐÐÌÉÃÁÔÉÏÎÓ 

¢Ƙƛǎ ŎƘŀǇǘŜǊ Ŏƻƴǘŀƛƴǎ ƛƴǎǘǊǳŎǘƛƻƴǎ ŦƻǊ ǇǳōƭƛǎƘƛƴƎ ·.!t ŀǇǇƭƛŎŀǘƛƻƴǎ ƛƴ ²tC .ǊƻǿǎŜǊΦ 

0ÕÂÌÉÓÈÉÎÇ 8"!0 !ÐÐÌÉÃÁÔÉÏÎÓ ɉ70& "ÒÏ×ÓÅÒɊ 

! ǎǳŎŎŜǎǎŦǳƭƭȅ ǇǳōƭƛǎƘŜŘ ŀǇǇƭƛŎŀǘƛƻƴ Ƙŀǎ ŀ ǎǘŀǊǘƛƴƎκƛƴŘŜȄ ǇŀƎŜ ǘƘŀǘ ƭƻƻƪǎ ƭƛƪŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎΥ 
 

 

¢ƻ ǇǳōƭƛǎƘ ŀ ²tC .ǊƻǿǎŜǊ ŀǇǇƭƛŎŀǘƛƻƴΣ ŜȄŜŎǳǘŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǎǘŜǇǎΦ 

"ÕÉÌÄ 3ÅÔÔÉÎÇÓ ÆÏÒ 70& "ÒÏ×ÓÅÒ !ÐÐÌÉÃÁÔÉÏÎ 

LŦ ȅƻǳ ŀǊŜ ǊǳƴƴƛƴƎ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ƛƴ ²ƛƴŘƻǿǎ ±ƛǎǘŀ ƻǊ ƭŀǘŜǊΣ Ǌǳƴ ŀǎ !ŘƳƛƴƛǎǘǊŀǘƻǊ ǎƻ ǘƘŀǘ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ 
Ƙŀǎ ŘƛǊŜŎǘƻǊȅ ǎƘŀǊƛƴƎ ǇŜǊƳƛǎǎƛƻƴΦ 

/ŜǊǘƛŦƛŎŀǘŜ CƛƭŜ ǎŜǘǘƛƴƎǎ ŀǊŜ ŜǎǘŀōƭƛǎƘŜŘ ƛƴ ǘƘŜ .ǳƛƭŘ ¢ŀǊƎŜǘ ǘŀō ƛƴ ǘƘŜ .ǳƛƭŘ {ŜǘǘƛƴƎǎ ŘƛŀƭƻƎΦ ¢ƘŜ ŎŜǊǘƛŦƛŎŀǘŜ ŦƛƭŜ 
ŦƛŜƭŘǎ ŀǊŜ ŜƴŀōƭŜŘ ǿƘŜƴ ȅƻǳ ŎƘƻƻǎŜ Φb9¢ ²tC .ǊƻǿǎŜǊ ŀǎ ǘƘŜ ǘŀǊƎŜǘ ǘȅǇŜΦ .ȅ ŘŜŦŀǳƭǘΣ ǘƘŜ ŎƻƳǇƛƭŜǊ ǳǎŜǎ ŀ 
ǇǊƛǾŀǘŜ ŎŜǊǘƛŦƛŎŀǘŜΦ ¢Ƙƛǎ ŎŜǊǘƛŦƛŎŀǘŜ ƛǎ ǎŀǾŜŘ ƛƴ ǘƘŜ ōǳƛƭŘ ŘƛǊŜŎǘƻǊȅ ǎǇŜŎƛŦƛŜŘ ƛƴ ǘƘŜ ¢ŀǊƎŜǘ bŀƳŜ ŦƛŜƭŘΣ ŀƴŘ Ƙŀǎ 
ǘƘŜ ŦƛƭŜ ƴŀƳŜ ȄōŀǇψƪŜȅΦǇŦȄΦ Lǘ ƛǎ ƴŜŎŜǎǎŀǊȅ ǘƻ ƛƳǇƻǊǘ ǘƘƛǎ ŎŜǊǘƛŦƛŎŀǘŜ ŦƻǊ ŀ ²tC ōǊƻǿǎŜǊ ŀǇǇƭƛŎŀǘƛƻƴ ǘƻ Ǌǳƴ ŦǊƻƳ 
LL{Φ ! ²tC ŀǇǇƭƛŎŀǘƛƻƴ ǿƛƭƭ ƴƻǘ ŘƻǿƴƭƻŀŘ ǳƴƭŜǎǎ ȅƻǳ ƛƳǇƻǊǘ ǘƘŜ ŎŜǊǘƛŦƛŎŀǘŜ ǘƘŀǘ ƛǎ ǳǎŜŘ ǘƻ ǎƛƎƴ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΦ 

¢ƻ ƛƳǇƻǊǘ ǘƘŜ ŎŜǊǘƛŦƛŎŀǘŜΣ Ŧƻƭƭƻǿ ǘƘŜǎŜ ǎǘŜǇǎΥ 

1. Open the Build Settings dialog by selecting Project > Build Settings from the menu bar.  

2. Select .NET Application. 

3. Select .NET WPF Browser (XBAP). 

4. Under Target Name, enter the directory where you want to build the application and click OK. 

¦ǇŘŀǘŜ ǘƘŜ tǊƻŘǳŎǘ ±ŜǊǎƛƻƴ όƛƴ ǘƘŜ ±ŜǊǎƛƻƴ ǘŀōύ ŜŀŎƘ ǘƛƳŜ ȅƻǳ ǊŜōǳƛƭŘ ŀƴ ŀǇǇƭƛŎŀǘƛƻƴΦ 
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5. Build the application by selecting Project > Build from the menu bar. 

6. Open your application directory in Explorer, open the xbap_key.pfx file, and configure the private 
certificate as follows: 

a. hƴ ǘƘŜ ƛƴƛǘƛŀƭ ǎŎǊŜŜƴ ŎƭƛŎƪ bŜȄǘΦ 

b. /ƭƛŎƪ bŜȄǘ ŀƎŀƛƴΦ 

c. 9ƴǘŜǊ ǘƘŜ ǇŀǎǎǿƻǊŘ мнопр όǎŜŜ ƴƻǘŜ ōŜƭƻǿύ ŀƴŘ ŎƭƛŎƪ bŜȄǘΦ 

d. {ŜƭŜŎǘ tƭŀŎŜ ŀƭƭ ŎŜǊǘƛŦƛŎŀǘŜǎ ƛƴ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǎǘƻǊŜ ŀƴŘ ŎƭƛŎƪ .ǊƻǿǎŜΦ 

e. /ƘƻƻǎŜ ¢ǊǳǎǘŜŘ wƻƻǘ /ŜǊǘƛŦƛŎŀǘƛƻƴ !ǳǘƘƻǊƛǘƛŜǎ ŀƴŘ ŎƭƛŎƪ hYΦ 

f. /ƭƛŎƪ bŜȄǘΦ 

g. /ƭƛŎƪ CƛƴƛǎƘΦ 

h. LƳǇƻǊǘ ǘƘŜ ǎŀƳŜ ŎŜǊǘƛŦƛŎŀǘŜ ǘƻ ¢ǊǳǎǘŜŘ tǳōƭƛǎƘŜǊǎ ōȅ ǊŜǇŜŀǘƛƴƎ ǎǘŜǇǎ ŀ-Ƙ ŀƴŘ ǎŜƭŜŎǘƛƴƎ ¢ǊǳǎǘŜŘ 
tǳōƭƛǎƘŜǊǎ ƛƴ ǎǘŜǇ ŜΦ 

bƻǘŜΥ ¢ƘŜ ǇǊƛǾŀǘŜ ŎŜǊǘƛŦƛŎŀǘŜ ǇǊƻǾƛŘŜŘ ǿƛǘƘ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ Ƙŀǎ ŀ ǎŜǘ ǇŀǎǎǿƻǊŘ ƻŦ мнопрΦ LŦ ȅƻǳ ǳǎŜ ŀ 
ŘƛŦŦŜǊŜƴǘ ŎŜǊǘƛŦƛŎŀǘŜΣ ȅƻǳ Ƴǳǎǘ ŀƭǎƻ ǳǎŜ ǘƘŜ ǇŀǎǎǿƻǊŘ ƻŦ ǘƘŀǘ ŎŜǊǘƛŦƛŎŀǘŜΦ 

7. Go back to the Build Setting dialog, enter your certificate file's location and password, and click OK. 
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0ÕÂÌÉÓÈÉÎÇ Á 70& "ÒÏ×ÓÅÒ !ÐÐÌÉÃÁÔÉÏÎ ÔÏ ))3 

ƻ̧ǳ Ŏŀƴ ŘŜǇƭƻȅ ŀ ²tC ōǊƻǿǎŜǊ ŀǇǇƭƛŎŀǘƛƻƴ ǘƻ ŀƴ LL{ сΦлκтΦлκтΦр ǎŜǊǾŜǊ ōȅ ǎŜƭŜŎǘƛƴƎ tǊƻƧŜŎǘ Ҕ tǳōƭƛǎƘ ŦǊƻƳ 

ǘƘŜ ƳŜƴǳ ōŀǊΦ 

 

¢ƘŜ ŦƛŜƭŘǎ ƘŀǾŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ŦǳƴŎǘƛƻƴǎΥ 

CƛŜƭŘ 9ȄǇƭŀƴŀǘƛƻƴ 

{ŜǊǾŜǊ bŀƳŜ LL{ ǎŜǊǾŜǊ ƴŀƳŜ ǘƻ ŘŜǇƭƻȅ ǘƘŜ ²tC ŀǇǇƭƛŎŀǘƛƻƴ όLL{ сΣ LL{ тύ 

¦ǎŜǊ bŀƳŜ ¦ǎŜǊ ƴŀƳŜ ǿƘƻ Ŏŀƴ ƭƻƎ ƛƴǘƻ ǎǇŜŎƛŦƛŜŘ LL{ ǎŜǊǾŜǊΦ aǳǎǘ ōŜ ŀ ƳŜƳōŜǊ ƻŦ ǘƘŜ 
!ŘƳƛƴƛǎǘǊŀǘƻǊǎ ƎǊƻǳǇΦ 

tŀǎǎǿƻǊŘ tŀǎǎǿƻǊŘ ŦƻǊ ǘƘŜ ǳǎŜǊ 

5ŜǇƭƻȅ 5ŀǘŀōŀǎŜ tǊƻȄȅ {ŜǊǾŜǊ /ƘŜŎƪ ǘƘƛǎ ǘƻ ŘŜǇƭƻȅ ǘƘŜ ŘŀǘŀōŀǎŜ ǇǊƻȄȅ ǎŜǊǾŜǊ ǘƻ ǘƘŜ ǎŀƳŜ LL{ ǎŜǊǾŜǊ ŀƭƻƴƎ 
ǿƛǘƘ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΦ ¢ƘŜ ¦w[ ƻŦ ǘƘŜ ǇǊƻȄȅ ǎŜǊǾƛŎŜ ƛǎ 
ƘǘǘǇΥκκғLL{ψ{ŜǊǾŜǊҔκ5.tƛǇŜ{ŜǊǾŜǊκ5.tƛǇŜ{ŜǊǾŜǊΦǎǾŎ 
LŦ ȅƻǳ ŀǊŜ ǳǎƛƴƎ {v[.ŀǎŜ ǘƘǊƻǳƎƘ ŀ ǊŜƳƻǘŜ {ŜǊǾŜǊΣ ōŜŦƻǊŜ ǇǳōƭƛǎƘƛƴƎ ǘƘŜ 
·.!t ŀǇǇƭƛŎŀǘƛƻƴΣ ŜŘƛǘ ǎǉƭΦƛƴƛ όώǿƛƴонŎƭƛŜƴǘΦǿǎонϐ ǎŜŎǘƛƻƴύ ōȅ ŎƻƳƳŜƴǘƛƴƎ 
ƻǳǘ ϦŀǳǘƻǎǘŀǊǘǎŜǊǾŜǊǇŀǘƘϦΦ 

¦w[ ό5ŀǘŀōŀǎŜ tǊƻȄȅ {ŜǊǾŜǊύ {ǇŜŎƛŦȅ ǘƘŜ ŘŀǘŀōŀǎŜ ǇǊƻȄȅ ǎŜǊǾƛŎŜ ¦w[ ǘƘŀǘ ƛǎ ŀƭǊŜŀŘȅ ǊǳƴƴƛƴƎΦ 

tǳōƭƛǎƘ [ƻŎŀǘƛƻƴ ¸ƻǳ Ŏŀƴ ǎǇŜŎƛŦȅ ǘƘŜ ƭƻŎŀǘƛƻƴ ƻƴ ǘƘŜ LL{ ǎŜǊǾŜǊ ǘƻ ŘŜǇƭƻȅ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΦ LŦ 
ǘƘƛǎ ŦƛŜƭŘ ƛǎ ōƭŀƴƪΣ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ƛǎ ŘŜǇƭƻȅŜŘ ǘƻ ғLL{ wƻƻǘҔκғ!ǇǇƭƛŎŀǘƛƻƴ 
bŀƳŜҔΦ Lƴ Ƴƻǎǘ ŎŀǎŜǎ ғLL{ wƻƻǘҔ ƛǎ /ΥξLƴŜǘtǳōξǿǿǿǊƻƻǘΦ 
¸ƻǳ Ŏŀƴ ŀƭǎƻ ǎǇŜŎƛŦȅ ŀ ƭƻŎŀƭ ƻǊ ǊŜƳƻǘŜ ŦƻƭŘŜǊ ǿƘŜƴ ȅƻǳ Řƻ ƴƻǘ ǎǇŜŎƛŦȅ ŀƴ LL{ 
ǎŜǊǾŜǊΦ ¢Ƙƛǎ ƛǎ ǳǎŜŦǳƭ ǿƘŜƴ ǘƘŜ ²tC ŀǇǇƭƛŎŀǘƛƻƴ Ƙŀǎ ōŜŜƴ ŘŜǇƭƻȅŜŘ ŀƴŘ ȅƻǳ 
ƪƴƻǿ ƛǘǎ ǇƘȅǎƛŎŀƭ ƭƻŎŀǘƛƻƴΦ 
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CƛŜƭŘ 9ȄǇƭŀƴŀǘƛƻƴ 

{ƛƎƴ !ǇǇƭƛŎŀǘƛƻƴ {ǇŜŎƛŦȅ ȅƻǳǊ ƻǿƴ ŎŜǊǘƛŦƛŎŀǘŜ ƘŜǊŜΦ /ƘŀƴƎŜǎ ƳŀŘŜ ƛƴ ǘƘƛǎ ŦƛŜƭŘ ŀǊŜ ǊŜŦƭŜŎǘŜŘ 
ƛƴ ǘƘŜ .ǳƛƭŘ {ŜǘǘƛƴƎǎ ŘƛŀƭƻƎΦ 

LŦ ǘƘŜ ǇǊƻȄȅ ǎŜǊǾŜǊ ƛǎ ǊǳƴƴƛƴƎΣ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǇŀƎŜ ŀǇǇŜŀǊǎ ǿƘŜƴ ȅƻǳ ŀŎŎŜǎǎ ǘƘŜ ǎǇŜŎƛŦƛŜŘ ¦w[Υ 

 

))3 4ÒÏÕÂÌÅÓÈÏÏÔÉÎÇ 

tǊƻōƭŜƳΥ !ŦǘŜǊ ƛƴǎǘŀƭƭƛƴƎ ǘƘŜ ŎŜǊǘƛŦƛŎŀǘŜ ŀƴŘ ƭŀǳƴŎƘƛƴƎ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΣ ŀƴ ŜǊǊƻǊ ǎƛƳƛƭŀǊ ǘƻ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ƛǎ 
ǊŜǇƻǊǘŜŘΥ 
 

 

{ƻƭǳǘƛƻƴΥ !ŎǘƛǾŀǘŜ он-ōƛǘ ŀǇǇƭƛŎŀǘƛƻƴǎ ōȅ ŦƻƭƭƻǿƛƴƎ ǘƘŜǎŜ ǎǘŜǇǎΥ 

1. In the IIS GUI, navigate to the Application Pool. 

2. Access Advanced Settings. 

3. Set Activate 32-bit Applications to TRUE. 

tǊƻōƭŜƳΥ !ŘƻtǊƻȄȅ ǎŜǊǾŜǊ ƛǎ ƴƻǘ ǿƻǊƪƛƴƎ ŀǎ ŀ ²/C ό²ƛƴŘƻǿǎ /ƻƳƳǳƴƛŎŀǘƛƻƴ CƻǳƴŘŀǘƛƻƴύ ǎŜǊǾƛŎŜΦ 
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{ƻƭǳǘƛƻƴΥ .ŜŎŀǳǎŜ ǘƘŜ ŘŜŦŀǳƭǘ LL{ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ŘƻŜǎ ƴƻǘ ŜƴŀōƭŜ ²/CΣ ȅƻǳ Ƴǳǎǘ Ǌǳƴ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ŎƻƳƳŀƴŘ ŀǎ 
ŀŘƳƛƴƛǎǘǊŀǘƻǊ ǘƻ ŎƘŀƴƎŜ ǘƘƛǎ ŎƻƴŦƛƎǳǊŀǘƛƻƴΥ 

cmd /C %FrameworkDir% \ \ v3.0 \ \ Windows Communication 

Foundation \ \ ServiceModelReg.exe - iru  

$ÁÔÁÂÁÓÅ 0ÒÏØÙ 3ÅÒÖÉÃÅ 

5ŀǘŀōŀǎŜ tǊƻȄȅ {ŜǊǾŜǊ ƛǎ ŀ ²Ŝō ǎŜǊǾƛŎŜ ǘƘŀǘ Ǌǳƴǎ ƻƴ LL{Φ ¢ƻ Ǌǳƴ ŘŀǘŀōŀǎŜ ǇǊƻȄȅ ǎŜǊǾƛŎŜ ŎƻǊǊŜŎǘƭȅΣ ŀƭƭ ƴŜŎŜǎǎŀǊȅ 
ŘŀǘŀōŀǎŜ ŎƭƛŜƴǘ ǘƻƻƭǎ Ƴǳǎǘ ōŜ ƛƴǎǘŀƭƭŜŘ ƻƴ ǘƘŜ ŘŀǘŀōŀǎŜ ǇǊƻȄȅ ǎŜǊǾŜǊ ƳŀŎƘƛƴŜΦ 

SQLBase Client Setup on IIS Server 

Cƻƭƭƻǿ ǘƘŜǎŜ ǎǘŜǇǎΥ 

1. Install Microsoft Visual C++ 2008 SP1 Redistributable Package (x86). This program is required to run 
SQLBase Client. 

2. Install SQLBase Client .NET Data Provider ((Applicable for Team Developer 6.1 SP2 and earlier versions) as 
follows: 

a. 5ƻǿƴƭƻŀŘ {v[.ŀǎŜ ммΦс {ǘŀƴŘŀǊŘ ŦƻǊ ²ƛƴŘƻǿǎ ŦǊƻƳ 
ƘǘǘǇΥκκǿǿǿΦƎǳǇǘŀǘŜŎƘƴƻƭƻƎƛŜǎΦŎƻƳκ{ŜǊǾƛŎŜǎκǇǊƻŘǳŎǘ5ƻǿƴƭƻŀŘǎΦŀǎǇȄ 

b. wǳƴ ǎŜǘǳǇΦŜȄŜΦ 

c. {ŜƭŜŎǘ /ǳǎǘƻƳΦ 

d. {ŜƭŜŎǘ ǘƘŜ CŜŀǘǳǊŜ {v[.ŀǎŜ онōƛǘ 5ǊƛǾŜǊǎ Ҕ Φb9¢ 5ŀǘŀ tǊƻǾƛŘŜǊΦ 

e. .ǊƻǿǎŜ ǘƻ ǘƘŜ ŘƛǊŜŎǘƻǊȅ ȅƻǳ ǿŀƴǘ ǘƻ ƛƴǎǘŀƭƭ ŀƴŘ ŦƛƴƛǎƘ ƛƴǎǘŀƭƭŀǘƛƻƴΦ 

f. 9Řƛǘ ǎǉƭΦƛƴƛ όƻƴ LL{ {ŜǊǾŜǊύΦ ¦ƴŘŜǊ ώǿƛƴонŎƭƛŜƴǘΦǿǎонϐ ǎŜŎǘƛƻƴΣ ŎƘŀƴƎŜ ƭƻŎŀƭƘƻǎǘ ǘƻ ǘƘŜ ǎŜǊǾŜǊ ŀŘŘǊŜǎǎ 
ǿƘŜǊŜ {v[.ŀǎŜ ǊŜǎƛŘŜǎΦ 

3. Create a SQLBase System Variable (Windows 7/Vista) as follows: 

a. wƛƎƘǘ-ŎƭƛŎƪ /ƻƳǇǳǘŜǊ ŀƴŘ ǎŜƭŜŎǘ tǊƻǇŜǊǘƛŜǎΦ 

b. {ŜƭŜŎǘ !ŘǾŀƴŎŜŘ ǎȅǎǘŜƳ ǎŜǘǘƛƴƎǎΦ 

c. {ŜƭŜŎǘ 9ƴǾƛǊƻƴƳŜƴǘ ±ŀǊƛŀōƭŜǎΦ 

d. ¦ƴŘŜǊ {ȅǎǘŜƳ ±ŀǊƛŀōƭŜǎΣ ǎŜƭŜŎǘ bŜǿΦ 

e. ¦ƴŘŜǊ ±ŀǊƛŀōƭŜ ƴŀƳŜΣ ŜƴǘŜǊ {v[.!{9Φ 

f. ¦ƴŘŜǊ ±ŀǊƛŀōƭŜ ǾŀƭǳŜΥ tŀǘƘ ǘƻ ǘƘŜ ƛƴǎǘŀƭƭŜŘ {v[.ŀǎŜ /ƭƛŜƴǘΣ ǎŜƭŜŎǘ hYΦ 

4. Add SQLBase Client to the Path as follows: 

a. wŜǇŜŀǘ ǎǘŜǇǎ оŀΦ ǘƘǊǳ оŎΦ 

b. ¦ƴŘŜǊ {ȅǎǘŜƳ ǾŀǊƛŀōƭŜǎΣ ǎŜƭŜŎǘ tŀǘƘ Ҕ 9ŘƛǘΦ 

c. ¦ƴŘŜǊ ±ŀǊƛŀōƭŜ ǾŀƭǳŜΣ ŜƴǘŜǊ ҈{v[.ŀǎŜ҈Τ ǘƻ ǘƘŜ ŦǊƻƴǘ ƻŦ ǘƘŜ tŀǘƘ ŀƴŘ ǎŜƭŜŎǘ hYΦ 

d. wŜǎǘŀǊǘ ȅƻǳǊ LL{ {ŜǊǾŜǊΦ 

Oracle Client Setup on IIS Server 

Cƻƭƭƻǿ ǘƘŜǎŜ ǎǘŜǇǎΥ 

1. Install oracle 11gR2 32bit client or server on IIS Server (database proxy server ). 

http://www.guptatechnologies.com/Services/productDownloads.aspx
http://www.guptatechnologies.com/Services/productDownloads.aspx
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2. Configure Oracle connection(s) as follows: 

a. Dƻ ǘƻ /ΥξŀǇǇξғǳǎŜǊҔξǇǊƻŘǳŎǘξммΦнΦлξŎƭƛŜƴǘψмξƴŜǘǿƻǊƪξŀŘƳƛƴΦ 

b. 9Řƛǘ ǘƘŜ ǘƴǎƴŀƳŜǎΦƻǊŀ ŦƛƭŜ ŀƴŘ ŀŘŘ ȅƻǳǊ hǊŀŎƭŜ ŎƻƴƴŜŎǘƛƻƴόǎύΦ 

SQL Server Client Setup on IIS Server 

wŜŦŜǊ ǘƻ έ/ƻƴŦƛƎǳǊƛƴƎ ŀƴ h5./ 5ŀǘŀ {ƻǳǊŎŜέ ƛƴ ǘƘŜ /ƻƴƴŜŎǘƛƴƎ {v[²ƛƴŘƻǿǎ hōƧŜŎǘǎ ǘƻ 5ŀǘŀōŀǎŜǎ ŘƻŎǳƳŜƴǘΦ 

Cƻƭƭƻǿ ǘƘŜǎŜ ǎǘŜǇǎΥ 

1. Launch odbcad32 on Proxy Server machine. 

hƴ ŀ сп-ōƛǘ ²ƛƴŘƻǿǎ h{Σ Ǝƻ ǘƻ /Υξ²ƛƴŘƻǿǎξ{ȅǎ²h²сп ŀƴŘ ƭŀǳƴŎƘ ƻŘōŎŀŘонΦ 

2. Add system DSN(s) needed by the application. 

Notes regarding the proxy server 

¶ .ƻǘƘ ǘƘŜ ŘŀǘŀōŀǎŜ ǇǊƻȄȅ ǎŜǊǾŜǊ ŀƴŘ ǘƘŜ ŎƭƛŜƴǘ ǎƘƻǳƭŘ ōŜ ƳŜƳōŜǊǎ ƻŦ ǘƘŜ ǎŀƳŜ ŘƻƳŀƛƴΦ !ŎŎŜǎǎ ŦǊƻƳ 
ŘƛŦŦŜǊŜƴǘ ŘƻƳŀƛƴǎ ƻǊ ǿƻǊƪƎǊƻǳǇǎ ƛǎ ǊŜƧŜŎǘŜŘΦ ¢ƘŜ ŦƻƭƭƻǿƛƴƎ ŜǊǊƻǊ ƳŜǎǎŀƎŜ ǿƛƭƭ ŀǇǇŜŀǊΥ 

 

¶ ·.!t ŀǇǇƭƛŎŀǘƛƻƴǎ ŀǊŜ ǎǘƻǊŜŘ ƛƴ ŀ ƭƻŎŀƭ ŎŀŎƘŜ ƻƴ ǘƘŜ ŎƭƛŜƴǘΦ LŦ ȅƻǳ ǘǊȅ ǘƻ Ǌǳƴ ŀƴ ȄōŀǇ ŀǇǇƭƛŎŀǘƛƻƴ ŦǊƻƳ LL{ ƻǊ 
ƭƻŎŀƭ ŦƛƭŜ ǎȅǎǘŜƳ ŀƴŘ ƎŜǘ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ŜǊǊƻǊΣ ȅƻǳ Ƴǳǎǘ ŎƭŜŀǊ ǘƘŜ ƭƻŎŀƭ ŀǇǇƭƛŎŀǘƛƻƴ ŎŀŎƘŜΦ 

ά¦ƴŀōƭŜ ǘƻ ƛƴǎǘŀƭƭ ǘƘƛǎ ŀǇǇƭƛŎŀǘƛƻƴ ōŜŎŀǳǎŜ ŀƴ ŀǇǇƭƛŎŀǘƛƻƴ ǿƛǘƘ ǘƘŜ ǎŀƳŜ ƛŘŜƴǘƛǘȅ ƛǎ ŀƭǊŜŀŘȅ ƛƴǎǘŀƭƭŜŘΦ 
¢ƻ ƛƴǎǘŀƭƭ ǘƘƛǎ ŀǇǇƭƛŎŀǘƛƻƴΣ ŜƛǘƘŜǊ ƳƻŘƛŦȅ ǘƘŜ ƳŀƴƛŦŜǎǘ ǾŜǊǎƛƻƴ ŦƻǊ ǘƘƛǎ ŀǇǇƭƛŎŀǘƛƻƴ ƻǊ ǳƴƛƴǎǘŀƭƭ ǘƘŜ 
ǇǊŜŜȄƛǎǘƛƴƎ ŀǇǇƭƛŎŀǘƛƻƴΦέ 

LŦ ȅƻǳ ƳŀƪŜ ŎƘŀƴƎŜǎ ƛƴ ȅƻǳǊ ŎƻŘŜκ·!a[ ǘƘŀǘ ŀǊŜ ƴƻǘ ŘƛǎǇƭŀȅŜŘ ǿƘŜƴ ȅƻǳ Ǌǳƴ ǘƘŜ ŀǇǇΣ ŎƭŜŀǊ ǘƘŜ ƭƻŎŀƭ 
ŀǇǇƭƛŎŀǘƛƻƴ ŎŀŎƘŜΦ 

rundll32 %windir% \ system32 \ dfshim.dll CleanOnlineAppCache  

¶ ¢ƘŜ LL{ {ŜǊǾŜǊ ƳŀŎƘƛƴŜ Ƴǳǎǘ ƘŀǾŜ Φb9¢ CǊŀƳŜǿƻǊƪ όǾŜǊǎƛƻƴ оΦр {tмύ ƛƴǎǘŀƭƭŜŘΦ 
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#ÈÁÐÔÅÒ υ ɀ 70& #ÏÎÔÒÏÌÓ 

¢Ƙƛǎ ŎƘŀǇǘŜǊ ŜȄǇƭŀƛƴǎ Ƙƻǿ ǘƻ ƛƳǇƭŜƳŜƴǘ ²tC ŎƻƴǘǊƻƭǎ ƛƴ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴǎΣ ŎƘŀƴƎŜ ǘƘŜƛǊ ǇǊƻǇŜǊǘƛŜǎΣ ŀƴŘ 
ƛƴǾƻƪŜ ǘƘŜƛǊ ƳŜǘƘƻŘǎΦ 

Lƴ Ƴŀƴȅ ŎŀǎŜǎΣ ²tC ŎƻƴǘǊƻƭǎ ǎŜǊǾŜ ŀǎ ǊŜǇƭŀŎŜƳŜƴǘǎ ŦƻǊ Ǿƛǎǳŀƭ !ŎǘƛǾŜ· ŎƻƴǘǊƻƭǎΦ aƻǎǘ !ŎǘƛǾŜ· ŎƻƴǘǊƻƭǎ ŀǊŜ ƻƭŘ 
ƛƳǇƭŜƳŜƴǘŀǘƛƻƴǎ ƻŦ ƎŀǳƎŜǎΣ I¢a[ ǾƛŜǿŜǊǎΣ ŀƴŘ ƻǘƘŜǊ ŎƻƴǘǊƻƭǎΦ ¢ƘŜǎŜ ŎƻƴǘǊƻƭǎ ǳǎǳŀƭƭȅ ƘŀǾŜ ŀƴ ƻƭŘ-ŦŀǎƘƛƻƴŜŘ 
ƭƻƻƪ ŀƴŘ ŦŜŜƭΦ aŀƴȅ ǘƘƛǊŘ-ǇŀǊǘȅ ²tC ŎƻƴǘǊƻƭǎΣ ƘƻǿŜǾŜǊΣ ƛƳǇƭŜƳŜƴǘ ǎƛƳƛƭŀǊ ŦǳƴŎǘƛƻƴŀƭƛǘȅ ǿƛǘƘ ŀ ƳƻŘŜǊƴ ƭƻƻƪ 
ŀƴŘ ŦŜŜƭΦ ²tC ŎƻƴǘǊƻƭǎ ƳŀƪŜ ƛǘ Ŝŀǎȅ ǘƻ ǊŜǇƭŀŎŜ !ŎǘƛǾŜ· ŎƻƴǘǊƻƭǎ ǊŀǘƘŜǊ ǘƘŀƴ ǇǊŜǎŜǊǾŜ ǘƘŜ ƻǳǘŘŀǘŜŘ !ŎǘƛǾŜ· 
ŎƻƴǘǊƻƭǎΦ 

Lƴ ƻǘƘŜǊ ǿƻǊŘǎΣ ²tC ŎƻƴǘǊƻƭǎ ŀǊŜ ƻŦǘŜƴ ŀǾŀƛƭŀōƭŜ ƻƴƭƛƴŜΣ ǘƘŜȅ ƭƻƻƪ ƎǊŜŀǘΣ ŀƴŘ ǘƘŜƛǊ ƛƳǇƭŜƳŜƴǘŀǘƛƻƴ ƛǎ ŀ 
ǇǊŜŦŜǊŀōƭŜ ŀƭǘŜǊƴŀǘƛǾŜ ǘƻ ǘǊŀƴǎŦŜǊǊƛƴƎ ŀƴ ƻǳǘŘŀǘŜŘ !ŎǘƛǾŜ· ŎƻƴǘǊƻƭ ǘƻ ŀ Φb9¢ ŀǇǇƭƛŎŀǘƛƻƴΦ 

#ÕÓÔÏÍ 70& #ÏÎÔÒÏÌ ÉÎ 4ÅÁÍ $ÅÖÅÌÏÐÅÒ 

¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ Ŏƻƴǘŀƛƴǎ ŀ ŎƻƴǘǊƻƭ ŎŀƭƭŜŘ ŀ /ǳǎǘƻƳ ²tC /ƻƴǘǊƻƭΦ ¢Ƙƛǎ ŎƻƴǘǊƻƭ ƛǎ ƳǳŎƘ ƭƛƪŜ ŀ ŦǊŀƳŜ ǿƛǘƘ ŀƴ 
ŀŘŘŜŘΣ ƛƳǇƻǊǘŀƴǘ ŀǘǘǊƛōǳǘŜΥ ·ŀƳƭΦ ¢ƻ ǳǎŜ ŀ ²tC ŎƻƴǘǊƻƭ όƻŦ ŀƴȅ ƪƛƴŘύ ƛƴ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴΣ ǎƛƳǇƭȅ ŀŘŘ ŀ 
ά/ǳǎǘƻƳ ²tC /ƻƴǘǊƻƭέ ŀƴŘ ǘƘŜƴ ǳǎŜ ǘƘŜ ·ŀƳƭ ŀǘǘǊƛōǳǘŜ ǘƻ ǎǇŜŎƛŦȅ ǘƘŜ ǘȅǇŜ ƻŦ ²tC ŎƻƴǘǊƻƭ ȅƻǳ ǿƛƭƭ ōŜ 
ƛƳǇƭŜƳŜƴǘƛƴƎΦ ¢ƘŜ ·ŀƳƭ ŀǘǘǊƛōǳǘŜ ƛǎ ŀ ǎǘǊƛƴƎ ŎƻƴǘŀƛƴƛƴƎ ŀ ȄŀƳƭ ŦǊŀƎƳŜƴǘ ŦƻǊ ŀ ǎƛƴƎƭŜ ²tC ŎƻƴǘǊƻƭΦ ¢Ƙƛǎ ŎƻƴǘǊƻƭ 
ŎƻǳƭŘ ōŜ ŀ ŎƻƴǘŀƛƴŜǊ ǘƘŀǘ ƛƴ ǘǳǊƴ Ŏƻƴǘŀƛƴǎ ƻƴŜ ƻǊ ƳƻǊŜ ŀŘŘƛǘƛƻƴŀƭ ŎƻƴǘǊƻƭǎΦ ¢ƘŜ ȄŀƳƭ ŦǊŀƎƳŜƴǘ Ƴǳǎǘ Ŏƻƴǘŀƛƴ 
ȄƳƭ ƴŀƳŜǎǇŀŎŜ ŘŜŎƭŀǊŀǘƛƻƴǎ ŦƻǊ ŀƴȅ ƴŀƳŜǎǇŀŎŜǎ ǘƘŀǘ ŀǊŜ ǊŜŦŜǊŜƴŎŜŘΦ 

70& &ÕÎÃÔÉÏÎÓ 

¢ƘŜ ŦƻƭƭƻǿƛƴƎ ŦǳƴŎǘƛƻƴǎ ŀǊŜ ǇǊƻǾƛŘŜŘ ŦƻǊ ǊŜǘǊƛŜǾƛƴƎ ŀƴŘ ǎŜǘǘƛƴƎ ǘƘŜ ǾŀƭǳŜǎ ƻŦ ǇǊƻǇŜǊǘƛŜǎ ƛƴ ŀ ²tC ŎƻƴǘǊƻƭΥ 

{ŀƭ²tCDŜǘ.ƻƻƭtǊƻǇŜǊǘȅ 

{ŀƭ²tCDŜǘ5ŀǘŜtǊƻǇŜǊǘȅ 

{ŀƭ²tCDŜǘbǳƳŜǊƛŎtǊƻǇŜǊǘȅ 

{ŀƭ²tCDŜǘ{ǘǊtǊƻǇŜǊǘȅ 

{ŀƭ²tC{Ŝǘ.ƻƻƭtǊƻǇŜǊǘȅ 

{ŀƭ²tC{Ŝǘ5ŀǘŜtǊƻǇŜǊǘȅ 

{ŀƭ²tC{ŜǘbǳƳŜǊƛŎtǊƻǇŜǊǘȅ 

{ŀƭ²tC{Ŝǘ{ǘǊtǊƻǇŜǊǘȅ 

Lƴ ŀŘŘƛǘƛƻƴΣ {ŀƭ²tCLƴǾƻƪŜaŜǘƘƻŘ ŜƴŀōƭŜǎ ȅƻǳ ǘƻ Ŏŀƭƭ ƳŜǘƘƻŘǎ ŦƻǊ ²tC ŎƻƴǘǊƻƭǎ ŦǊƻƳ ǿƛǘƘƛƴ ȅƻǳǊ ¢ŜŀƳ 
5ŜǾŜƭƻǇŜǊ ŎƻŘŜΦ 

{ŜŜ ǘƘŜ ƻƴƭƛƴŜ ƘŜƭǇ ŦƻǊ ŘƻŎǳƳŜƴǘŀǘƛƻƴ ƻƴ ŜŀŎƘ ƻŦ ǘƘŜǎŜ ŦǳƴŎǘƛƻƴǎΦ 

70& %ÖÅÎÔÓ 

¢ƘŜ {!aψ²tC9ǾŜƴǘ ƳŜǎǎŀƎŜ ŀǇǇŜŀǊǎ ǿƘŜƴŜǾŜǊ ŀƴ ŜǾŜƴǘ ƻŎŎǳǊǎ ƛƴ ŀƴȅ ²tC ŎƻƴǘǊƻƭΦ ¢ƘǳǎΣ ŀƴȅ ²tC ŎƻƴǘǊƻƭ 
Ŏŀƴ ǳǎŜ {!aψ²tC9ǾŜƴǘ ŀƴŘ ǘƘŜ ŀǎǎƻŎƛŀǘŜŘ ǿǇŦϝƪŜȅǿƻǊŘǎΦ 

¢Ƙƛǎ ŜǾŜƴǘ Ƙŀǎ ǘƘǊŜŜ ƪŜȅǿƻǊŘǎΥ 

¶ ǿǇŦ9ǾŜƴǘbŀƳŜ ς ! ǎǘǊƛƴƎ ǘƘŀǘ ƛƴŘƛŎŀǘŜǎ ǿƘƛŎƘ ŜǾŜƴǘ ƻŎŎǳǊǊŜŘΦ 

¶ ǿǇŦ9ǾŜƴǘ/ŀƴŎŜƭƭŜŘ ς .ƻƻƭŜŀƴ ǘƘŀǘ Ŏŀƴ ōŜ ǎŜǘ ǘƻ ŎŀƴŎŜƭ ǘƘŜ ŜǾŜƴǘΦ 
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¶ ǿǇŦ9ǾŜƴǘIŀƴŘƭŜŘ ς .ƻƻƭŜŀƴ ǘƘŀǘ ƳŀǊƪǎ ǘƘŜ ŜǾŜƴǘ ŀǎ άƘŀƴŘƭŜŘέ ƛƴ ƻǊŘŜǊ ǘƻ ƛƴƘƛōƛǘ ǳƴǿŀƴǘŜŘ ƛƴǘŜǊŦŜǊŜƴŎŜΦ 

¢ƘŜ ŦƻƭƭƻǿƛƴƎ ƛǎ ŀƴ ŜȄŀƳǇƭŜ ƻŦ ǘƘŜ ǳǎŀƎŜ ƻŦ ǘƘƛǎ ŜǾŜƴǘ ŀƴŘ ƛǘǎ ǿǇŦ9ǾŜƴǘbŀƳŜ ƪŜȅǿƻǊŘΥ 

WPF Custom: xSlider Message Actions  

 On SAM_WPFEvent 

  If wpfEventName ="ValueChanged"  

   Call SalWPFGetNume ricProperty( xSlider, "Value", nSkX ) Set  

      sArgsTransform[0] =SalNumberToStrX(nSkX, 0 )  

   Call SalWPFInvokeMethod(wpfTransformMyTD, "setTransform",  

      sArgsTransform, sReturn)  

$ÅÂÕÇÇÉÎÇ !ÐÐÌÉÃÁÔÉÏÎÓ ×ÉÔÈ 70& #ÏÎÔÒÏÌÓ 

{ƻƳŜ ²tC ŎƻƴǘǊƻƭǎΣ ǎǳŎƘ ŀǎ ƳŜŘƛŀ ǇƭŀȅŜǊǎ ōŀǎŜŘ ƻƴ aŜŘƛŀ 9ƭŜƳŜƴǘΣ Řƻ ƴƻǘ ƘƻƴƻǊ ǘƘŜ ά/ǳǊǊŜƴǘ 5ƛǊŜŎǘƻǊȅέ 
ǿƘŜƴ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ƛǎ ƛƴ ŘŜōǳƎ ƳƻŘŜΦ ¢ƘǳǎΣ ŦƻǊ ²tC ŎƻƴǘǊƻƭǎ ǘƻ ǿƻǊƪ ŎƻƴǎƛǎǘŜƴǘƭȅ ŀǘ ŘŜōǳƎ ǘƛƳŜΣ ȅƻǳ Ƴǳǎǘ 
ǇǊƻǾƛŘŜ ǇǊƻǇŜǊ ¦w[ǎ ŦƻǊ ǎƻǳǊŎŜ ŦƛƭŜǎΣ ƛƴŎƭǳŘƛƴƎ ŀ Ŧǳƭƭ ǇŀǘƘ ǘƻ ǘƘŜ ŦƛƭŜ ǊŜǉǳƛǊŜŘΦ 

'ÁÕÇÅÓ 

hƴŜ ǘȅǇŜ ƻŦ ²tC ŎƻƴǘǊƻƭ ƛǎ ǘƘŜ ƎŀǳƎŜΦ DŀǳƎŜǎ ǇǊƻǾƛŘŜ ŀ Ǿƛǎǳŀƭƭȅ ƛƴǘŜǊŜǎǘƛƴƎ ŘƛǎǇƭŀȅ ƻŦ ƴǳƳŜǊƛŎŀƭ ŘŀǘŀΣ ŀƴŘ ǘƘŜ 
ǿƛŘŜ ǾŀǊƛŜǘȅ ƻŦ ²tC ƎŀǳƎŜǎ ŀǾŀƛƭŀōƭŜ ƳŀƪŜǎ ǘƘŜƳ ŀ ǾŜǊǎŀǘƛƭŜ ƻǇǘƛƻƴΦ 

DŀǳƎŜǎ ƘŀǾŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǇǊƻǇŜǊǘƛŜǎΦ !ƭƭ ƻŦ ǘƘŜǎŜ ǇǊƻǇŜǊǘƛŜǎ ƘŀǾŜ ǎǘǊƛƴƎ ǊŜǇǊŜǎŜƴǘŀǘƛƻƴǎΣ ǿƘƛŎƘ ƳŜŀƴǎ ǘƘŜȅ 
Ŏŀƴ ōŜ ǎŜǘ ƛƴ ǘƘŜ ŎƻƴǘǊƻƭΩǎ ·!a[ ǇǊƻǇŜǊǘȅ ƻǊ Ǿƛŀ {ŀƭ²tC{Ŝǘ{ǘǊtǊƻǇŜǊǘȅΦ 

Properties for all gauges 

tǊƻǇŜǊǘȅ ¢ȅǇŜ /ƻƳƳŜƴǘǎ 

aƛƴ 5ƻǳōƭŜ aƛƴƛƳǳƳ ±ŀƭǳŜ 

aŀȄ 5ƻǳōƭŜ aŀȄƛƳǳƳ ±ŀƭǳŜ 

LǎLƴǘŜǊŀŎǘƛǾŜ .ƻƻƭ LƴŘƛŎŀǘŜǎ ǿƘŜǘƘŜǊ ǘƘŜ ǳǎŜǊ Ŏŀƴ ŎƘŀƴƎŜ ǘƘŜ ǾŀƭǳŜ ōȅ ŘǊŀƎƎƛƴƎ ǘƘŜ 
ƴŜŜŘƭŜΣ ōŀǊΣ ŜǘŎΦ 

Lǎ[ƻƎŀǊƛǘƘƳƛŎ .ƻƻƭ LƴŘƛŎŀǘŜǎ ǘƘŀǘ ǘƘŜ ƎŀǳƎŜ ǎƘƻǳƭŘ ōŜ ƭƻƎŀǊƛǘƘƳƛŎ 

LǎwŜǾŜǊǎŜŘ .ƻƻƭ wŜǾŜǊǎŜ ǘƘŜ ƎŀǳƎŜ 

[ƻŎŀǘƛƻƴ  {ŎŀƭŜhōƧŜŎǘ[ƻŎŀǘƛƻƴ 

[ƻƎŀǊƛǘƘƳƛŎ.ŀǎŜ 5ƻǳōƭŜ  

aŀƧƻǊ¢ƛŎƪǎ 5ƻǳōƭŜ ¢ƘŜ ƴǳƳōŜǊ ƻŦ ƳŀƧƻǊ ǘƛŎƪǎ ƛƴ ǘƘŜ ƎŀǳƎŜΦ ϦaŀƧƻǊ ¢ƛŎƪǎϦ ŀǊŜ ǘƘƻǎŜ 
ǎǇŜŎƛŦȅƛƴƎ ǘƘŜ ƭŀǊƎŜǎǘ ǎƛȊŜ ƎǊƻǳǇƛƴƎΦ ¢ƘǳǎΣ ƛŦ ǘƘŜ ŜƴǘƛǊŜ ƎŀǳƎŜ ǊŀƴƎŜ 
Ŏƻƴǎƛǎǘǎ ƻŦ л ǘƘǊƻǳƎƘ мллΣ ŀƴŘ aŀƧƻǊ¢ƛŎƪǎ ƛǎ ǎŜǘ ǘƻ пΣ ǘƘŜǊŜ ǿƛƭƭ ōŜ ŦƻǳǊ 
ƳŀƧƻǊ ƎǊƻǳǇǎ ƛƴǎƛŘŜ ǘƘŀǘ ǊŀƴƎŜ ƻŦ л-мллΣ ǿƘƛŎƘ ǿƛƭƭ ǊŜǎǳƭǘ ƛƴ ǘƛŎƪ ƳŀǊƪǎ 
ŀǘ нрΣ рлΣ ŀƴŘ трΦ Lƴ Ƴƻǎǘ ƎŀǳƎŜǎΣ ǘƘŜ ƳŀƧƻǊ ǘƛŎƪ ƳŀǊƪǎ ŀǊŜ ǘƘŜ ƭƻŎŀǘƛƻƴǎ 
ǿƘŜǊŜ ŀƴ ŀŎǘǳŀƭ ƴǳƳŜǊƛŎ ǾŀƭǳŜ ƛǎ ŘǊŀǿƴ ƻƴ ǘƘŜ ǎŎŀƭŜΦ 
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tǊƻǇŜǊǘȅ ¢ȅǇŜ /ƻƳƳŜƴǘǎ 

aƛŘŘƭŜ¢ƛŎƪǎ 5ƻǳōƭŜ 9ŀŎƘ ƳŀƧƻǊ ǘƛŎƪ ǎŜŎǘƛƻƴ Ŏŀƴ ōŜ ǎǳōŘƛǾƛŘŜŘ ƛƴǘƻ aƛŘŘƭŜ ¢ƛŎƪǎΦ ¢ƘŜ 
aƛŘŘƭŜ¢ƛŎƪǎ ǇǊƻǇŜǊǘȅ ǎǇŜŎƛŦƛŜǎ Ƙƻǿ Ƴŀƴȅ ǎǳōƎǊƻǳǇǎ ŀǊŜ ŘƛǎǇƭŀȅŜŘ 
ƛƴǎƛŘŜ ŜŀŎƘ ƳŀƧƻǊ ǘƛŎƪ ƎǊƻǳǇΦ ! aƛŘŘƭŜ¢ƛŎƪǎ ǎŜǘǘƛƴƎ ƻŦ н ǊŜǎǳƭǘǎ ƛƴ ƻƴŜ 
ƳŜŘƛǳƳ-ǎƛȊŜŘ ǘƛŎƪ ƳŀǊƪ ŘǊŀǿƴ ōŜǘǿŜŜƴ ŜŀŎƘ ƳŀƧƻǊ-ǎƛȊŜŘ ǘƛŎƪ ƳŀǊƪ 
όƻƴŜ ƳŜŘƛǳƳ ǘƛŎƪ ŘƛǾƛŘƛƴƎ ǘƘŜ ǘǿƻ ƳŜŘƛǳƳ ǘƛŎƪ ƎǊƻǳǇǎύΦ 

aƛƴƻǊ¢ƛŎƪǎ 5ƻǳōƭŜ {ƛƳƛƭŀǊ ǘƻ aƛŘŘƭŜ¢ƛŎƪǎΦ ¢ƘŜ aƛƴƻǊ¢ƛŎƪǎ ǇǊƻǇŜǊǘȅ ƛƴŘƛŎŀǘŜǎ Ƙƻǿ Ƴŀƴȅ 
ǎǳōƎǊƻǳǇǎ ŀǊŜ ŘƛǎǇƭŀȅŜŘ ǿƛǘƘƛƴ ŜŀŎƘ ƳƛŘŘƭŜ ǘƛŎƪ ƎǊƻǳǇΦ 

{ƘƻǿCƛǊǎǘ[ŀōŜƭ .ƻƻƭ LƴŘƛŎŀǘŜǎ ǿƘŜǘƘŜǊ ǘƘŜ ŦƛǊǎǘ ƭŀōŜƭ ǎƘƻǳƭŘ ōŜ ǎƘƻǿƴ 

{Ƙƻǿ[ŀǎǘ[ŀōŜƭ .ƻƻƭ LƴŘƛŎŀǘŜǎ ǿƘŜǘƘŜǊ ǘƘŜ ƭŀǎǘ ƭŀōŜƭ ǎƘƻǳƭŘ ōŜ ǎƘƻǿƴ 

±ŀƭǳŜ  5ƻǳōƭŜ ¢ƘŜ ǾŀƭǳŜ ƻŦ ǘƘŜ ƎŀǳƎŜ 

LǎCƭŀǘ .ƻƻƭ ¦ǎŜ ŀ ŦƭŀǘΣ н5 ǎǘȅƭŜ 

Properties for Radial Gauges, Range Gauges, and Flat Range Gauges 

tǊƻǇŜǊǘȅ ¢ȅǇŜ /ƻƳƳŜƴǘǎ 

wŀŘƛǳǎ 5ƻǳōƭŜ ¢ƘŜ ǊŀŘƛǳǎ 

{ǘŀǊǘ!ƴƎƭŜ 5ƻǳōƭŜ {ǘŀǊǘ ŀƴƎƭŜ ƛƴ ŘŜƎǊŜŜǎ όл Ґ ǊƛƎƘǘΣ фл Ґ Řƻǿƴύ 

{ǿŜŜǇ!ƴƎƭ Ŝ 5ƻǳōƭŜ bǳƳōŜǊ ƻŦ ŘŜƎǊŜŜǎ ŦǊƻƳ ǘƘŜ ǎǘŀǊǘ ǘƻ ǘƘŜ ŜƴŘ 

Properties for Range Gauges and Flat Range Gauges 

tǊƻǇŜǊǘȅ ¢ȅǇŜ /ƻƳƳŜƴǘǎ 

wŀƴƎŜ[ƛǎǘ wŀƴƎŜ[ƛǎǘ [ƛǎǘ ƻŦ ǊŀƴƎŜǎΤ ŦƻǊ ŜȄŀƳǇƭŜΥ  
άwŜŘ-л-оллΤ¸Ŝƭƭƻǿ-олм-сллΤDǊŜŜƴ-слм-млллέύ 

 

¢ƘŜ wŀƴƎŜ[ƛǎǘ ǇǊƻǇŜǊǘȅ ŘŜǎŎǊƛōŜǎ ǘƘŜ ŎƻƭƻǊ ǊŀƴƎŜǎ ŦƻǊ ŀ ƎǊŀǇƘΦ  

¢ƘŜ ǎǘǊƛƴƎ ǊŜǇǊŜǎŜƴǘŀǘƛƻƴ Ƙŀǎ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ŦƻǊƳŀǘΣ ǿƘŜǊŜ ғōǊǳǎƘƴҔ ƛǎ ŀƴȅ ǎǘǊƛƴƎ ǘƘŀǘ Ŏŀƴ ōŜ ǳǎŜŘ ǘƻ ŘŜǎŎǊƛōŜ 
ŀ ōǊǳǎƘ ƛƴ ȄŀƳƭΣ ŀƴŘ ғaƛƴƴҔ ŀƴŘ ғƳŀȄƴҔ ŀǊŜ ǘƘŜ ƳƛƴƛƳǳƳ ŀƴŘ ƳŀȄƛƳǳƳ ǾŀƭǳŜǎ ŦƻǊ ǘƘŜ ǊŀƴƎŜΥ 

<brush1> - <min1> - <max1>;<brush2> - <min2> - <max2> 

%ØÁÍÐÌÅÓ 

CƻǊ ŜȄŀƳǇƭŜǎ ƻŦ Ƙƻǿ ǘƻ ƛƳǇƭŜƳŜƴǘ ²tC ŎƻƴǘǊƻƭǎ ƛƴ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴǎΣ ŎƘŀƴƎŜ ǘƘŜƛǊ ǇǊƻǇŜǊǘƛŜǎΣ ƛƴǾƻƪŜ ǘƘŜƛǊ 
ƳŜǘƘƻŘǎΣ ŀƴŘ ǎƻ ƻƴΣ ǎŜŜ ǘƘŜ ǎŀƳǇƭŜ ŀǇǇƭƛŎŀǘƛƻƴǎ ƛƴ ȅƻǳǊ ώ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊϐξ{ŀƳǇƭŜǎξ ŘƛǊŜŎǘƻǊȅΦ 
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#ÈÁÐÔÅÒ φ ɀ #ÏÎÎÅÃÔÉÖÉÔÙ ÉÎ Ȣ.%4 
!ÐÐÌÉÃÁÔÉÏÎÓ 

¢Ƙƛǎ ŎƘŀǇǘŜǊ ŜȄǇƭŀƛƴǎ Ƙƻǿ ǘƻ ŎƻƴƴŜŎǘ ǘƻ hǊŀŎƭŜΣ {v[ {ŜǊǾŜǊΣ ŀƴŘ {v[.ŀǎŜ ƛƴ Φb9¢ ŀǇǇƭƛŎŀǘƛƻƴǎΦ 

#ÏÎÎÅÃÔÉÎÇ ÔÏ /ÒÁÃÌÅ 

¶ ²ƘŜƴ ŘŜǾŜƭƻǇƛƴƎ ²tC ŀǇǇƭƛŎŀǘƛƻƴǎ ǘƘŀǘ Ǝƻ ŀƎŀƛƴǎǘ ŀƴ hǊŀŎƭŜ ŘŀǘŀōŀǎŜΣ ȅƻǳ Ƴǳǎǘ ǳǎŜ ǘƘŜ hǊŀŎƭŜ ммƎwн 
он-ōƛǘ ŎƭƛŜƴǘΦ 

¶ ¢ƘŜ hǊŀŎƭŜммƎwн он-ōƛǘ ŎƭƛŜƴǘ Ŏŀƴ ōŜ ǳǎŜŘ ǘƻ Ǝƻ ŀƎŀƛƴǎǘ ŀƴ ƻǊŀŎƭŜмлƎ ƻǊ ƻǊŀŎƭŜммƎ ŘŀǘŀōŀǎŜΦ 

¶ ¢ƘŜǊŜ ƛǎ ƴƻ ƴŜŜŘ ǘƻ ŎƻƴŦƛƎǳǊŜ ŀƴ hǊŀŎƭŜ Φb9¢ ŎƻƴƴŜŎǘƛƻƴ ōŜŎŀǳǎŜ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ƳŀǇǎ 
ȅƻǳǊ ƴŀǘƛǾŜ ŀƴŘ h[95. ŎƻƴƴŜŎǘƛƻƴǎ ǘƻ ŜǉǳƛǾŀƭŜƴǘ Φb9¢ ŎƻƴƴŜŎǘƛƻƴǎΦ 

¢ƻ ŎƻƴŦƛƎǳǊŜ ŀƴ ƻǊŀŎƭŜ h[95. ¦5[ ŦƛƭŜΣ Ŧƻƭƭƻǿ ǘƘŜǎŜ ǎǘŜǇǎΥ 

1. Open the command prompt and register the Oracle 11gR2 32bit OLEDB driver: 

regsvr32 C: \ app \ <users> \ product \ 11.2.0 \ client_1 \ BIN \ OraOLEDB11.dll  

2. Launch the "Data Link Properties" dialog for the udl file you want to configure: 

rundll32.exe "%ProgramFiles(x86)% \ Common Files \ System \ OLEDB\ oledb32.dll",  

 OpenDSLFile "<path to udl file> \ <udlfile>.udl"  

3. Under the Provider tab, select Oracle Provider for OLE DB. 
 

 

4. Click the Connection tab and enter your Data Source name, username, and password. 
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5. Click Test Connection. 

 

hƴ ŀ сп-ōƛǘ ²ƛƴŘƻǿǎ h{Σ Ǌǳƴ ǊŜƎǎǾǊон ŀƴŘ ǊǳƴŘƭƭон ŦǊƻƳ /Υξ²ƛƴŘƻǿǎξǎȅǎǿƻǿспΦ 

#ÏÎÎÅÃÔÉÎÇ ÔÏ 31,3ÅÒÖÅÒ 

¸ƻǳǊ {v[{ŜǊǾŜǊ ǎǘŀƴŘŀǊŘκbŀǘƛǾŜ h5./ ŀƴŘ h[95. ŎƻƴƴŜŎǘƛƻƴǎ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ƳŀǇ ǘƻ ŜǉǳƛǾŀƭŜƴǘ Φb9¢ 
ŎƻƴƴŜŎǘƛƻƴǎΦ 

ODBC 

¢ƻ ǎŜǘ ǳǇ ŀƴ ƻŘōŎ ŎƻƴƴŜŎǘƛƻƴΣ Ŧƻƭƭƻǿ ǘƘŜǎŜ ǎǘŜǇǎΥ 

1. Open the command prompt and run odbcad32. 

hƴ ŀ сп-ōƛǘ ǿƛƴŘƻǿǎ h{Σ Ǌǳƴ ƻŘōŎŀŘон ŦǊƻƳ ǘƘŜ ǎȅǎǿƻǿсп ŘƛǊŜŎǘƻǊȅΦ 

2. In the ODBC Data Source Administrator window, click the Add button. 
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3. In the resulting Create New Data Source dialog, scroll down to SQL Server (for standard odbc connection) 
or Native SQLServer (for native odbc connection) and select Finish. 

 

 

4. In the Create New Data Source to SQL Server dialog, enter a reference name for the server and a 
description, select the server you want to connect to, and select Next. 
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5. Select With SQL Server authentication using a login ID and password entered by the user, enter the 
Login ID and Password, and click Next. 

 

 

6. /ƘŜŎƪ ǘƘŜ ά/ƘŀƴƎŜ ǘƘŜ ŘŜŦŀǳƭǘ ŘŀǘŀōŀǎŜ ǘƻέ check box, select your database from the dropdown, and 
click Next. 

 

7. Click Finish. 

8. Select Test Data Source and, if the test is successful, click OK. 

9. Exit the ODBC Data Source Administrator and open up the sql.ini in your Team Developer directory. 

10. ¦ƴŎƻƳƳŜƴǘ ǘƘŜ ƭƛƴŜ ƻŦ ŎƻŘŜ άŎƻƳŘƭƭҐǎǉƭƻŘōонέ ŀƴŘ ƛƴǎŜǊǘ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ƭƛƴŜ ƻŦ ŎƻŘŜ ǳƴŘŜǊ άώƻŘōŎǊǘǊϐέ 
using the reference name you gave your server: 

remotedbname=[RefName],dns=[ RefName] (for example,  

 remotedbname=[SVR1],dns=[SVR1])  

31, 3ÅÒÖÅÒ 4)-%34!-0 

5ǳŜ ǘƻ ǎǘǊƛŎǘ 5ŀǘŀ ¢ȅǇŜ aŀǘŎƘƛƴƎ ƛƴ²tC ŀǇǇƭƛŎŀǘƛƻƴǎΣ {ǉƭ{ŜǊǾŜǊ ¢La9{¢!at{ όǿƘƛŎƘ ŀǊŜ ƻŦǘŜƴ ǳǎŜŘ ŀǎ wƻǿ 
L5ǎύ ŀǊŜ ƘŀƴŘƭŜŘ ǎƻƳŜǿƘŀǘ ŘƛŦŦŜǊŜƴǘƭȅ ǘƘŀƴ ǘƘŜȅ ŀǊŜ ƛƴ ²LbонΦ .ŜŎŀǳǎŜ ¢La9{¢!atǎ ŀǊŜ ōƛƴŀǊȅ Řŀǘŀ ǘȅǇŜǎΣ 
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ǘƻ ōƛƴŘ ŀ ǘƛƳŜǎǘŀƳǇ ǘƻ ŀ ǎǘǊƛƴƎ ȅƻǳ Ƴǳǎǘ Ŏŀƭƭ Ϧ{Ŝǘ[ƻƴƎ.ƛƴŘ5ŀǘŀǘȅǇŜϦ ŀŦǘŜǊ ǊǳƴƴƛƴƎ {ǉƭtǊŜǇŀǊŜ ŀƴŘ ōŜŦƻǊŜ 
ǊǳƴƴƛƴƎ {ǉƭ9ȄŜŎǳǘŜΣ ŀǎ ƛƴ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ŜȄŀƳǇƭŜΥ 

Call SqlPrepare(hSql,"SELECT ROWID INTO :dfString FROM TEST") Call 

SqlSetL ongBindDatatype(1, 23)  

Call SqlExecute(hSql)  

¢ƘŜ ǊŜǎǳƭǘƛƴƎ ǎǘǊƛƴƎ ǿƛƭƭ ōŜ ŀ ǎǘǊƛƴƎ ƻŦ ōȅǘŜǎ ǇŀŎƪŜŘ ƛƴǘƻ ŀ ŘƻǳōƭŜ-ōȅǘŜ ¦ƴƛŎƻŘŜ ǎǘǊƛƴƎΦ Lǘ ǿƛƭƭ ƴƻǘ ōŜ ƘǳƳŀƴ 
ǊŜŀŘŀōƭŜΣ ōǳǘ Ŏŀƴ ōŜ ǳǎŜŘ ǘƻ ŎƻƳǇŀǊŜ ǘƘŜ ŎƻƴǘŜƴǘǎ ƻŦ ƻƴŜ Ǌƻǿ ǘƻ ŀƴƻǘƘŜǊΦ 

31,"ÁÓÅ 

Φb9¢ ŎƻƴƴŜŎǘƛǾƛǘȅ ƛƴ {v[.ŀǎŜ ƛǎ ŀ ƳƛǊǊƻǊ ƻŦ ƴŀǘƛǾŜΦ bƻ ŀŘŘƛǘƛƻƴŀƭ ŀŎǘƛƻƴǎ ŀǊŜ ǊŜǉǳƛǊŜŘ ƻƴ ǘƘŜ ǇŀǊǘ ƻŦ ǘƘŜ ǳǎŜǊΦ 
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#ÈÁÐÔÅÒ χ ɀ Ȣ.%4 %ØÐÌÏÒÅÒ 

¢Ƙƛǎ ŎƘŀǇǘŜǊ ŘŜǎŎǊƛōŜǎ Φb9¢ 9ȄǇƭƻǊŜǊΣ ǘƘŜ ŀǎǎŜƳōƭƛŜǎ ȅƻǳ Ŏŀƴ ŀŎŎŜǎǎΣ ŀƴŘ ǘƘŜ ƭƛōǊŀǊƛŜǎ ȅƻǳ Ŏŀƴ ōǳƛƭŘ ǿƛǘƘ ƛǘΦ 

Φb9¢ 9ȄǇƭƻǊŜǊ ƛǎ ŀ ǇƻǿŜǊŦǳƭ ǘƻƻƭ ǘƘŀǘ ŀƭƭƻǿǎ ȅƻǳ ǘƻ ƎŜƴŜǊŀǘŜ ƛƴŎƭǳŘŜ ƭƛōǊŀǊƛŜǎ ό!t[ǎύ ŦǊƻƳ ŜȄƛǎǘƛƴƎ Φb9¢ 
ŀǎǎŜƳōƭƛŜǎΦ ¢ƘŜ ǊŜǎǳƭǘƛƴƎ !t[ǎ Ŏŀƴ ōŜ ƛƴŎƭǳŘŜŘ ƛƴ ȅƻǳǊ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ŀǇǇƭƛŎŀǘƛƻƴ ǿƘŜǘƘŜǊ ȅƻǳǊ ōǳƛƭŘ ǘŀǊƎŜǘ 
ƛǎ ²ƛƴон ƻǊ Φb9¢Φ 

5ÓÉÎÇ Ȣ.%4 %ØÐÌÏÒÅÒ 

Cƻƭƭƻǿ ǘƘŜǎŜ ǎǘŜǇǎΥ 

1. In the Tools menu, select .NET Explorer. The following window opens: 

 

2. Click Next. 

3. The next screen asks you to select GAC Assembly or Assembly File. 

 

4 D!/ !ǎǎŜƳōƭȅ ς /ƘƻƻǎŜ ǘƘƛǎ ƻǇǘƛƻƴ ǘƻ ƛƳǇƻǊǘ ŀƴ ŀǎǎŜƳōƭȅ ŦǊƻƳ ǘƘŜ Dƭƻōŀƭ !ǎǎŜƳōƭȅ /ŀŎƘŜ όŀ 
ŎƻƭƭŜŎǘƛƻƴ ƻŦ Φb9¢ ŀǎǎŜƳōƭƛŜǎ ǘƘŀǘ ŜȄƛǎǘ ƻƴ ȅƻǳǊ ƳŀŎƘƛƴŜύΦ 

4 !ǎǎŜƳōƭȅ CƛƭŜ ς /ƘƻƻǎŜ ǘƘƛǎ ƻǇǘƛƻƴ ǘƻ ƛƳǇƻǊǘ ŀ ŎǳǎǘƻƳ ŀǎǎŜƳōƭȅΦ  

aŀƪŜ ȅƻǳǊ ǎŜƭŜŎǘƛƻƴ ŀƴŘ ŎƭƛŎƪ bŜȄǘΦ 

4. The next window differs according to the option you selected in the previous step. 

LŦ ȅƻǳ ŎƘƻǎŜ D!/ !ǎǎŜƳōƭȅΣ ȅƻǳ ǿƛƭƭ ǎŜŜ ŀ ǎŎǊŜŜƴ ǎƛƳƛƭŀǊ ǘƻ ǘƘŜ ŦƻƭƭƻǿƛƴƎΥ 
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LŦ ȅƻǳ ŎƘƻǎŜ !ǎǎŜƳōƭȅ CƛƭŜΣ ȅƻǳ ǿƛƭƭ ǎŜŜ ŀ Řŀǘŀ ŦƛŜƭŘ ŀƴŘ .ǊƻǿǎŜ ōǳǘǘƻƴ ǿƘŜǊŜ ȅƻǳ Ŏŀƴ ƛƴŘƛŎŀǘŜ ǘƘŜ 
ƭƻŎŀǘƛƻƴ ƻŦ ǘƘŜ ŀǎǎŜƳōƭȅ ŦƛƭŜΦ 

¢Ƙƛǎ ǎǘŜǇ ŀƴŘ ǘƘŜ ƴŜȄǘ ǎǘŜǇ ŀǎǎǳƳŜ ǘƘŀǘ ȅƻǳ ŎƘƻǎŜ D!/ !ǎǎŜƳōƭȅΦ {ŜŜ ǎǘŜǇǎ с ŀƴŘ т ŦƻǊ ƛƴŦƻǊƳŀǘƛƻƴ ǘƘŀǘ 
ŀǇǇƭƛŜǎ ǘƻ ŜƛǘƘŜǊ ƻǇǘƛƻƴΦ 

{ŜƭŜŎǘ ǘƘŜ ŀǎǎŜƳōƭȅ ȅƻǳ ǿŀƴǘ ǘƻ ƛƳǇƻǊǘ ŀƴŘ ŎƭƛŎƪ bŜȄǘΦ 

5. The next screen lists classes contained in the assembly you selected.  

{ŜƭŜŎǘ ǘƘŜ ŎƭŀǎǎόŜǎύ ȅƻǳ ǿŀƴǘ ǘƻ ƛƳǇƻǊǘΦ ¦ǎŜ {ƘƛŦǘҌŎƭƛŎƪΣ /ǘǊƭҌŎƭƛŎƪΣ ƻǊ ŎƭƛŎƪ ŀƴŘ ŘǊŀƎ ǘƻ ǎŜƭŜŎǘ ƳǳƭǘƛǇƭŜ 
ŎƭŀǎǎŜǎΦ 

 

¸ƻǳ Ƴǳǎǘ ŀƭǎƻ ƛƴŘƛŎŀǘŜ ǘƘŜ ƻǳǘǇǳǘ ǇŀǘƘ ŦƻǊ ǘƘŜ !t[ ǘƘŀǘ ǿƛƭƭ ōŜ ƎŜƴŜǊŀǘŜŘΦ ¢ȅǇŜ ǘƘŜ ǇŀǘƘ ƛƴ ǘƘŜ hǳǘǇǳǘ 
tŀǘƘ ŦƛŜƭŘ ƻǊ ǳǎŜ ǘƘŜ .ǊƻǿǎŜ ōǳǘǘƻƴ ǘƻ ƴŀǾƛƎŀǘŜ ǘƻ ǘƘŜ ŘŜǎƛǊŜŘ ŘƛǊŜŎǘƻǊȅΦ 
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/ƭƛŎƪ bŜȄǘΦ 

6. When you see the following message, click Finish. 

 

Φb9¢ 9ȄǇƭƻǊŜǊ ŎƭƻǎŜǎ ŀƴŘΣ ŀǎǎǳƳƛƴƎ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ƛǎ ǎǘƛƭƭ ǘƘŜ Ƴƻǎǘ ǊŜŎŜƴǘƭȅ ŀŎǘƛǾŜ ŀǇǇƭƛŎŀǘƛƻƴΣ ǊŜǘǳǊƴǎ 
ȅƻǳ ǘƻ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴ ƻǳǘƭƛƴŜΦ  

¢ƘŜ ƎŜƴŜǊŀǘŜŘ !t[ ƛǎ ƴƻǘ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ƛƴŎƭǳŘŜŘ ƛƴ ȅƻǳǊ ƻǳǘƭƛƴŜΦ ¢ƘŜǊŜŦƻǊŜΣ ǊŜǇŜŀǘ ǎǘŜǇǎ м-с ǘƻ ƎŜƴŜǊŀǘŜ 
ŀǎ Ƴŀƴȅ !t[ǎ ŀǎ ȅƻǳ ǿŀƴǘΦ 

bƻǘŜΥ Φb9¢ ŀǎǎŜƳōƭƛŜǎ ό5[[ǎύ ŎǊŜŀǘŜŘ ƛƴ ±ƛǎǳŀƭ {ǘǳŘƛƻ Ƴǳǎǘ ōŜ ƎŜƴŜǊŀǘŜŘ ǿƛǘƘ ǘŀǊƎŜǘ ŦǊŀƳŜǿƻǊƪ ǎŜǘ ǘƻ Φb9¢ 
CǊŀƳŜǿƻǊƪ оΦр ƻǊ Φb9¢ CǊŀƳŜǿƻǊƪ пΦлΦ hǘƘŜǊǿƛǎŜΣ Φb9¢ 9ȄǇƭƻǊŜǊ ŘƛǎǇƭŀȅǎ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ŜǊǊƻǊ 
ƳŜǎǎŀƎŜ ǿƘŜƴ ȅƻǳ ǘǊȅ ǘƻ ƛƳǇƻǊǘ ǘƘŜ 5[[Υ ά/ƻǳƭŘ ƴƻǘ ƭƻŀŘ ǘƘŜ ǎŜƭŜŎǘŜŘ ŀǎǎŜƳōƭȅ ōŜŎŀǳǎŜ ƛǘǎ /t¦ 
ŀǊŎƘƛǘŜŎǘǳǊŜ ƛǎ ƴƻǘ ǎǳǇǇƻǊǘŜŘΦέ 

7. To include the generated APL, right-click the Libraries section of your outline, select Add Next Level and 
File Include. 

8. Browse to the location you indicated in the Output Path (step 5), and select the new APL file. If it does 
not reside in the same directory as your application outline, click the άAppend Path To File Nameέ check 
box, and click Open. 

!ÂÏÕÔ !8,Óȟ !0,Óȟ $,,Ó 

$ÅÆÉÎÉÔÉÏÎÓ 

In this chapter, AXL, DLL, and APL files are defined as follows: 

¶ !·[Φ !ƴ !·[ ŦƛƭŜ ƛǎ ŀ ŘŜǎŎǊƛǇǘƛƻƴ όǿǊƛǘǘŜƴ ƛƴ ·a[ύ ƻŦ ǘƘŜ ǎȅƳōƻƭǎ ōŜƛƴƎ ƛƳǇƻǊǘŜŘ ŦǊƻƳ ǘƘŜ ŜȄǘŜǊƴŀƭ 
ŀǎǎŜƳōƭȅΦ Lǘ Ƴǳǎǘ ōŜ ƛƴŎƭǳŘŜŘ ŦƻǊ ŀ Φb9¢ ǇǊƻƧŜŎǘΦ 

¶ 5[[Φ ! 5[[ ƛǎ ŀ ƭƛōǊŀǊȅ ǘƘŀǘ Ŏƻƴǘŀƛƴǎ ŎƻƳǇƛƭŜŘ ŎƻŘŜ ŦƻǊ ŦǳƴŎǘƛƻƴǎ ǘƘŀǘ ǿƛƭƭ ōŜ ŎŀƭƭŜŘ ŦǊƻƳ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΦ 

¶ !t[Φ [ƛƪŜ ŀ 5[[Σ ŀƴ !t[ ƛǎ ŀ ƭƛōǊŀǊȅ ǘƘŀǘ Ŏƻƴǘŀƛƴǎ ŎƻŘŜ ŦƻǊ ŦǳƴŎǘƛƻƴǎ ǘƘŀǘ ǿƛƭƭ ōŜ ŎŀƭƭŜŘ ŦǊƻƳ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΦ 

Ȣ.%4 %ØÐÌÏÒÅÒ 'ÅÎÅÒÁÔÅÓ !0, ÁÎÄ !8, 

²ƘŜƴ ȅƻǳ ƛƳǇƻǊǘ ŀ Φb9¢ ŀǎǎŜƳōƭȅ ŀƴŘ ŎǊŜŀǘŜ ŀƴ !t[ Ǿƛŀ Φb9¢ 9ȄǇƭƻǊŜǊΣ ŀƴ !·[ ŦƛƭŜ ƻŦ ǘƘŜ ǎŀƳŜ ƴŀƳŜ ƛǎ ŀƭǎƻ 
ƎŜƴŜǊŀǘŜŘΦ !ǎ ŜȄǇƭŀƛƴŜŘ ǇǊŜǾƛƻǳǎƭȅΣ ǘƘŜ !t[ ŦƛƭŜ ƛǎ ǘƘŜ ƻƴŜ ȅƻǳ ƛƴŎƭǳŘŜ ƛƴ ȅƻǳǊ ƻǳǘƭƛƴŜΦ ²ƘŜƴ ȅƻǳ ƛƴŎƭǳŘŜ ǘƘŜ 
!t[Σ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ƛƳǇƻǊǘǎ ǘƘŜ !·[ ŦƛƭŜ ŀǎ ǿŜƭƭΦ ¸ƻǳ Ŏŀƴ ǎŜŜ ǘƘƛǎ ƛƴ ǘƘŜ 9ȄǘŜǊƴŀƭ !ǎǎŜƳōƭƛŜǎ 
ǎŜŎǘƛƻƴ ƻŦ ǘƘŜ ƻǳǘƭƛƴŜΦ 

¢ŜŎƘƴƛŎŀƭƭȅΣ ǘƘŜ !·[ ƛǎ ƻƴƭȅ ƴŜŜŘŜŘ ƛŦ ȅƻǳǊ ŦƛƴƛǎƘŜŘ ǇǊƻŘǳŎǘ ǿƛƭƭ ōŜ ŀ Φb9¢ ŀǇǇƭƛŎŀǘƛƻƴΦ ¢ƘŜ !t[ ƛǎ ƻƴƭȅ ƴŜŜŘŜŘ 
ƛŦ ȅƻǳǊ ŦƛƴƛǎƘŜŘ ǇǊƻŘǳŎǘ ǿƛƭƭ ōŜ ŀ ²ƛƴон ŀǇǇƭƛŎŀǘƛƻƴΦ .ƻǘƘ ŦƛƭŜǎ ŀǊŜ ƛƴŎƭǳŘŜŘ ƛƴ ǘƘŜ ƻǳǘƭƛƴŜ ŦƻǊ ǘǿƻ ǊŜŀǎƻƴǎΥ 

¶ ²ƛǘƘ ōƻǘƘ ŦƛƭŜǎ ƛƴŎƭǳŘŜŘΣ ȅƻǳ Ŏŀƴ ŎƻƳǇƛƭŜ ȅƻǳǊ ŀǇǇƭƛŎŀǘƛƻƴ ǘƻ Φb9¢ ƻǊ ²ƛƴон ǿƛǘƘƻǳǘ ŎƘŀƴƎƛƴƎ ȅƻǳǊ ŦƛƭŜ 
ƛƴŎƭǳǎƛƻƴǎΦ 

¶ ¢ƘŜ /ƻŘƛƴƎ !ǎǎƛǎǘŀƴǘ ŘǊŀǿǎ ǳǇƻƴ ǘƘŜ !t[ ŦƻǊ ŦǳƴŎǘƛƻƴ ƴŀƳŜǎΣ ǇŀǊŀƳŜǘŜǊǎΣ ŜǘŎΦ ¢ƘǳǎΣ ƛŦ ȅƻǳ ƻƴƭȅ ƛƴŎƭǳŘŜ 
ǘƘŜ !·[ ŦƛƭŜΣ ǘƘŜ ŎƻŘƛƴƎ ŀǎǎƛǎǘŀƴǘΩǎ ŦŜŀǘǳǊŜǎ ǿƛƭƭ ōŜ ƭƛƳƛǘŜŘΦ 
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Ȣ.%4 3!, ,ÉÂÒÁÒÙ 'ÅÎÅÒÁÔÅÓ $,, ÁÎÄ !8, 

²ƘŜƴ ȅƻǳ ŎǊŜŀǘŜ ŀ Φb9¢ {![ [ƛōǊŀǊȅ ǿƛǘƘ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊΣ ǘƘŜ ŎƻƳǇƛƭŜŘ ǇǊƻƧŜŎǘ Ŏƻƴǎƛǎǘǎ ƻŦ ǘǿƻ ŦƛƭŜǎΥ ŀ 5[[ 
ŀƴŘ ŀƴ !·[Φ Lƴ ǘƘƛǎ ŎŀǎŜΣ ȅƻǳ ǿƛƭƭ ƛƴŎƭǳŘŜ ǘƘŜ !·[ ŦƛƭŜ όƛƴ ǘƘŜ 9ȄǘŜǊƴŀƭ !ǎǎŜƳōƭƛŜǎ ǎŜŎǘƛƻƴ ƻŦ ȅƻǳǊ ƻǳǘƭƛƴŜύΦ 
¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ƭƻƻƪǎ ƛƴ ǘƘŜ ǎŀƳŜ ŘƛǊŜŎǘƻǊȅ ŦƻǊ ǘƘŜ 5[[ ŀƴŘ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ƛƴŎƭǳŘŜǎ ƛǘΦ 

6ÁÒÉÁÂÌÅÓ "ÁÓÅÄ ÏÎ )ÍÐÏÒÔÅÄ Ȣ.%4 #ÌÁÓÓÅÓ 

²ƘŜƴ ȅƻǳ ŎǊŜŀǘŜ ŀ ǾŀǊƛŀōƭŜ ōŀǎŜŘ ƻƴ ƻƴŜ ƻŦ ǘƘŜ ƛƳǇƻǊǘŜŘ Φb9¢ ŎƭŀǎǎŜǎΣ ǘƘŜ ƛƴǎǘŀƴǘƛŀǘƛƻƴ ƻŦ ǘƘŜ ǾŀǊƛŀōƭŜ ƛǎ ƴƻǘ 
ŀƭǿŀȅǎ ŀǳǘƻƳŀǘƛŎΦ 

²ƘŜƴ ǳǎƛƴƎ ŀ ²ƛƴон ōǳƛƭŘ ǎŜǘǘƛƴƎΣ ȅƻǳ ƴŜŜŘ ǘƻ ŜȄǇƭƛŎƛǘƭȅ ƛƴǎǘŀƴǘƛŀǘŜ ȅƻǳǊ ǳǎŜǊ-ŘŜŦƛƴŜŘ ǾŀǊƛŀōƭŜ ό¦5±ύ ōȅ 
ŎŀƭƭƛƴƎ ƻƴŜ ƻŦ ǘƘŜ ŎƻƴǎǘǊǳŎǘƻǊ ƳŜǘƘƻŘǎ ƛƴ ǘƘŜ ŎƻŘŜ ƎŜƴŜǊŀǘŜŘ ōȅ Φb9¢ 9ȄǇƭƻǊŜǊΦ ¢ƘŜǊŜ ǿƛƭƭ ōŜ ƻƴŜ ƳŜǘƘƻŘ ŦƻǊ 
ŜŀŎƘ ǾŜǊǎƛƻƴ ƻŦ ǘƘŜ ŎƻƴǎǘǊǳŎǘƻǊ ŀǾŀƛƭŀōƭŜΦ 

²ƘŜƴ ǳǎƛƴƎ ŀ Φb9¢ ōǳƛƭŘ ǎŜǘǘƛƴƎΣ ǘƘŜ ƎŜƴŜǊŀǘŜŘ ŎƻŘŜ ǿƛƭƭ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ƛƴǎǘŀƴǘƛŀǘŜ ǘƘŜ ¦5± ƛŦ ǘƘŜǊŜ ƛǎ ŀ 
ŘŜŦŀǳƭǘ ŎƻƴǎǘǊǳŎǘƻǊ ŀǾŀƛƭŀōƭŜΦ LŦ ǘƘŜǊŜ ƛǎ ƴƻ ŘŜŦŀǳƭǘ ŎƻƴǎǘǊǳŎǘƻǊ ŀǾŀƛƭŀōƭŜΣ ǘƘŜƴ ȅƻǳ ǿƛƭƭ ƘŀǾŜ ǘƻ ŜȄǇƭƛŎƛǘƭȅ Ŏŀƭƭ 
ƻƴŜ ƻŦ ǘƘŜ ŎƻƴǎǘǊǳŎǘƻǊ ƳŜǘƘƻŘǎΣ ŀǎ ƛƴ ²ƛƴонΦ 

¢ƘŜǊŜ ƛǎ ƴƻ ƘŀǊƳ ƛƴ ŎŀƭƭƛƴƎ ǘƘŜ ƳŜǘƘƻŘ ŦƻǊ ǘƘŜ ŘŜŦŀǳƭǘ ŎƻƴǎǘǊǳŎǘƻǊΣ ŜǾŜƴ ƛŦ ƛǘ ǿŀǎ ŀƭǊŜŀŘȅ ŎŀƭƭŜŘ ŀǳǘƻƳŀǘƛŎŀƭƭȅΦ 
Lƴ ǘƘƛǎ ŎŀǎŜΣ ǘƘŜ ¦5± ǿƛƭƭ ǎƛƳǇƭȅ ōŜ ǊŜ-ƛƴǎǘŀƴǘƛŀǘŜŘ ǳƴƴŜŎŜǎǎŀǊƛƭȅΦ IƻǿŜǾŜǊΣ ǎƛƴŎŜ ȅƻǳ Ƴǳǎǘ Ŏŀƭƭ ǘƘŜ ŘŜŦŀǳƭǘ 
ŎƻƴǎǘǊǳŎǘƻǊ ŜȄǇƭƛŎƛǘƭȅ ƛƴ ƻǊŘŜǊ ǘƻ ŎƻƳǇƛƭŜ ǘƻ ²ƛƴонΣ ŎŀƭƭƛƴƎ ǘƘŜ ŘŜŦŀǳƭǘ ŎƻƴǎǘǊǳŎǘƻǊ ƳŜǘƘƻŘ ŜȄǇƭƛŎƛǘƭȅ ǿƛƭƭ ŀƭƭƻǿ 
ȅƻǳ ǘƻ ŎƻƳǇƛƭŜ ȅƻǳǊ ŎƻŘŜ ƛƴ ōƻǘƘ ōǳƛƭŘ ǎŜǘǘƛƴƎǎ ǿƛǘƘ ƴƻ ŎƘŀƴƎŜ ƛƴ ǘƘŜ ŎƻŘŜΦ 

¦ǎŜǊǎ ǿŀƴǘƛƴƎ ǘƻ ǊŜǎƛȊŜ ŀ ƴŀǘƛǾŜ Φb9¢ ŀǊǊŀȅ Ƴǳǎǘ Řƻ ǎƻ ǿƛǘƘƛƴ ǘƘŜƛǊ ŜȄǘŜǊƴŀƭ ŎƻŘŜΦ ²ƛǘƘ ǘƘŜ ŜȄŎŜǇǘƛƻƴ ƻŦ 
{ŀƭ!ǊǊŀȅDŜǘ¦ǇǇŜǊ.ƻǳƴŘΣ ŀƭƭ {ŀƭ!ǊǊŀȅ ŦǳƴŎǘƛƻƴǎ ǊŜǇƻǊǘǎ ŀƴ ŜǊǊƻǊ ǿƘŜƴ ŎƻƳǇƛƭƛƴƎ ǘƻ Φb9¢ ŀǇǇƭƛŎŀǘƛƻƴǎΦ 

Ȣ.%4 !ÓÓÅÍÂÌÉÅÓ #ÒÅÁÔÅÄ ÉÎ 6ÉÓÕÁÌ 3ÔÕÄÉÏ 

¦ǎƛƴƎ ±ƛǎǳŀƭ {ǘǳŘƛƻ нллу ŀƴŘ ±ƛǎǳŀƭ {ǘǳŘƛƻ нлмлΣ ǳǎŜǊǎ Ŏŀƴ ƎŜƴŜǊŀǘŜ /ƭŀǎǎ [ƛōǊŀǊƛŜǎ ƛƴ ŀƴȅ /[w ƭŀƴƎǳŀƎŜ ό/ҌҌΣ 
/І Σ ±.Φb9¢ύΦ Φb9¢ 9ȄǇƭƻǊŜǊ Ŏŀƴ ōŜ ǳǎŜŘ ǘƻ ƎŜƴŜǊŀǘŜ ŜǉǳƛǾŀƭŜƴǘ !t[ǎ ŀƴŘ !·[ǎ ǘƘŀǘ Ŏŀƴ ōŜ ǳǎŜŘ ƛƴ ¢ŜŀƳ 
5ŜǾŜƭƻǇŜǊ ŀǇǇƭƛŎŀǘƛƻƴǎΦ 

 



 

43 

#ÈÁÐÔÅÒ ψ ɀ $ÅÂÕÇÇÉÎÇ $,,Ó 

¢Ƙƛǎ ŎƘŀǇǘŜǊ ŘŜǎŎǊƛōŜǎ ǾŀǊƛƻǳǎ ǿŀȅǎ ǘƻ ŘŜōǳƎ Φb9¢ /ƭŀǎǎ [ƛōǊŀǊƛŜǎ ŀƴŘ ²Ŝō ǎŜǊǾƛŎŜǎ ŦǊƻƳ ǿƛǘƘ ¢ŜŀƳ 
5ŜǾŜƭƻǇŜǊ Φb9¢ ŀǇǇƭƛŎŀǘƛƻƴǎΦ {v[²ƛƴŘƻǿǎ ŀƭƭƻǿǎ ŎǳǎǘƻƳŜǊǎ ǘƻ ōǳƛƭŘ Φb9¢ ŀǇǇƭƛŎŀǘƛƻƴǎ ƻǊ ƭƛōǊŀǊƛŜǎ ŀǎ сп-ōƛǘΣ 
ōǳǘΣ ŦƻǊ ŘŜōǳƎƎƛƴƎ ǇǳǊǇƻǎŜǎΣ ȅƻǳ ǎƘƻǳƭŘ ŎƘƻƻǎŜ он-ōƛǘ ŀǎ ǘƘŜ ǘŀǊƎŜǘ /t¦ ǘȅǇŜΦ 

Ȣ.%4 #ÌÁÓÓ ,ÉÂÒÁÒÉÅÓ 

/ƭŀǎǎŜǎ ǇǊƻǾƛŘŜ ǊŜǳǎŀōƭŜ ŎƻŘŜ ƛƴ ǘƘŜ ŦƻǊƳ ƻŦ ƻōƧŜŎǘǎΦ ! Ŏƭŀǎǎ ƭƛōǊŀǊȅ Ŏƻƴǘŀƛƴǎ ƻƴŜ ƻǊ ƳƻǊŜ ŎƭŀǎǎŜǎ ǘƘŀǘ Ŏŀƴ ōŜ 
ŎŀƭƭŜŘ ƻƴ ǘƻ ǇŜǊŦƻǊƳ ǎǇŜŎƛŦƛŎ ŀŎǘƛƻƴǎΦ ¦ǎŜǊǎ Ŏŀƴ ŘŜǾŜƭƻǇ Φb9¢ Ŏƭŀǎǎ ƭƛōǊŀǊƛŜǎ ǳǎƛƴƎ ±ƛǎǳŀƭ {ǘǳŘƛƻ ƻǊ 
{v[²ƛƴŘƻǿǎΦ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ ǎǳǇǇƻǊǘǎ ƛƳǇƻǊǘƛƴƎ Ŏƭŀǎǎ ƭƛōǊŀǊƛŜǎ ǘƘŀǘ ŀǊŜ ǘŀǊƎŜǘŜŘ ǘƻ ŜƛǘƘŜǊ ǘƘŜ оΦр ƻǊ пΦл 
ǾŜǊǎƛƻƴ ƻŦ Φb9¢ CǊŀƳŜǿƻǊƪΦ CƻǊ ƳƻǊŜ ŘŜǘŀƛƭǎ ƻƴ Ƙƻǿ ǘƻ ƳŀƪŜ Ŏƭŀǎǎ ƭƛōǊŀǊƛŜǎ ǳǎƛƴƎ ±ƛǎǳŀƭ {ǘǳŘƛƻΣ ǾƛǎƛǘΥ 

ƘǘǘǇΥκκƳǎŘƴΦƳƛŎǊƻǎƻŦǘΦŎƻƳκŜƴ-ǳǎκƭƛōǊŀǊȅκŦоŎȅŜморόǾҐǾǎΦфлύΦŀǎǇȄ 

CƻǊ ƳƻǊŜ ƛƴŦƻǊƳŀǘƛƻƴ ƻƴ Ƙƻǿ ǘƻ ƳŀƪŜ Ŏƭŀǎǎ ƭƛōǊŀǊƛŜǎ ǳǎƛƴƎ {v[²ƛƴŘƻǿǎΣ ŎƘŜŎƪ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ L59 Φb9¢ 
ōǳƛƭŘ ǎŜǘǘƛƴƎǎΦ 

¢ƻ ǳǎŜ ŀƴŘ ŘŜōǳƎ Φb9¢ Ŏƭŀǎǎ ƭƛōǊŀǊƛŜǎ ƛƴ ¢ŜŀƳ 5ŜǾŜƭƻǇŜǊ Φb9¢ ŀǇǇƭƛŎŀǘƛƻƴǎΣ Ŧƻƭƭƻǿ ǘƘŜǎŜ ǎǘŜǇǎΥ 

1. Build the class library using Visual Studio. Make sure to generate a PDB file for the library. 

2. Use .NET Explorer and import the class library generated in Step 1 to create corresponding APL and AXL 
files. 

3. Open the Team Developer application that is using the library and set the breakpoint at the function call. 
Make sure build settings for the application are set to either .NET WPF Desktop or .NET WPF Browser. 

4. Press F7 from TD IDE and run the application in Debug mode. When the breakpoint is hit, click Step-In 
and observe that SQLWindows opens the corresponding library source file in a separate code viewer. 

5. Keep clicking Step-In and observe how the focus in the separate code viewer moves as it executes the 
code functions. 

!ƭǘŜǊƴŀǘƛǾŜƭȅΣ ǘƘŜ ǳǎŜǊ Ŏŀƴ ƻǇŜƴ ŀ ǎŜǇŀǊŀǘŜ ŎƻŘŜ ǾƛŜǿŜǊ ōȅ ǎŜƭŜŎǘƛƴƎ ǘƘŜ ά{Ƙƻǿ /ƻŘŜ±ƛŜǿŜǊέ ƳŜƴǳ ƛǘŜƳ 
ǳƴŘŜǊ ǘƘŜ ǇƻǇǳǇ ƳŜƴǳ ά5ŜōǳƎέ ƛƴ ǘƘŜ L59 ŀǎ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǎƘƻǿǎΥ 

http://msdn.microsoft.com/en-us/library/f3cye135(v%3Dvs.90).aspx
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¢ƘŜ ŦƻƭƭƻǿƛƴƎ ǎƘƻǿǎ ǘƘŜ ǊŜǎǳƭǘ ƻŦ ǿƘŜƴ {v[²ƛƴŘƻǿǎ ǎǘŜǇǎ ƛƴǘƻ ƻǘƘŜǊ ǎƻǳǊŎŜǎΥ 
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